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ACRONYMS

ADSL

FTP

HTML

ISDN

ISP

LAN

(OR]

PDF

TCP/IP

VolP

WWW

Asymetric Digital Subscriber Line
File Transfer Protocol

Hypertext Markup Language is the set of codes inserted in a file so that it can
be viewed as a World Wide Web page. The markup tells the Web browser how
to display a Web page's words and images for the user

Integrated Services Digital Network
Internet Service Provider

Local Area Network is a group of computers that are linked together and share
resources. They are usually linked to a single computer, a server, which allows
sharing of files, printers, and allows information exchange. A local area network
may serve as few as two or three users or many as thousands of users.

An operating system is the program that manages all the other programs in a
computer. The other programs are called applications. The applications request
services from the operating system.

Portable Document Format is a file format that has captured all the elements of
a printed document as an electronic image that you can view, print, or forward
to someone else. To view and use the files, you need the free Acrobat Reader,
which you can easily download.

Transmission Control Protocol/Internet Protocol is the basic communication
language of the Internet. It can also be used as a communications language
(protocol) in a private network such as an Intranet. When you are set up with
direct access to the Internet, your computer is provided with a copy of the TCP/IP
program just as every other computer that you may send messages to or get
information from also has a copy of TCP/IP.

Voice over Internet Protocol

World Wide Web
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Why this manual

The IT for advocacy training manual and workshops are a joint initiative of Gender Links (GL) and the
Gender and Media Southern Africa (GEMSA) Network with support from the Netherlands Institute of
Southern Africa (NIZA).

GL is a Southern African NGO that promotes gender equality in and through the media. GL has been at
the forefront of research, training and policy development on gender and the media, and in gender justice
campaigns using ICTs.

GEMSA is an association of gender and media activists that includes institutional partners such as Gender
Links, the Gender and Media (GEM) Networks, MISA and its national offices, the Federation of African
Media Women Southern Africa (FAMSA), editors forums, media monitoring projects and gender NGOs,
as well as individual members. Launched at the historic Gender and Media (GEM) Summit in September
2004, the GEMSA network is fast growing and is a key mobilising force for progressive gender practices
in the Southern African media.

The main aim of the workshops is to build the capacity of members and partner institutions to use IT
effectively for advocacy, networking and training. As one of the first major training activities of GEMSA
the workshops will also serve to share information about the network at country level; recruit members;
grow and strengthen the institutional base of GEMSA. The initiative is also a contribution to bridging the
digital divide — and especially the gender dimensions of it.

Africa and the digital divide

The raw facts include:

e Africa has two percent of the world’s phone lines and 12 percent of the population. Fifty percent
(and in some cases as high as 80 to 95 percent) of the phone lines are in capital cities, where
only ten percent of the population lives.

e Teledensity (telephone lines per 100 inhabitants) is 0.5 in sub Saharan African countries (excluding
South Africa), compared to 4.5 in emerging economies and 52.6 percent in industrialized countries.

e The cost of renting a phone connection in Africa averages 20 percent of income per capita,
compared to a world average of nine percent; and only one percent in high- income countries.

e Line growth is about 8 percent a year, half that of other developing counties.

e Cellular telephone services now comprise about 20 percent of the phones on the continent (outside
South Africa) and are available in 42 countries. In South Africa cellular phones have outstripped
all predictions; covering 70 percent of the population. Most of these can also be used for access
to Internet, but at high cost.

. Estimates of the number of African Internet users range from 800 000 to one million (out of a total
population of some 800 million.) About 700 000 of these are in South Africa, leaving 100 000
among the 750 million people outside South Africa. This works out at one African Internet user
for every 5000 people, compared to the world average of one user for every 40 people, and one
in every 4-6 people in North America and Europe.

. Because most Internet Service Providers (ISP’s) are concentrated in capital cities, it is a long
distance call to the Internet for most of the (predominantly rural) public. There are a few
exceptions, such as Malawi, Mauritius and Zimbabwe, which provide local access across the
whole country as a result of conscious government policy.

. Internet costs in many countries are high.
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On the other hand:

The climate of democracy, change and liberalisation in many African countries is providing a more
conducive environment for rapid advances in the information and communications revolution on
the continent.

Internet connectivity in Africa has increased by leaps and bounds.

A number of telecommunication initiatives have been announced that are likely to substantially
improve the Internet infrastructure.

Because of the high cost and low international bandwidth available in many African countries,
increasing attention has been drawn to the possibility of using satellites for Internet services using
very small-aperture terminals (VSATs). Within the decade, other satellite-based communications
are being planned and these are expected to radically improve access to the most remote parts
of the sub continent.

Private sector growth in Internet service provision is growing rapidly. SITA, the airline co-operative,
has by far the largest network in Africa. Africa Online is a close second, with operations in
Zimbabwe, Tanzania, Ghana, Kenya, Senegal, Mali and Cote d’lvoire. Other international Internet
suppliers include AT and T, BT; Global One/Sprint; UUNET/AlterNet, MCI, NSN, BBN, Teleglobe,
Verio and France Telecom/FCR.

The bulk of service providers are small businesses, often started by technicians who learned their
skills at universities.

Privately run public access points such as kiosks and cyber cafes are mushrooming in Africa.
schools; police stations and clinics that can share the cost of equipment access with a larger
number of users.

Gender and information technology

“In ICTs all the gender inequalities are confronted in microcosm- women’s higher level of illiteracy, their
socialisation, their lack of exposure to and fears of technology.”
- Mercy Wambui, Communications Team, Economic Commission for Africa.

The gender dimensions of ICTs may be summarised as follows:

The invisibility of women’s contribution: As in so many other fields, the contribution of women
to ICTs is hidden. The task of feminist scholars has therefore been to “uncover and recover the
women hidden from history” in this area.

llliteracy and schools enrolment: 63.9 percent of women in developing countries are illiterate
- far higher than the percentage for men. Only 39 percent of girls are enrolled in schools in these
countries; compared to 50.4 percent of boys.

The absence of women from science and technology: The world over, females are under-
represented in the scientific, mathematical, engineering, computing and information technology
fields of study. Many women are found working in libraries. But the technology components of
libraries are dominated by men. Even in the USA, women comprise 7.8 percent of science and
computer engineering faculties.

Attitudes: As a result of their socialisation, women and girls tend to find technology intimidating
and alienating and therefore to suffer from “technophobia”.

Training: This is often alienating and not customised to women’s needs. Studies suggest that
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women prefer to learn through an orderly routine in which they understand the reason for each step,
whereas men have been encouraged to learn through experimentation, trial and error. Men are
socialised to tinker whereas women are socialized to avoid taking risks.

. Access: Women'’s use of ICTs is not equal to their share of the population as illustrated in the
following figures on use by women of ICT goods and services: 38 % in the USA; 25 % in Brazil; 17
% in Japan and South Africa; 16 % in Russia; 7 % in China and 4 % in the Arab states.

. Decision-making: Women are under-represented in all these decision making structures in the ICT
sector.

e Content: Only a tiny fraction of the content on the Internet is generated by women in developing
countries.

*  Negative portrayal of women: Cyber sex, which feeds on the objectification of women’s bodies,
pornography and child pornography are among the fastest growing and most lucrative dimensions
on the Internet. Much as ICTs have the potential to be put to use in advancing gender equality they
also have the capacity to destroy many of the fragile gains.

How to use this manual

This manual covers the full range of information from basic computer technology and software to the
various applications. It is designed in such a way that users can skip sections familiar to them, or start
from the beginning, depending on their comfort level. The manual has been designed for use as part of
workshops in which there will be a facilitator and peer support. These workshops will have a focus on
developing specific campaigns, e.g. around the Sixteen Days of Activism on Gender Violence, using ICTs.

It will not be possible to work through all of the exercises in the training. The value of the manual is that
users can refer back to the instructions and follow them through on their own. Remember, it is only through
tinkering that you will be more comfortable with IT. And the more comfortable you are with IT, the more
you can “make IT work for gender justice”!

Symbols used in this manual

(Q All practical exercises are located on their own pages in boxes like this ona

& Tips and shortcuts will be indicated by this symbol and will be placed in a box to separate them from
the rest of the text.
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Objectives

The objectives of this session are to:

e Gain a brief and thorough overview of computers and computer networks.
. Understand the difference between hardware and software.

. Learn the uses of operating system software like Windows.

. Learn to work in the Windows environment.

. Understand the importance of file sizes.

. Know how to deal with computer viruses.

d Know how to search for files and folders on your computer.

. Learn how to search for files on a local area network.

. Provide a basic introduction to the Internet and how to get connected.

What is a personal computer (PC)?

A PC is a machine which is used to perform tasks like math calculations and document formatting, which
would take a lot of human thinking time if they had to be done manually (by hand). In other words a PC
is an electronic machine for inputting, processing, storing and displaying information. We can graphically
display a personal computer as follows:

INPUT =——9 PROCESSING =— OQOUTPUT
Keyboard Central Processing Unit or Monitor / Screen
Microprocessor

STORAGE
Random Access Memory
& Disks

Input

Firstly, some data is required before the PC can do anything with it. This can be entered using a keyboard,
scanner, mouse, touch screen, camera or microphone.

Processing

Secondly, the computer must process this data in order to turn it into useful information for humans — it
uses memory and the CPU to do this.

Output

Thirdly, this information must be made available to the person using the PC — printed as hard copy, 11
displayed on a screen, as sound through speakers, etc.
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PC’s can be used for many things, but the following are the most common:
e Financial and maths calculations.
* Typing letters and documents, including books and manuals like this one.
* Playing games.
e Creating websites.
* Sending and receiving information using the Internet.
* Creating databases of searchable information, such as a library catalogue system.
e Storing and retrieving information.
e Managing projects and businesses.
* Doing graphic presentations like slideshows.
* Using sound and video (you can even turn your PC into a mini-TV if you have the right equipment).
* Creating your own computer programmes.

The Parts of a Personal Computer - Hardware

The parts of a PC are generally referred to as Hardware. Hardware is those parts that you can see and
touch. A PC consists of the following hardware parts:

Monitor

A monitor is a lot like a high-quality television set. As you
work, the monitor lets you see what you are doing. Just
as you get colour and black and whiter television sets,
you also get colour and black and white colour monitors.
Black and white monitors are generally referred to as
monochrome monitors.

Keyboard

The keyboard contains the keys you use to type data
into the computer and enter commands. Although the
locations of the keys on your keyboard may differ your
keyboard should contain the same keys. A typical
keyboard contains the following main areas:

| LL| I I]“J"]_]i_d[[ L]i] j__l;l
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Alphanumeric keys — these are keys that act like typewriter keys

Function keys — the way the function keys work depend on the program

Numeric keypad — works like a calculator

Computer keys — the way the computer keys work depends on the program

Ctrl & Alt keys — these keys work in combination with other keys to give program command
Arrow keys — they are used to move the cursor around.
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System unit/box
The System Unit is a box that holds the following parts:

Central Processing Unit (CPU)

The CPU is the “brain” of the computer. The CPU interprets the program
instructions and processes the data you enter. The speed and power
of a PC is largely determined by the type of microprocessor that is used
by its CPU.

Random Access Memory (RAM)

RAM is temporary memory which contains information only when the
computer is on. When you load a program onto the computer and
create a document, both program and document are temporarily stored
in RAM.

All computers need memory in order to store instructions and data in an electronic form that the computer
can read and process quickly. All computers come with memory, but the amount of memory can vary
from one computer to another.

Disks and disk drives

Disks are used to store information permanently in the
form of files. We can distinguish between four disk types
namely, stiffy/floppy disks, hard disks, CD-ROM disks
and Flash disks.

Flash disk

This acts like a hard disk and one can save data on it.
Flash disks come in different sizes and plug into the
back of your computer. The word "flash" comes from the
fact that data can be copied or erased quickly, in blocks
instead of one byte at a time.

13
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Modems

Modem is an acronym for Modulator Demodulator. A
modem is a device that converts data from digital
computer signals to analog signals that can be sent over
a phone line. This is called modulation. The analog
signals are then converted back into digital data by the
receiving modem. This is called demodulation. Modems
External Modem Internal Modem are used to connect to the Internet.

External or Internal?

An external modem goes outside your PC, easily plugs into a jack on the back of your PC through a
cable, and has useful status lights. An internal modem plugs into a PCI or ISA slot inside your PC, is
harder to install, but usually costs less.

Lightning Protection?
Lightning is the number one cause of modem failure. To protect your modem you should select a modem
which incorporates patented circuitry for lightning protection.

Scanner

A scanner is a device, usually attached to a PC, which will convert a
page of text and/or images (pictures) into a word processing file and/or
image file. The quality of the conversion depends on the quality of the
input, the resolution of the scanner and the capabilities of the program
used.

The mouse
A mouse is a pointing device that enables you to quickly move around
the screen and to select commands from menus, rather than typing the
commands.

Working with a mouse

Your mouse has 2 buttons at each side at the top. It may have a 3rd button in the middle. Throughout
this manual, whenever the instruction to ‘click’ appears, it means click once with the left button — unless
there is a different instruction, such as ‘double-click’ or ‘right click’.

Left-clicking

The left button is the one you will use the most often. You will either click it once or twice. Once is to
select something on the screen. Move your mouse around on the table — notice how the pointer on the
screen moves around as you do so. When you click with your mouse, your computer will try to select
or open something at the point where that arrow is.
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Double-clicking
Clicking twice on the left button will usually open a program or file.

Right-clicking
Clicking once on the right button will usually cause a mini-menu to ‘pop up’ on your screen. You can then
select a choice from the menu by clicking once with the left button.

Highlighting, dragging and dropping
You will occasionally need to select a section of text so that you can work with it directly. This will be
especially useful when you are doing word processing.

1. Click at the beginning of the text you wish to select.

2. Hold down the left mouse button and drag the mouse slowly across and down until you have selected
the entire section you need.

3. It should be highlighted in blue.

4. Let go of the mouse button.

You can hold down the left button and drag an object (like a shortcut icon) from one place to another on
your desktop. Release the button when you have dragged the icon to the new location. This is called
dragging and dropping.

The middle button or scroller
This is used to scroll up or down documents you have open, or web pages you are looking at on the
Internet.

EXERCISE A
Examine your mouse
1. Unplug your mouse from the back of your computer.
2. Take your mouse apart (slide the round panel at the back out and remove the ball).
3. Put it back together again.
4. Plug it back into the computer.
Use your mouse
1 Move your mouse around on the mouse pad and watch how the pointer on your screen moves.
2. Left-click on the Start button.
3. Scroll up (move the pointer up the menu list) to Programmes.
4. Hold the mouse still when the pointer reaches Programmes.
5. Watch how the Programmes menu appears to the right.
6. Move the mouse so that you can scroll up the menu and click once to select Microsoft Word
(MS Word).
7. Inthe top right corner you will see a small x — click on it and the programme will close.
8. Now move your mouse pointer over the screen until it rests on the My Computer icon. Double
click on this icon and it will open the program which allows you to view all the files on your

computer. Close this window in the same way as you closed the Word window in step 7 above.
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The Keyboard

<> Shift

Alt

The Shift Key

The shift key is used to change case and allows you to use symbols such as @#$%.For
example, to obtain the character @

1.  Hold down the Shift key

2. Press the 2 key at the top of your keyboard

3. Release both keys

The Alt Key

This key is usually used together with another key or two. When you push this key
together with the f key, the cursor moves to the menu bar at the top of the screen. It’s
the same as clicking your mouse on the File menu. From there you can use the arrow
keys to select menu options. This is useful if you don’t like switching between your
mouse and keyboard often. Press Alt again to move the cursor back off the menu bar.

& To restart your computer (reboot) press Alt-Ctrl-Delete. This is for emergencies only!

Enter

‘ \‘T Hi\ “;\?\lgg

The Windows Key
This key opens the Start menu at the lower left corner of your screen. It has the same
effect as you clicking the Start button with your mouse.

The Ctrl Key

The Ctrl key stands for Control. This key is used in combination with other keys to
perform specific tasks, often called shortcuts. One example is Ctrl-p. Often programmes
automatically print the document you are using if you push the Ctrl button and the p
key at the same time.

The Delete Key
This key erases the character directly to the right of your cursor. If you have text or
graphics that are highlighted, those are erased by pushing this key as well.

The Backspace Key
This key erases the character directly to the left of your cursor. If you have text or
graphics that are highlighted, those are erased by pushing this key as well.

Enter

The Enter key works very much like the Return key on a typewriter. However, do not
press enter after every line when you are typing a document. Windows knows when
you are reaching the end of a line, and will automatically go to the next line. If you do
press Enter after each line, and then attempt to change the font or size of the document,
you’ll see some strange results!

Pressing Enter also usually agrees to a question that Windows asks you, similar to
clicking on OK or Yes in a window called a dialog box.
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Insert

Lock

Caps Lock

Home

. ll l .E =

End

N\ N\ N\
N Bl E
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Esc

Tab

Again, as with a typewriter, the Tab key will insert indentation (a space before you
type) into a document. It also makes the cursor move from box to box when entering
information into the fields of an online form or a Windows dialog box.

Insert

Pressing the Insert key toggles (switches) between Insert Mode and Overwrite Mode.
Insert Mode will insert text where the cursor is when you type. However, Overwrite
Mode simply writes over anything that is to the right of the cursor.

Num Lock

If you look at your Numeric Keypad (the group of keys to the right with all the numbers
on it), you’ll see that there are arrows and words under most of the numbers. When
Num Lock is turned on, you can use those keys to enter numbers (instead of using
the row right above the keyboard letters). When Num Lock is turned off, you can use
the arrows and commands printed below the numbers.

Caps Lock
Pressing the Caps Lock key toggles between typing in UPPER CASE and lower case.

Home / End / Pg Up / Pg Down

Often the Home key is used to move your cursor to the beginning of a line, and the
End key is used to move it to the end of a line. Page Up and Page Down are slightly
misleading. Often, the Page Down key won’t move your cursor from Page 2 to Page
3. Instead, it may move the cursor up/down one "screen-length", meaning that if you
push the Page Down key, the top of the screen becomes what was just after the bottom
of the screen before you pressed the key. Use these four keys to navigate quickly
around a document. You will see this practically when you use a word processing
program.

Arrow keys
Use these to move the cursor in your document.

Esc
Press this button to interrupt a process on your computer. It is like clicking on cancel.

17
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Windows
What is an operating system?

This is the software used to manage the entire PC, or system. It ensures that everything works together
properly. All data on PC’s is saved in the form of files and the operating system creates a file structure
on the hard drive, where all the information is stored. This means that there is a logical filing system for
all the work you do on your PC. It is similar to filing all the documents you work on in folders in the drawers
of an office filing cabinet. In a way, it can be said that the operating system builds a virtual filing cabinet
on your computer. You can create your own folders (sometimes called directories) and also delete old
ones that you do not need anymore.

Files have names and extensions, for example letter.doc (‘doc’ files are opened using the MS Word
program). Files are stored in folders.

The reason why filenames and extensions are used is so that you can:
d Easily locate information you have saved on the computer.
. The operating system knows which programme (or application) to use to open the file.

Operating systems also enable users to share information, devices and software with other computer
users over a network. In addition, they manage and control the resources used by the PC — this includes
memory and the CPU. This manual focuses on the use of the Windows operating system, but there are
other popular and reliable systems for PC’s, such as Linux.

An operating system should be the first software that you load onto your PC — it will help you setup any
other software which you install after that. Normally when you buy a computer it comes loaded with an
operating system. Once the operating system is installed, you can load or install other software like word
processor and database programs. These programs are called applications. There are other programs
which perform tasks to keep your PC in good working order, such as anti-virus programs. These applications
are called utilities as they perform tasks that maintain your system. Sometimes they are called system
tools.

Starting and logging on

If your computer is part of a computer network, Windows will usually present a dialogue box on the screen
asking you to ‘log on’ using a name and password. It is called a dialog box because the computer is
asking you to enter information before it continues the task it is busy with.

Once you type in this data, press enter or click ‘ok’ with the left mouse button. You should log on to the
network. This means that you can use the resources on the network where you have permissions to do
s0. You can access information on another PC on the network, but only if that information has been made
shareable and the other PC is switched on.
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The Desktop

The desktop is the virtual desktop on your PC screen. It contains shortcuts in the form of icons, and
provides a user-friendly way to work with your computers programs, files and parts. Pictures of the desktop
are called ‘screenshots’.

Icons

These are the small pictures on your screen (the desktop and the Start menu, as well as other places
on your computer) which represent different parts of your system. Some of them will refer to files you
have created and some will refer to programs. They are shortcuts to opening the programs and files
you use most often. You can double-click with your mouse on the icons and the file you have
selected will open on your computer. You can also create and delete shortcuts as you wish.

My Computer

The My Computer icon provides access to the resources on your computer. You can
access your drives (and therefore all the files and programs on these drives) and other
peripherals (like the printer) by double clicking on the My Computer icon. You can also
access the Control Panel, where all your system preferences are set up, through My
Computer.

My Documents

My Documents

This is a shortcut to all the files and sub-folders that you have saved in this folder. 75
Recycle Bin et Sxplarer
Windows will send all the files that you delete to the Recycle Bin. If you need to recover
a deleted file, you can open the Recycle Bin and restore the document. If you are sure
you no longer need deleted files, you can empty the Recycle Bin.

Network Neighborhood

Opening this icon will display all the computers on your network. If you are trying to access
files on another computer on the network, you can double click on it in this window and
all the shareable files will be made available to you.

The Taskbar

This is the thin grey bar at the bottom of your desktop. Usually, any programs you have open will have
an icon in the taskbar. It also contains the start menu and the system tray, as well as the clock.

|isston] | @@ || @operesi-pacoso | pymisosatvon-01_| @evaos | [y oA |
Clock
This is displayed on the far right and gives the time. You can adjust these settings by double clicking 19

on this icon. If you hold your mouse pointer over the clock, the date should be displayed.




20

2. COMDUITELR AND INTEDNET BASICS

System tray

This is the section of the taskbar on the right hand side. It contain small icons of programs running in the
background (you don’t work on them directly — an example is virus protection software). There are
sometimes small quick-start icons in the taskbar next to the start button. One click on these icons will
start a program running.

Open Programs

If you have Programs open, they will be represented in the Taskbar as well. If you look at illustration
above, you will notice that there are 3 applications (programs) running at the time the picture was taken.

& In Windows, you can switch between applications by holding down the Alt key and pressing Tab

Start menu
This is the button on the far left, at the bottom. If you click here the screen will display a menu which you
can use to open programs and perform tasks (see ‘launching programs’ below).

To open a program, click on Start

Click on Programs

Click on Word, or on Office and then on Word, depending on how your menu is setup
The program should open

Hpwn -~

Wallpaper and Screensaver

Wallpaper is the image which forms the background picture or colour on your desktop. This can be
modified by right clicking anywhere on the desktop background (but not on an icon) and selecting
Properties from the popup menu. This will open the Display Properties window.

—_

Click on the tab labeled Background

Under the heading Wallpaper is a list of options. Click on each one to preview how your desktop
will appear if you select that image as your wallpaper

Under Display is a box with a drop-down menu. Click on the down arrow to show display options
Click on the option you want

Click on Apply to set this as your background

Now click on the tab next to Background

N

I

Looking at a Window
Open the Windows Explorer program and take a look at the Window which opens on your screen.
1. Click on Start

2. Click on Programs
3. Click on Windows Explorer
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The Title Bar

At the top you will see the Title bar, which is usually in blue. The white writing tells you the name of the
program and document. Almost all programs which open in the Windows system have this feature.
At the top right corner, you will see 3 blocks. The first is a flat line — this is the minimise icon. Click here
and your window will ‘collapse’ into the taskbar at the bottom of the screen. Clicking on the correct item
in the taskbar will open the window again.

The next icon is for changing the size of the window — either making it smaller or maximising the size
of the window to fill your screen.

At the far right is the x for exiting the program — to shut the window completely, click on the x.

B% Exploring - C:\

~
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92kB  MS-DOS Application 47237991022 PM
Systam hile 10£2/00 807 AM
Analicatinn Fvtansinn AF1R/AF 417 Al

The Scroll Bars

On the right of the window is the vertical scroll bar. You can click in this ‘bar’ with your mouse and
the document will ‘scroll down’ so that the section you cannot see which is below the present image
will be displayed. Click on the arrows at the top and bottom of the bar to move up and down in the
document. Near the bottom of the screen is the horizontal scroll bar. This works in the same way
as the vertical bar, but will move your view to the right or the left. Not all windows have scroll bars.

21
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The Menu Bar

The Menu bar is directly below the Title bar and it displays the menu. The menu begins with the word
File and continues with Edit, View, Tools, Window, Help, etc. You use the menu to give instructions to
the software. Point with your mouse to a menu option and click the left mouse button to open a drop-
down menu. You can now use the left and right arrow keys on your keyboard to move left and right across
the Menu bar items. You can use the up and down arrow keys to move up and down the drop-down menu.
To select an item, highlight the item on the drop-down menu and press Enter. An ellipsis (3 dots ...) after
a menu item signifies additional options; if you select that option, a dialog box will appear.

The Toolbar

As a new user it is important for you to learn about toolbar. These are found below the Menu Bar on your
screen.OThe toolbar is located at the top of the screen with icons on it.d0To become familiar with the function
each icon represents, move your mouse pointer over each of the buttons on the toolbar. A description

will pop up on your screen. Many programs have more than 1 toolbar.

Using Windows help

1. Click on Start
2. Click on Help
3. The Help window should open

& Pressing the F1 function key at the top of your keyboard will automatically open help in most Windows
programs

There are 3 sections to the Help: Contents, Index and Search.

E? Windows Help

To find a Help topic

1. InHelp, click one of the following
tabs:

[2] Welcome to Help
(18] Introducing Windows 98
() How to Use Help
Find a topic

EI Get more out of helg

[ Copy a topic

Print a topic

[2] Move through topics

[2] Get Help in a dialog

@ How to Change the
@ Register Your Software
@ What's New in Window™
@ If You're New to Window
[ 3 Using Windows 58 Plus
2 Exploring Your Computer frame.
2 Exploring the Internet Note

2 Using Windows Accesson .
v i » Click web Help ® on the Help
. i . toolbar to ggttechni!:al support, -

® To browse through topics by
category, click the Contents
tab,

® Tosee alist of index entries,
click the Index tab, and then
either type a word or scroll
through the list,

® To search for words or phrases
that may be contained in a
Help topic, click the Search tab.

2. Inthe left frame of the Help
window, click the topic, index entry,
or phrase to display the
carresponding topic in the right
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Contents
This lists the help items available. By clicking on different topics, shown on the left, you will have access
to information that is displayed on the right (see picture above).

Index

Clicking on the Index tab will take you to another option. You can scroll down through an alphabetical
listing of all help keywords below the keyword entry box. If you know what you want help on, type a
keyword (for example ‘internet’) into the keyword box and then press Enter. A display will appear on the
right, or a list of topics will appear. Double-click on the topic you want to view, and the information will
be displayed on the right of the Help window.

Search

1. Enter a keyword

2. Click List topics to search the help files for information about a certain topic.
3. Select a topic with your mouse — it will be displayed on the right.

Logging off and shutting down Windows
To shut down or restart

1. Click on Start

2. Click on Shut Down

3. Select Shut Down or Restart, depending on whether you want to switch off or restart your
computer

4. Click on OK

5. If you have selected Shut down, wait for the computer to tell you that it is safe to
switch off before doing so

Filing
Creating a folder

A folder is a place to store various files which are related — for example, you may wish to store all the
Word files which are faxes and letters in one place in a Folder named Correspondence.

You would make a folder called Letters, and save all the relevant files there. Compare this to storing
books and documents under different sections in a library catalogue. It is a way of helping you know
where your information is.

Open Windows Explorer. The screen is split into 2 — on the left is a list of all the drives and folders.
This list can be expanded or collapsed by clicking on the plus or minus signs next to the folders.
Clicking on a folder will select it — and the contents of that folder, which could be other folders 23
and/or files, will be displayed on the right hand side of the window. New folders can be created.

This can be within other folders or directly on the hard drive.
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To create a new folder on the hard drive, click on the symbol for your hard drive (usually C). To create a
folder somewhere else, click on the folder where you want it to be stored.

To create a folder for faxes and letters in the My Documents folder

—_

Click on My Documents
2. Click on File and then New
3.  Type the name of the new folder, Communications and press Enter

EXERCISE )
1. Open Windows Explorer

2. Create a new folder in My Documents

Name it by using your first name or last name
. J

Managing files

Use Windows Explorer to manage and organise the files on your computer. The Windows Explorer
Program is useful for this — alternatively, double-click on the My Computer icon on the desktop.

& You can drag and drop files and folders within Windows Explorer.

In your Windows folder is a folder named Temp, and all your documents are saved in here occasionally.
You should delete these files now and again, depending upon how many files you work on during the
week.

Another folder that is good to empty every now and again is Temporary Internet Files. This folder stores
all the images and files that you view if you are using the World Wide Web.

Searching in Windows

Windows has a search facility which makes it easy to search for files and folders, people, and other
computers on your network; and it's a convenient starting point for searching for information on the
Internet. Windows Search also has an indexing service that maintains an index of all the files on your
computer, making searches faster.

When you use Windows Search, you can specify several search criteria. For example, you can search
for files and folders by name, type, or size. You can find a file based on when you last worked on it or
search for files containing specific text.

You may use Windows Search if you are looking for common file types, if you remember all or part of
the name of the file or folder you want to find, or if you know when you last changed a file. If you know
only part of the name, you can use wildcard characters to locate all files or folders that include that part
in the name. For example, *letter.” will find Holiday letter.doc, Special letter.doc, and Special letter.txt.

J
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The Windows Search also allows you to search for all types of objects, from pictures, music, and
documents, to printers, computers, and people. You can search your own computer, other computers (if
you are connected to a network or workgroup), and the Internet.

Using wildcard characters

A wildcard character is a keyboard character such as an asterisk (*) or a question mark (?) that is used
to represent one or more characters when you are searching for files, folders, printers, computers, or
people. Wildcard characters are often used in place of one or more characters when you do not know
what the real character is or you do not want to type the entire name.

Wildcard character Uses

Asterisk (*) Use the asterisk as a substitute for zero or more characters. If you
are looking for a file that you know starts with "gloss" but you cannot
remember the rest of the file name, type the following:

gloss*

This locates all files of any file type that begin with "gloss" including
Glossary.txt, Glossary.doc, and Glossy.doc. To narrow the search to

a specific type of file, type:

gloss*.doc
This locates all files that begin with "gloss" but have the file name
extension .doc, such as Glossary.doc and Glossy.doc.

Question mark (?) Use the question mark as a substitute for a single character in a name.
For example, if you type gloss?.doc, you will locate the file Glossy.doc
or Glossl.doc but not Glossary.doc.

The Windows Search also allows you to search for all types of objects, from pictures, music, and
documents, to printers, computers, and people. You can search your own computer, other computers (if
you are connected to a network or workgroup), and the Internet.

Searching for files and folders in Windows

Below are the steps in searching for files and folders:
1.  Click Start, point to Search, and then click For Files or Folders.
2. Click All files and folders.
3. Type part or the full name of the file or folder, or type a word or phrase that is in the file.
4. If you do not know either piece of information or want to narrow your search further, select one or
more of the remaining options:
* In Look in, click the drive, folder, or network you want to search.
* Click When was it modified? to look for files that were created or modified on or between
specific dates.

25
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* Click What size is it? to look for files of a specific size.
* Click More advanced options to specify additional search criteria.
5. Click Search.

If you do not see All files and folders, for any reason, you have probably changed your default search
behavior.

* Click Change preferences.

* Click Change files and folders search behavior.

* Click Standard, and then click OK.

* Click All files and folders.

If you get too many results, try using additional search criteria to make your search more specific.
To search for a specific type of file

When you know the type of file you are looking for, such as a picture file, you can quickly search for all

files of that type by using Windows Search.

1. Click Start, point to Search, and then click For Files or Folders.

2. Click Pictures, music, or video or Documents (word processing, spreadsheet, etc.), depending
on the type of file you want to find.

3. Click the appropriate search criteria, type all or part of the name of the file (if you know it), and
then click Search.

To search for a computer on the network

Click Start, point to Search, and then click For Files or Folders.
Click Computers or people.

Click A computer on the network.

In Computer name, type the name of the computer you want to find.
Click Search.

aprp -

To search for people and groups in the Address Book

Click Start, point to Search, and then click For Files or Folders.

Click Computers or people.

Click People in your address book.

In Look in, click Address Book.

On the People or Advanced tab, type your search criteria, and then click Find Now.

aprwn -

Sharing files and devices over a network

It is often useful to have access to information that others are working on. This is especially true if you
are working on a project in a team.
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Enabling sharing

1. Click on Start

2. Click on Settings and then Control Panel

3. Double-click on the icon labeled Network

4. In the window which opens next, click on the button labeled File and Printer sharing

5. Adialog box will open

6. Click next to the option to give others access to your files (a tick shows it is selected)

7. If you have the printer connected to your computer, and other users on the network need access
to it to print documents, click next to the option to grant this access

8. Click OK

9.  Other people on your network are now able to access files and devices which you make shareable

Making a file or device shareable

Right-click on the file/folder/device in Windows Explorer

Select Sharing from the popup menu

Click on the Sharing tab

Click on Shared as to enable sharing

Choose whether you want other users to have full, read-only, or password access (read-only
means they can access the file but cannot modify it)

Click on Apply

Click Ok

Accessing shared files

Double-click on My Computer

Select the icon for the computer which has the information you need
Double-click on it

Locate the file and double-click it to open it

27
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File Sizes

Why is file size important?

If you are saving documents, graphics, or any other file on your PC and you do not need to share this
information with colleagues outside of your office then the size of your files is not a major concern.
However, if you are sharing information over the Internet or emailing information, then file size becomes
very important. The bigger the file, the longer it takes to send or download.

How do I find out the size of my file?

To find out the size of your file or document, you will use the program WINDOWS EXPLORER which
comes with your operating system. WINDOWS EXPLORER allows you to view your folders and files on

your PC.

1. Right click on Start
2. Click on Explore

A window will appear which show the structure of your computer. Click on C: to show all the folders on
your hard disk. A list of folders appears in the right block of the window. Click on the folder that contains
your file. Alist of files appears in the right block.

To find the file size of a particular file, right click on the file name and click on Properties.
The size of the file will be listed in kilobytes, e.g. 22.0 (KB)

Bytes, Kilobytes, Megabytes and Gigabytes

The standard measurement units for file sizes are bytes, kilobytes megabytes and gigabytes. A byte is
calculated as one character of the keyboard.

Largest Larger Large Basic Unit

Gigabyte (GB) Megabyte (MB) Kilobyte (KB) Byte

Exact Conversion

1,024 Byte = 1 Kilobyte (KB)

1,024 Kilobyte (KB) = 1 Megabyte (MB)
1,024 Megabyte (MB) = 1 Gigabyte (GB)

However we can estimate sizes by rounding to 1000.
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The basic unit is a byte. If you have 1000 bytes, you can then call it 1 kilobyte. If you have 1000 kilobytes,
you can then call it 1 megabyte. The same happens when you go up from megabytes to gigabytes. Each

chart below shows equivalent amounts.

Gigabyte (GB)

Megabyte (MB)

Kilobyte (KB)

Byte

1 1,000 1,000,000 1,000,000,000
Gigabyte (GB) Megabyte (MB) Kilobyte (KB) Byte
.001 1 1,000 1,000,000
Gigabyte (GB) Megabyte (MB) Kilobyte (KB) Byte
.000001 .001 1 1,000
Gigabyte (GB) Megabyte (MB) Kilobyte (KB) Byte

.000000001

.000001

.001

1

When you see 1.2 megabytes that means that there is 1 megabyte and 2/10 of a megabyte or 1 megabyte

and 200 kilobytes.

Important points on file size

If you are using a modem to dial up to the Internet, it will take approximately 20 minutes to download

a 1MB file.

Sending and receiving large files will increase your telephone costs, as you will need to connect for

longer periods of time.

J Often your Internet Service Provider (ISP) limits the size of mailboxes. A large file will block or fill

up your mailbox, stopping you from receiving other email.

J Images or graphics usually have the extension jpg, gif, bmp or tif. A tif file can be very large (usually
larger than 1 MB) and can cause problems with your email. File sizes are very important for websites.
Websites need to have very small graphic files so that it does not take a long time for a webpage

to download.

0 A WORD document which has a number of graphics inserted into it, as well as a graphic letterhead,

can become a very large file.

29
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How to make files smaller

You can compress your documents and files so that the file size is decreased. Avery common program
that is used to compress files is WINZIP. The WINZIP program can be downloaded from the Internet.
Zipping a file usually reduces the file size by almost two thirds of the original size. If the size of a file or
a number of files that you want to send using email is larger than 1 MB, it is a good idea to zip the files
into one zipped file. You can then email the zipped file as an attachment.

To compress a graphic, you will need to use specific image editing software program, for example,
Photoshop, Paintshop Pro or Irfanview. There are many image editing programs available for free on the
Internet.

How do I zip a file

Go to Windows Explorer.

Find the file that you want to zip or compress.

Right click on the file name.

Click on ADD TO ZIP.

The WINZIP program opens.

Click on NEW to create a new zip file.

Choose the folder where you want to save the zip file and give it a name e.g.. conference documents.
Click on OK.

You will see the WINZIP window showing you the file you have added in the zip file and the reduced
file size.

10. If you want to add another document to the zip archive, click on ADD and choose the next file to zip.
11. To save the zip file, click on FILE and CLOSE.

12. The zip file is save with a .zip extension.

©® N O~

How do I unzip a file

If you have received a zip file as an email attachment:

Save the file in a folder on your hard disk.

Open WINDOWS EXPLORER.

Find the folder where you save the zip file.

Right click on the zip file and choose OPEN WITH WINZIP.

The WINZIP program open showing you all the files in the zip file that have been compressed.
Click on EXTRACT on the WINZIP toolbar to extract or uncompress the files that you require.
Choose the folder where you want to save the unzipped file by clicking through the file structure.
Click on OK.

© N oA wN

The files will be extracted or uncompressed and saved normally onto the hard disk.
PDF Files
A PDF (Portable Document Format) is a file that has captured all the elements of a printed document as

an electronic image that you can view, navigate, print, or forward to someone else. PDF files are created
using Adobe Acrobat, Acrobat Capture, or similar products. PDF files are especially useful for documents

)
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such as magazine articles, brochures, or flyers in which you want to keep the original graphic appearance
online. A PDF file contains one or more page images, each of which you can zoom in on or out from. You
can page forward and backward.

PDF files are useful when:

*  You want to keep the formatting, graphics and style of a document.
*  You need to compress the size of a file.
*  You don’t want the file to be edited.

To view and use the files, you need the free Acrobat Reader, which you can easily download. Once you've
downloaded the Reader, it will start automatically whenever you want to look at a PDF file.
The Acrobat product that lets you create PDF files, is Adobe Acrobat Writer and costs about $200-300.
To download Adobe Acrobat Reader, go to http://www.adobe.com/products/acrobat/readstep2.html

Viruses and virus checks

Avirus is a program that attaches itself to a file or a program in your computer and can cause information
to become corrupt (damaged). Viruses can also corrupt your programs and affect your email. Some
viruses can wreck your entire computer. Most viruses are transmitted via stiffy disk, over networks, or
are received in email messages.

Ways to avoid virus infection on your PC

e Install a good virus protection program such as McAfee, Vshield or Norton’s Anti-virus from Symantec.
It is worth buying a good virus protection program. You will need to install the program on your
computer and download the update files regularly. You can download the update files from the
Internet. New viruses are released all the time and you will need to keep your anti-virus program
up to date. You can set up the virus protection program to scan your computer on a regular basis.

. Do not install files from a stiffy disk without running a virus check (using your antivirus program) first.

* Do not open attachments that you receive via email — especially if they have extensions like exe.
An exe file is a program or executable file and is the most common file to be affected by a virus.

. Only open files you receive via email if you are expecting them and you know and can trust the
sender.

e Do not download files from the Internet unless you are using a trusted and recommended download
site.

If you find a virus

If a virus infects your computer, and you are running an anti-virus program, you will usually be able to
clean the virus fairly quickly. The anti-virus program will pick up the virus, and then quarantine the file it
is attached to, in a safe area on your computer. You will be asked if you want to repair or delete the file.

Sometimes a virus will corrupt your entire computer and the hard disk will have to be formatted
(everything will be cleaned off your hard disk drive and re-installed). This is an exhausting task that
you want to avoid. You can also lose important files that way, and hours and hours of work. If this
happens you will need to call in IT support or an IT specialist to help clean up your computer.
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é& Make regular backups of important information every week so that you can avoid losing all your
information if a virus infects your computer. A backup means copying your important files to a
flash disk, a CD or to a computer on your network that is used for this purpose, and keeping it
in a safe place until you no longer need it.

Backing up

It is very important to save your data as you make changes to it, but most important of it all is backing
up your data daily. Computers can lose all the data that you stored in them and never recover your
information again. Backup is the activity of copying files so that they will be preserved in case of equipment
failure or other catastrophe such power failures or viruses.

Tips for keeping data updated, backed-up, and stored appropriately:

Save files and e-mails frequently while writing them, so unnecessary data isn't lost in the event of
a system failure or disaster.

Make copies of all critical files or data onto CDs or other removable media.
Take the removable media to a different location for storage.

Check that the copies can be restored properly on your computer by retrieving them from the external
location and re-entering them into your computer. Do this periodically to verify your back-up
methodology is correct.

The Backup utility in Windows® XP Professional helps you protect your files and information if your
computer fails. For example, you can use Backup to copy the data on your hard drive and archive it on
another hard drive, a disk, a CD, a DVD, or another computer. If your hard drive is erased or damaged,
you can easily restore the data from the archived copy.

To start the Backup Utility in Windows XP Professional:

1.

Open Backup. (Click Start, point to All Programs, point to Accessories, point to System Tools,
and then click Backup.)

The Backup or Restore Wizard starts by default, unless you disabled it. If the Backup or Restore
Wizard does not start by default, you can still use it to back up files by clicking the Tools menu, and
then clicking Backup Wizard.

Click the Next.

In the Window that asks What do you want to do? click the circle next to Back up files and
settings. Then click Next.
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Choosing what to back up

As you can see in Figure 1 below, the Backup
Utility lets you decide how much information on
your computer that you'd like to back up.

Depending on how much software you have
installed, you may not have room to back up all
the information on your computer. For most people,
the My documents and settings option is a better
choice. This selection preserves your data files
(including e-mail messages and address books)
and your personal settings.

If several people use your computer—as might be
the case on a shared PC —select Everyone's
documents and settings. This option backs up
personal files and preferences for every user with
an account on the computer.

If you know that you have data files stored outside
your profile, click Let me choose what to back
up. This option takes you to the ltems to Back
Up.

Choose where to store your backup

In the next Window you'll select the type of backup,
the place you want to save your backed up files,
and what you'd like to name them. Unless you
have access to backup tape (most people don't),
the first option will default to File.

Under Choose a place to save your backup click
Browse and choose the backup storage device
you are using.

After you've chosen a backup location, enter a
descriptive name for the file, click Next to display
the wizard's final page, as shown below, and then
click Finish to begin backing up immediately.

Backup or Restore Wizard

What lo Back Up
“f'ou ean spacily the lems pou want b back up

‘wihat do you warl o back up?
(%) My documents and sefing:
Irrchudiecs: the My Documents folder, plus pow Fayonles, deshiop, and cookies.
(O Everyore's dacuments and sellings
Irchudas ey user's My Documents foldes, phus ther Favorbes, daskiop, and
cookier
(C1.A8 imbamation on this compubss

Inchudes all data on thit compuber, and crestes & syshem sscovery disk that
can be used Lo restore Windows in the case of a major ladure

) Lint e choose what lo back up

| ¢Back || Hews | [ Cancel

Choose which files to back up

Backup or Restore Wiz rg

s

Completing the Backup or
Restore Wizard

*rou have craated the folowing backup seliings

Hame: 11800 ShatedD ocs'. My Diata Backup blf
Descoption:  Set creabed B/5/2003 of 4 23FM

Corants: Sedecied fles and foldeds

Leeation File

Tor cloge this wizard ard st the backup, cick Finish

T spescily addibonal backup opliont.
ichck, Advanced

| tgack || _Frin | [ Ccancel |

Review your back up settings.
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Networks

In the world of computers, networking is the practice of linking two or more computing devices together
for the purpose of sharing data and resources. Networks are built with a mix of computer hardware and
computer software.
Networks can be categorised in several different ways. One approach defines the type of network according
to the geographic area it spans. , for example, typically reach across a single physical location, whereas,
reach across cities or even across the world. The is the world's largest public WAN.
Networks typically consist of the following components:

e Servers

*  Workstations or Client Computers

¢ Network hardware such as hubs, switches, network cards

* Network Operating System

e Cabling

Clients and servers are devices that perform specific functions on a network. A server hosts files, databases,
Web sites, or other applications. Servers often feature higher-powered processors, more memory, and
larger disk drives than clients. Servers are also used for backup purposes. Client computers normally
request and receive information over the network. Laptops, notebooks and most desktop PCs operate
as clients. Using your desktop PC with a network card, you can access software, share files and use a
single printer via the server.

The main alternative to client/server networking is peer-to-peer networking, where network devices all
perform equivalent functions. This is a useful option to connect 2 or three computers together in a small
organisation allowing you to share files and a printer. You will still need a network card in each PC and
cabling to connect the PCs together.

Peer-to-peer networking is most common on small LANs.
What is an intranet and how does it differ from the Internet?

An intranet is a private designed for use by everyone within an organization. A very simple intranet might
consist of an internal email system or a message board. More sophisticated intranets include one or more
Web site that contain organisational news, forms, and personnel information. The essential idea of an
intranet is that it uses LAN (and WAN) technologies to facilitate communication between people and
improves the knowledge base of an organization's employees.

What is wireless computer networking?

Wireless networks utilize radio waves and/or microwaves to maintain communication channels between
computers. Wireless networking is a more modern alternative to wired networking that relies on cabling
between network devices.

Advantages of wireless networks include mobility and elimination of unsightly cables. Disadvantages of
wireless include the potential for radio interference due to weather, other wireless devices, or obstructions
like walls.
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Wireless is rapidly gaining in popularity for both home and business networking. Wireless technology
continues to improve, and the cost of wireless products continues to decrease.
You need a wireless card and a transmitter to set up a wireless network.

If your organisation needs to set up a network, you will need to call in an IT company to help set up the
computer network cards and cabling.

The Internet

The Internet is a world-wide system of computer networks that enables people all over the world to
communicate electronically. Access to the Internet is access to a wealth of information. The Internet
publishes a variety of information - news, products, software, hardware, games, music...

There are many tools which enable people to use the Internet for finding and exchanging information.
The most commonly used tools are email and the World Wide Web.

Internet tools
There are a number of ways to use the Internet to access and exchange information.

e Electronic mail (e-mail)
Sending information from one person to another, which could be a few lines of text, a document, a
spreadsheet file or a sound file.

e The World Wide Web (WWW)
Alinked network of pages of information which anyone can access. Each page consists of text, often
graphics and may contain sound and video files.

*  Mailing lists
Sending specific information on a topic to a large group of people. The information can be one-way
or can allow the group to participate in electronic discussions.

e Interactive spaces
Gives the user the ability to interact with information on a website, either by commenting on an issue
or completing a feedback form.

e Discussion groups
Public electronic discussions on the World Wide Web on specific topics.

. File Transfer protocol (FTP)
The ability to download information from the Internet onto your own computer or upload files onto
the Internet, mostly onto websites.
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Getting connected

In order to get online or connected to the Internet, you will need the following:
e Acomputer.

. A telephone line/ cell phone connection/ wireless or satellite connection
. Modem.

. An account with an Internet Service Provider.

. A computer program (software) to make all these things work together.

There are different ways of connecting to the Internet:

Modem: Most people use a modem to connect. This is the cheapest but slowest way of connecting. A
modem works at a maximum speed of 56 Kbps. A modem is a device that enables a computer to send
data over telephone lines. Computer information is stored digitally. A telephone line transmits data in an
analogue form. A modem converts between digital and analogue signals.

ISDN: This is a bit more expensive but faster way of connecting to the Internet. ISDN (Integrated Services
Digital Network) is a standard for sending voice, video and data over telephone lines. ISDN requires
specific modems so you will need to buy a special ISDN modem. ISDN transmits data at 64 or 128 Kbps.

ADSL: This is a much faster way of connecting to the Internet. Unlike the regular dialup phone service
through a modem, ADSL (Asymmetric Digital Subscriber Line) provides continuous “always online"
connection. There are different packages available for private homes or business. ADSL transmits data
at 192, 385 and 512 Kbps and charges vary according to data transmission speeds.

To get more information contact an Internet Service Provider.
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Objectives

The objectives of this section are to:

. Introduce the software that comes with most computers for performing different functions.

e Give pointers on useful applications for word processing, creating lists and budgets, as well as
presentations.

Microsoft Office

Microsoft Office is a suite or collection of “office suite” programmes that are widely used in offices,
organisations and individuals.

There are different editions of Microsoft Office (see table below). The Standard Edition of Office includes
the well known programs Word , Excel, PowerPoint and Outlook. The benefit of using office suites such
as Microsoft Office is that the individual programs all work together — for example, you can create a
spreadsheet in Excel and then paste it into Word. Or you can create a chart in PowerPoint and paste
into Word, and so on.

Open Office — a free alternative
Microsoft is very widely used and it is no doubt a very good suite of programs. The only problem is that
it is quite expensive to buy.

There is an alternative to consider — an open source office suite which you can download and use for
free. It is called OpenOffice and can be downloaded from the internet at www.openoffice.org.

The OpenOffice suite is a set of office tools similar to those in Microsoft Office. The suite consists of a
word processor, spreadsheet application, presentation package, formula editor, drawing program, data
charting application, HTML editor, and file filters that enable the importing and exporting of various
formats. OpenOffice contains everything you'd expect in an office suite. And, importantly, OpenOffice
can read documents that have been created in Microsoft Office.

Programmes in the Microsoft Office Suite

Word is a word processing programme and is used for writing documents, reports, and other publications
It has powerful features — you can format documents (changing things like fonts, letter and paragraph
spacing, making text bold or italic and so on.) You can make tables, create indexes and make hyperlinks
which allow you to link to other sections in the document, or to other documents, and even to link to
websites on the internet. The programme contains a spell and grammar checker, as well as a Thesaurus.
These are just some of the features of Word— there are many, many more.

Excel is a spreadsheet program. A spreadsheet is a program which allows you to prepare lists
— such as budgets — which require calculations. It is very useful when you have a calculation and
want to change an amount — the spreadsheet simply recalculates the total at the press of a button.
Excels allows you to sort information and to make graphs or charts. It is a very powerful program,
and like Word, has many, may features.
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PowerPoint is a program usually used to prepare presentations. Each page is like a slide which you
can add text, pictures, graphs and even sound and video clips. Once again, it is a very powerful program
with many powerful features.

Outlook is an email and contact manager. It allows you to send and receive emails, create email
address books and keep a contact list of the names, phone number, and other details of your contacts.
Once again, it is a powerful program with many features.

Access is a data base program which is found in the more expensive editions of Microsoft Office
(Microsoft Office Professional). Access is a powerful tool which allows you collect, collate and manipulate
data in a variety of ways.

Microsoft Publisher is a program which allows you to design and layout publications, such as invitations,
newsletters, booklets and so on. It comes with many sample templates and allows you to create
professional looking publications.

DIFFERENT EDITIONS OF MICROSOFT OFFICE
(Based on the latest Microsoft Office 2003)

Microsoft Office Microsoft Office Microsoft Office Microsoft Office
Professional Small Business Standard Student and Teacher
Edition 2003 Edition 2003 Edition 2003 Edition 2003
Access 2003 - - -
Excel 2003 Excel 2003 Excel 2003 Excel 2003
Outlook 2003 Outlook 2003 Outlook 2003 Outlook 2003
Outlook 2003 Outlook 2003 - -
with Business with Business
Contact Manager Contact Manager
PowerPoint 2003 PowerPoint 2003 PowerPoint 2003 PowerPoint 2003
Publisher 2003 Publisher 2003 - -
Word 2003 Word 2003 Word 2003 Word 2003
Note: This edition
is for non commercial
use only
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Microsoft word

Microsoft Word is a Word Processor. This means that you can create, edit and print documents like letters
and faxes, books, etc using this program.

Creating a document

1. Open the Word program by clicking on Start, then Programs, then Word.

2. You may have to click on Office and then on Word, depending upon how the program was installed
on your computer.

3. The Word window should display on your screen.

4. Sometimes it will open with a new document automatically.

5. Ifitdoesnt, it will open a small window that asks you to select a document type. Choose the document
type you want — such as ‘Blank Document’ — by clicking on it once. Make sure that Document is
selected under the Create New heading at the bottom right of the screen, and then click on OK.

W Microsoft Word - Documentl
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-- This is the text area. --
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+
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¥
[E]ElEI:EI"I I *
[Page 1 Sec1 1 (A r” tlnt Col1 [ﬁﬁn—x,ﬂ

The Word Window

Similarly to all Windows applications, there is a Title Bar, a Menu Bar and a couple of Toolbars. In this
program, there is also a text area.

Which toolbars do you need?
Toolbars provide shortcuts to menu commands. Word has many such commands, and there are a number

of toolbars which can be displayed on your screen. Ensure that the Standard and Formatting Toolbars
are available, as these provide icons for the most frequently used functions in Word.
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The Ruler

The ruler is generally found below the main toolbars. It is used to change the format of your document
quickly. You can turn the ruler displayed or not, as you wish. Most people work with it on, so that they
can view it as they work.

Text Area

Just below the ruler is a large area called the "text area." You type your document in this space. The
blinking vertical line in the upper left corner of the text area is the cursor. It marks the insertion point. As
you type, your work will show at the cursor location.

Saving a document
To save a document for the first time

Click on File.

Click on Save As.

A Dialog box will open asking you to enter certain the filename, etc.

In the Save in field, select the folder in which you want to save the document.
Type the name you want to give it in the File name field.

Click on OK.

o ok~ 0N~

; ﬂuw e Tradio.doc
T digital sound_Shtrainng,doc FeTr_vacz.doc
[i! evaluatel.doc ﬁ
ti! glossary.doc
kd mandoc.coc
L] netsearch.cos
'i! outlook express.doc

Floutlook expressT.doc ESN TRAINERS, doc

word Document (*.doc) I

You should continue to save your document as you work on it — if you do not and your computer loses
power, you will lose the information you have been working on. Press Ctrl-s to save your document every
15 minutes or so. You can also Click on File and Click on Save. To save with a different name, or on a
different drive, use Save as from the File menu.




3. PROCESSING AND
PRESENTING INFORMATION

Opening documents

Open MS Word.

Click on File.

Click on Open.

Select the folder where your file is saved.
Select the filename.

Click OK.

I e

Closing documents

1. Click on File.

2. Click on Close.
(

EXERCISE

Set up your Toolbars

—_

Click View on the Menu bar.

2. Click on Toolbars.

If Standard and Formatting have a tick (a checkmark ) next to them, press the Esc key until the
menu has closed.

If one or both do not have a tick, click on Customize.

Point to the box next to the unchecked word with you mouse and click once.

A tick should appear.

Click on Close.

w

N o g s

Display the Ruler

Click on View on the Menu bar.

If the Ruler option has a tick next to it, press Esc to close the menu.
If it does not have the tick, click on Ruler.

The ruler should now display below the Toolbars.

R
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Basic formatting
Text formatting and alignment

You can select which font you want to use. The font is the style of text that appears on your document.
This is one font, and this is another. You can also change the size and manner in which your text is
formatted — it can be typed in bold, italics or can be underlined. All of these options are available using
the Format menu from the Menu Bar.

1. Click on Format.

2. Click on Font.

3. Select your preferences — use the Preview in the window to check how it will appear before clicking
on OK.

4.  Select which alignment you wish to use — click on the relevant icon. If
you have already typed text and you wish to change the alignment,
highlight the text with your mouse and click on the relevant
icon.

Font
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Numbering and bullets

1. Click at the place where you want a bulleted or numbered list to begin.

2. Click on the bullet or number icon on the toolbar.

3. As you start typing, a bullet or number will automatically appear at the beginning of the line
4. Each time you press Enter, a new bullet, or the next number in the sequence will appear on the

new line.

This list of steps is an example of a numbered list created in this way.

To format your list in detail — for example, select which bullet image you want — Click Format and
then Click Bullets and Numbering.

7. A window will pop up and you can enter or select the options you wish.

8. Click OK.

o> o

s and Numbering
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Page numbering
It is possible to automatically number the pages of your document.

Click on Insert in the menu bar.

Click on Page Numbers.

A window will appear.

Click on the arrow to view the drop down menu in the Position field and select where on the page
you want the number to appear.

Repeat for the Alignment field.

Click on OK.

Hwp -

o o

Page Numbers
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Printing

To preview the document before you print it, click on the print preview icon on the toolbar. &
Click on Close to close the preview screen.

To print

1. Click File.

2. Click Print.

3. A window with different printing options will appear.

4. Select the options you want.

5. Click on OK.

Scanning a photograph & saving it as a jpeg file

Ensure that the scanner is connected to your computer and that it is correctly setup.

apr e

Place the document that you wish to scan face-down on the scanner window, as you would with a
photocopying computer.

Open the scanning software on your PC.

Click on capture image.

Click on jpeg for filetype.

Your document will be scanned and saved on to your hard disk.

EXERCISE

Open MsWord and Create a new, blank document.
Save this document in the folder you created earlier.
Copy the text from the top of section headed ‘basic formatting’ until the section headed ‘numbering|
and bullets’ (back 2 pages in the manual).

Use font type Arial, size 14 for headings and size 12 for text, and use font type Courier for any
sections using a different font.

Use bold, underline, etc where necessary.

Align all text using the ‘fully justified’ option.

Insert page numbers.

Save your document.

Print your document.

Close MSWord.
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Tables

A table can be created in two ways, either:

. Click on the “Tables” icon on the standard toolbar, a sample table will appear.

Initially, this table will be 2 rows by 5 columns wide, you can click and drag over the grid to select a
smaller area or drag and pull the grid from left to right to expand it to the size you require to a maximum
of 18 rows by 13 columns, e.g. 3 rows by 2 columns, 2 rows by 8 columns.

Or for larger tables you can use the Table menu.

Click on “Table” then click on “Insert Table”, a dialogue box will appear:

Inzert Table

Select the number of rows - unlimited - and the number of columns - a maximum of 31 by clicking on
the small arrows.

Set the column width to a reasonable size - if you leave it on auto it will fit them automatically to the
page margins. Now click on “OK”.

Once you have selected your rows and columns, a grid of lines - cells - will appear on the screen and
the ruler at the top will show the column margins. Your cursor will be in the top left corner cell. You can
now start entering your text.

Moving around the table

Use the [Tab] key to move from one cell to the next along the grid or use the cursor keys to go
in any direction you wish.
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Selecting text in tables

To select a Cell Click on the left of the cell
To select a Row Click to the left of the row
To select a Column Click on the column, then click on “Table” in the menu bar and

“Select Column”. Alternatively move the cursor over the top of the
column, till it turns into a black arrow and click.

To select the Whole Table Click on “Table” in the menu bar and “Select Table”.
To select any area Click and drag over the area you want

Adjusting the widths of columns

As you create the Table a Ruler will appear. It will show the left and right margin markers and the individual
column markers.

Click on the marker for the column to be adjusted and drag to a new location

You can also click on and drag the column grid markers to the required width in the table itself.

Alternatively you can set width of column and row height in the Table menu. This is particularly useful if
you wish to set standard widths for columns

Select the table - or columns - where standard widths apply.
1.

apr DD

Click on the Distribute Rows or columns evenly

Table Properties

Click on “Table” then click on “Table Properties”
The screen shown adjacent will appear:

Click on the tab “Column”.

Set the desired width required at “Preferred Width”.
Make the Columns or Rows the same size with The
Tables and Borders toolbar.

Click on the Tables and Borders icon to view
the toolbar.




3. PROCESSING AND
PRESENTING INFORMATION

Inserting or adding another row

Click on the insert row icon, a new row will appear.
To add another row to the bottom of the table
Position the cursor on the bottom right cell

Press the [Tab] key

Position the cursor on the row BELOW where you want the new row to appear E

arwp -

Inserting or adding another column

1. Position the cursor on the column to the RIGHT of where you want the new column to appear.

3. Click on the insert column icon, a new column will appear

2. Press [Alt] and click to select the whole column. H

To delete rows or columns

1. Select the Row(s) or Column(s) to be deleted
2. Click on “Table” then click on “Delete Rows” or “Delete Columns”

Adding up totals

There is the facility to add up the totals of the entries in a column.
Click on the area (Cell) to contain the total
Click on “Table” then click on “Formula”: A dialogue box will appear.

aumnis i E3 Select the presentation by
using the down arrow next
=SUM{ABOVE) to “Number Format” then
click on “OK”, the total will

appear in the cell.

Alternatively click on the autisum button . on the Tables and Borders Toolbar
Creating headings and titles
1. Headings and titles can be created at any point in the table.

2. Select the cells across which the heading is to go.
3. Click on “Table” then click on “Merge Cells”.

a7
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To reset heading cells as table cells

To reset heading cells as table cells or to split cells into a number of sub columns:
1. Select the cells.
2. Click on “Table” then click on “Split Cell”, a dialogue box will appear.

Split Cells K E

Mumber of columns: IE E‘
Murmber of rows: I 5‘

W Metrge cells befiore split

[0]4 I Cancel I

3. Select the number of columns you want.
To repeat the headline on each page of the table

Put your cursor in the heading on the first page.

Click table.

Click “Heading rows repeat”.

The heading will be repeated on each row of the table.

Hpwp -

Lines, borders and shading

You can add lines, borders and shading to text by using the “Borders” icon.

_:-':t |Iick on the “Tables and Borders” icon. The “Borders” toolbar will appear.

Oraw Table Easer Line Soyle Line ‘wizight Border Borders Border
Colour Shading

So|— - 1=L|E-5-
O-o@|F- 3 Ak 4 i s

hierge Split Cel Dizstribute Rows J Columns Sont Table Aatosum
Cells Bwenhy
Aignment Change direction

of teat

1. Select the text you wish to add the presentation to.
48 2. Click on the down arrows to select a “Style of Line” and “Type of Shading”
3. Use the drop down arrow beside the Borders icon to select the table lines you require.
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To clear borders or lines

1.  Select the paragraph you wish to remove the presentation from.
2. Click on the drop down arrow beside the Borders icon to select the table lines you require to delete.

To close the borders toolbar
Click on the “Tables and Borders” icon again. The Toolbar will disappear.
Templates

Atemplate is a blueprint document. It is used as a master copy from which you can create other documents
in the same format and style.

For example, our standard documents, Letter, Memo etc are produced by templates. The macros access
the relevant template, take a copy and put it on the screen.

Templates are protected from accidental change, but they are not fixed. You can open them and edit
or make changes to the format as you would normal documents. In addition, you can create your own
templates, personal to your own work, to that of your department or the whole organisation.
The templates are held on the “C” drive in the “Templates” directory, the path name is found as follows:

1. Click on Tools; Options; File Locations
2. Highlight User Templates and click on Modify to change the location
3. All template formats end with the suffix “.DOT".

Modifying current macro templates to your requirements
You may wish to make changes to the current templates, making them more appropriate to your needs.
You may want to add different formatting or your organisation’s letterhead.
* Click on “File” then “Open”
* On the “C” drive, go to the "Templates” directory to view the contents.
A list of (.dot) template files will appear.
e Click on the name of the template, then click on “OK”.

Do NOT change Normal.dot

The template is fully open, make the required amendments just as for a normal document then, without
renaming, close it and save the changes.

Because the name is the same, the macros will still run the template, therefore all standard documents
subsequently produced will show the customised changes.

Creating new templates

You may wish to create your own templates, master copies of forms that are specific to your work
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or that of your department. Alternatively, you may want to create a standard document that the whole
organisation can use. You can create new templates using the current ones as a foundation. You
can create entirely new templates of your own.

Making new versions of current templates

Using the current templates as a base you can create your own templates, e.g. letters with standard text

set up for specific purposes.

* Click on “File” then “New”, the list of templates will appear.

Genersl | peectedmanager | tegoipiesdngs | tetesmFaes | Memos
2 ] e
W] B = e
Flork WehPage  Emad  Agendfm.dot
Document Message
T ) = o T
Feesovidot  Bosrdcov.dot Comodmudot DEFECTS.DOT SO0 3 e,
5 = =
DEVLIFRML... FASFORM.... FDLCTFRM.... GRPLIRFR....
Crests New
g1 &l &l o | o

e e

* Click on the name of the template you wish to use as a foundation
Now select “Template” in the “Create New” area on the bottom right hand side.

¢ Click on “OK”.

1. A copy of the template will appear on screen. It will be headed “Template 1”. Make the changes

required.

2. When you start to name and save the document, the save screen will automatically start in the
“Template” directory and will automatically save the file as a “Document Template” with the suffix

“.dot”.

3. You will not be able to change this; the selection box will be “greyed out”. The only area that can
be changed is the “Filename” box. Enter the new template name at “Filename”.

Save As

Save in: |_| Templates

e @@ % 05 - ook -

—Ej | Agendfrm.dok
12_3 Areacov.dot
12_3 Boardcov.dot
‘ Business Planner Templates @
P& Comefrm, dat

ot efects dot
F2t| Devitrm, dot

P2t | FaxForm. dot
P2 | Fdletfrim. dot
[ | Grpltrr. dat
[ |k eyissue. dat
&L ettrfrm, dot
[ | Manual, dot
| memfrm. dot
[ | Mer gefrm, dot

MinitFrm. dot
Newlkfrm. dot
Normal.dat
Persspec.dot
Rentfrm.dot
Reprtfrm.dot
Roleprof . dot

File: name: Test Document dot

Save as bype: PR

u Save I
Cancel

4. Click on “OK”.

The new template now appears on the list of templates inside the "File” “New” screen, it can be used as

a base to create new documents.
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Creating totally new templates

1. Create the document to be used as a template, then go into “File”, “Save”
Type in the “FileName”

2. In the “Save File as Type” box select “Document Template”

3. Click on “OK”

Document Template (*,daot)

Ward Document (*,doc
[Document Templake (%, dok]
Text Only (* bxt)

Text Only with Ling Breaks (*.txt)
MS-DOS Text (*.bxt)

As soon as you select “Document Template”, the drives and directories will change to “Template” directory
and the text will become greyed out. The file will be saved as a template with the suffix “.dot”.

The new template name now appears on the list of templates inside the "File” “New” screen, it
can be used as a base to create new documents.

Accessing and using templates

Once created, templates can be accessed as many times as you wish, each time a new blank copy of
the document will appear on screen for you to complete. Templates cannot be changed by accident, only
by deliberately accessing the foundation document.

1. Click on “File” then “New”, the list of templates will appear.

2. Click on the name of the template you want to use.

3. Ensure “Document” is selected in the “New” area on the bottom left hand side.
4. Click on “OK”.

A of the template will appear on the screen as a normal document, you can change the copy in any way
you wish, then save it either as a normal document or as a different template.
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Excel

What is a spreadsheet?

A spreadsheet is a table of data, often number data that is used to represent, for example, a financial
statement or budget. Microsoft Excel spreadsheet files consist of worksheets. Each worksheet contains
columns and rows. The columns are lettered A, B, C, etc and the rows are numbered 1, 2, 3, etc.

Creating a basic spreadsheet

1. Open MS Excel.

2. There may be a new spreadsheet already opened for you. If not, go to step 3.
3. Click on File and New.

4. Click on OK.

The Excel window

As with Word, there is a title and menu bar as well as scroll bars, but you will notice that the menu options
are slightly different. There are also different Toolbars.

Below the Toolbar is the Worksheet — this is the space that is divided up into cells by the labeled rows
and columns of the sheet. You enter your data into the cells on the worksheet. There are usually 3
Worksheets in 1 spreadsheet, but you can add more if you wish to. The numbers and letters of the rows
and columns form cell addresses.

For example, the cell located in the upper left corner of the worksheet is cell A1,

2le /o

meaning column A, row 1.




3. PROCESSING AND
PRESENTING INFORMATION

At the bottom of the window is a status bar — you will notice that the wording in the status bar changes
as you enter data, for example from Ready to Enter. Just above the status bar are the tabs for the
different worksheets in your spreadsheet. You can access other worksheets by clicking on these tabs
which are labeled Sheet1, Sheet2, etc.

Eﬁfvﬁ' bi worksheets 1, 2 and 3 |
l4| 4 » [ p]\sheetl / Sheetz / Sheet3 /

Ready | | |

Entering and editing data

Place the cursor in the cell in which you would like to enter data by clicking in it with the mouse, or by
moving there with your arrow keys, type the data, and then press Enter.

After you enter data into a cell, you can edit it by pressing F2 while you are in the cell you wish to edit.
You can also edit the cell by clicking in the Formula bar and typing there.

In Microsoft Excel, you can specify which direction the cursor moves when you press the Enter key. You
can have the cursor move up, down, left, right, or not at all. The following example shows how to ensure
that the cursor is set to move down when you press Enter.

1. Click on Tools, which is located on the Menu bar.

2. Click on Options.

3. Click on the Edit tab, if it is not in the front.

4. Make sure there is a checkmark in the Move Selection after Enter box.
5. Click on the arrow to see the drop-down menu.

6. Select Down if it is not already selected.

7. Click on OK.

Saving an Excel file

Follow the same procedure as saving a file in Word

1. Click on File.

2. Click on Save As and enter the relevant information.
3. Click on OK.
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10.

1.

12.

13.

14.
15.

EXERCISE

Moving around in your worksheet

Open a spreadsheet in Excel and save it in your folder.

Press the down arrow key several times. Note that the cursor moves downward one cell at a time.
Press the up arrow key several times. Note that the cursor moves upward one cell at a time.
Press the right arrow key several times. Note that the cursor moves to the right. Press the left arrow
key several times. Note that the cursor moves to the left.

Press the Page Down key. Note that the cursor moves down one page. Press the Page Up key.
Note that the cursor moves up one page.

Press the End key. Note that "END" appears on the Status bar in the lower right corner of the screen.
Press the right arrow key. Note that the cursor moves to the farthest right area of the screen.
Press the End key again. Press the down arrow key. Note that the cursor moves to the bottom of
the screen.

Press the End key again. Press the left arrow key. Note that the cursor moves to the farthest left
area of the screen.

Press the End key again. Press the up arrow key. Note that the cursor moves to the top of the screen
(if you have entered data into the worksheet, the End key moves you to the end of the data area).
The Home key, used in conjunction with the End key, moves you to cell A1 (or to the beginning of
the data area if you have entered data).

If you press the F5 function key while in the Ready mode (see status bar, below), you will be prompted
for the cell you wish to go to.

Press F5 and The Go To dialog box will appear.

Type J3.

Press Enter and the cursor should move to cell J3.

Entering data

Place the cursor in cell A1.

Type “Electronic Library”.

The Backspace key erases one character at a time.
Erase "Electronic" by pressing the backspace key.
Press Enter.

The word "Library" should appear in cell A1.

Basic formatting

Formatting text

This is similar to the way text is formatted Word. The options are more limited in Excel, but you can still
align text, make it bold, italic or underlined, etc.

arial +10~ B £ U

rIIIII
il
]

A -I ml

You can use the icons on the toolbars or you can use the Format option on the menu bar.

J
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Using the Format option on the menu bar
1. Click on Format.
. Click on Cells.
. Click on the Font tab if it is not in the front.
. Select the settings you want.
. Click on OK.

a A~ ODN

Formatting numbers

You can format the numbers you enter into Microsoft Excel. You can specify the number of decimal places,
place a Rand or dollar sign in front of the number, or display the number as a percentage in addition to
several other options.

1. Move the cursor to cell A5 and type 1234567.

2. Press Enter.

3. Move the cursor back to cell A5.

4. Click on Format on the Menu bar.

5. Click on Cells.

6. Click on the Number tab, if it is not in the front.

7. Click on Number in the Category box.

8. Type 2 in the Decimal Places box. This will cause the number to display with two decimal places,

for example 2.00 instead of 2.

9. Click on OK.
You can also use the icons on the Toolbar to format numbers. Take Currency  Comma  Decrease Decimal
a look at the icons and compare them to the picture on the right. (B %, BB
Clicking on an icon will automatically insert formatting in the cells you Percent Increase Decimal
have highlighted. Use the method which is easiest and quickest for

you.
Automatic Calculation

If you have automatic calculation turned on, Microsoft Excel recalculates the worksheet as you change
cell entries.

Setting Automatic Calculation

Click on Tools on the Menu bar.

Click on Options.

Click on the Calculation tab if it is not in the front.
Select Automatic, if it is not already selected.
Click on OK.

aprd -
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Formatting cells

When you enter Microsoft Excel, the width of each cell is set to a default width. This width is called the
standard column width. To change the standard column width, follow these steps

. Click on Format in the Menu bar.

. Click on Column.

. Click on Standard Width.

. Type 25 in the Standard Column Width field.

. Click on OK.

. The width of every cell on the worksheet should now be set to 25.

DO~ 0N =

Another way to adjust column width is to click on the letter at the top of the
column. This will highlight the entire column. Now move your mouse pointer
over the top of the column until a double arrow appears (see illustration).
Hold down your left mouse button and drag the pointer to the right or left — this will ‘stretch’ or ‘shrink’
the column width. When you have the desired width, let go of your mouse button.

You can change the height of the rows in the spreadsheet in a similar way by clicking on the number of
the row you wish to format, and stretching it with your mouse when the double arrowed pointer appears.

Calculations & formulae

In Microsoft Excel, you can enter numbers and mathematical formulas into cells. For example, you can
quickly add up long columns of numbers. When a number is entered into a cell, you can perform
mathematical calculations such as addition, subtraction, multiplication, and division.
An example of a formula is

=al+3

& When entering a mathematical formula, place and equals sign (=) before your formula.
& Use the following to indicate the type of calculation you wish to perform:
&+ (Addition), - (Subtraction), * (Multiplication) and / (Division)

Addition
1. Move the cursor to cell A1 and type 1.
. Press Enter.
. Type 1 in cell A2 and press Enter.
. Type =A1+A2 in cell A3 and press Enter.
. Cell A1 has been added to cell A2 and the result is shown in cell A3.

a ~ ON

Subtraction
1. Press F5 and Type B1, then Enter.
. Type 5in cell B1 and press Enter.
. Type 3 in cell B2 and press Enter.
. Type =+B1-B2 in cell B3 and press Enter.
. Cell B1 has been subtracted from B2 and the result is shown in cell B3.

a ~ ON
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Multiplication

1.

o ok W

Press the F5 function key and type C1

Press Enter

Type 2 in cell C1 and press Enter

Type 3 in cell C2 and press Enter

Type =C1*C2 in cell C3 and press Enter

C1 is multiplied by C2 and the answer is displayed in C3

Division

1.

ook wN

Press the F5 function key and type D1

Press Enter

Type 6 in cell D1 and press Enter

Type 3 in cell D2 press Enter

Type =D1/D2 in cell D3 and press Enter

D1 is divided by D2 and the answer is displayed in cell D3

& Calculations are performed from left to right, with multiplication and division performed before addition
and subtraction

Functions

Microsoft Excel has a set of prewritten formulas called functions. Functions differ from regular formulas
in that you supply the value but not the operators, such as +, -, *, or /. For example, the SUM function
is used to calculate sums. When using a function, remember the following:

Use an equals sign to begin a formula
Specify the function name

Enclose arguments within parentheses
Use a comma to separate arguments

Here is an example of a function
= SUM(2,13,10,67)

begins the function

SUM name of the function

2,13, 10 and 67 arguments

Parentheses (brackets ()’) enclose the arguments

comma ‘,’ separates each of the arguments

The SUM function adds the arguments together.
Functions and calculations can be copied and pasted from one cell to another.
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(
EXERCISE

Entering a formula

1. Open the spreadsheet you created earlier if you have closed it.

2. Move to a new worksheet by clicking on Sheet2, which is located in the lower left corner of the
screen.

3. GotocellAl.

Type =3+3+12/2*4.

5. Press Enter.

&

Editing a formula

1. Double-click in cell A1.
2. Edit the cell to read =(3+3+12)/2*4.
3. Press Enter.

Typing a Function

Adding (SUM)

Click on Sheet3 located at the bottom of your window to move to a new worksheet.
Type 12 in cell B1 and press Enter.

Type 27 in cell B2 and press Enter.

Type 24 in cell B3 and press Enter.

Type =SUM(B1:B3) in cell A4.

Microsoft Excel ‘sums’ (adds) cells B1 to B3.

2 e A

Calculate an average from a series of numbers (AVERAGE)

Move the cursor to cell A5.

Type Average.

Press the right arrow key.

Type =AVERAGE(B1:B3) and press Enter.
The average should appear.

Save your file.

(oo s 0N
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Sorting data

You can sort entries in a worksheet into order — for example, i 7] ]

alphabetical order, or from lowest to highest numbers.

Sort by
ICnIumnA vl & ascending
1. Click on Data on the Menu bar. ¢ Descending
2. Click on Sort. Then by
3. Under Sort by select whether you want Ascending or I j‘ :;aﬁ;rﬁg
Descending (Ascending is from lowest to highest, or Thenby
a-z, and Descending is the opposite). |—L_| @ Ascending
4. Under My list has, select whether you want to keep the € Descending
top row as a Header(title) row — and not sorted —or, if you | My listhas
have no titles, select No header row. ¢ Headerrow & No header row
5. Click OK. :
Options... I oK Cancel

Inserting / Deleting Rows and Columns

To insert / delete a row

1. Click on the number of the row where you want a new row to appear.
Right-click.

Select Insert or Delete from the popup menu.

If you chose Insert, a row will be inserted.

If you chose Delete, the row you selected will disappear.

apr D

To insert / delete a column

1. Click on the letter of the column where you want a new one to appear.
Right-click.

Select Insert or Delete from the popup menu.

If you chose Insert, a new column will appear.

If you chose Delete, the row you had selected will disappear.

ar D

Creating charts and linking chart data to worksheets

You can create a chart, or picture, of your data using Excel. This can be useful because it gives a graphic
idea of what the numbers are saying.

To create a chart

Highlight the section of data that you wish to turn into a chart.
Include the headings — they will be built into your chart.

Do not worry about your original data — it will remain on the worksheet unless you delete it.
Click on the chart wizard icon on the Toolbar.
The first part of the 4-step chart wizard will begin. ﬂ

aprwn -
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Chart Wizard - Step 1 of 4 - Chart Type

6. Select which Chart type you want from the list on the left. If you select a type, a preview will
display on the right.

7. From the preview, click the Chart sub-type which you want.
8. Click on Next.

Chart Wizard - Step 2 of 4 - Chart Source Data

9. Under Series in, select whether you want the data to be in Rows or Columns.
10. Click on Next.

11. Fill out the chart labels in Step 3 and click on Next.

60 12. Choose whether you want the chart to be displayed in your current worksheet, or in a new one
Click on Finish.
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Power point

Microsoft PowerPoint is presentation program that is used to create slide presentations, transparencies,
slides shows, etc.

Before you create a presentation, you need to have some idea of the slides you will require to get your
idea across. If you are unsure, create a basic set of slides. They can be rearranged later and new slides
inserted.

PowerPoint Dialog Box

When you start PowerPoint you get to the dialog below where you have to choose the type of presentation
you wish to create.

PowerPoint

vanced Word 2000 Overhead. .,
Advancediwdaveoh.ppt

These are the options:

Option Result

AutoContent Wizard Starts a macro to guide you through the initial steps of choosing
the contentof your new presentation, from a selection of suggested
options.

Template Brings up the Template dialog box in which you can choose from

a large selection of colour or black & white templates.

Blank Presentation Starts a new presentation with no template attached.

Open Existing Presentation | Brings up the Open dialog box in which you choose the directory
and name of an existing PowerPoint presentation.

61



62

3. PROCESSING AND
PRESENTING INFORMATION

To Choose The Type Of Presentation You Wish To Create.

Click on the relevant option, to place a black dot in the white circle
d Click on the “OK” button

. At this point - choose the Blank Presentation option

New Slide Dialogue Box

When selecting the Blank Presentation option, you will have to choose an AutoLayout for the first page
of your presentation, in the New Slide dialog box.

The AutoLayouts are pre-designed page layouts, shown as ‘thumbnail’ pictures, offering a choice of
commonly used presentation layouts, such as a Title Slide or Bullet List.

To Choose an AutoLayout
Click on the appropriate AutoLayout thumbnail. (Use the scroll bar to see the full selection)
Click “OK”

Overview of PowerPoint screen

The following section describes the features showing on screen once you have opened PowerPoint and
chosen an AutoLayout for the first page of your presentation.
The AutoLayout shown here is a Title slide.

Title Bar Hewr Slide Windows Controls

l Button \
et Prsesat i

Standard Toolbar

Formatting Toolbar

Click to add title +— Text Fleholder

-4——  Vertical Scroll Bar
Click to add subtitle Harizontal Serall B ar

Page Up, Page

Ic—lmowm.
e — = Down Buttons

Dirawing, Speakers
Toolbar Hotes
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Title Bar

The blue Title Bar at the top of the screen shows the name of the application currently running and the
name of the current presentation being worked on.

By default the first file is called ‘Presentation’, then ‘Presentation2’, ‘Presentationd’, etc., until each file
is saved and given its own name.

Menu Bar

Underneath the Title Bar is the Menu Bar containing a list of ‘drop down’ menus. Menus are accessed
by clicking on them.

Some menu commands have been assigned keyboard shortcuts which are shown in the menu, to the
right of the menu command. For example in the File menu, the Save command is [Ctrl]+[S].

Any menu options shown in grey are not available at your current position in PowerPoint.
Toolbars

Toolbars contain buttons that enable the user to access menu commands in one easy action.
The upper Standard Toolbar contains buttons for opening, saving and printing presentations, undoing
mistakes, and inserting objects such as charts and Word tables.

The lower Formatting Toolbar contains buttons for formatting text.

At the bottom of the screen you will see the Drawing Toolbar, which contains buttons for creating,
selecting and manipulating graphics objects such as rectangles and lines.

Scroll Bars
Scroll bars are used to move around the pages in your presentation.

At the bottom of the screen is the Horizontal Scroll Bar. This is used to move left and right across the
page.

The Vertical Scroll Bar, on the right hand side of the screen, is used to move up and down a page, and
also to move through all the pages of the presentation.

To use a scroll bar, click on one of the single arrows at the end of the bar to move through your
presentation in the direction of the arrow.

or

Click on the scroll box and drag across the scroll bar.
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Next Page, Previous Page

At the bottom of the Vertical Scroll Bar there are two buttons with double arrows on them. These can
be used to move to the next page (down arrows) or previous page (up arrows) in the presentation.

View Buttons

H=E[CIaE ST

The five View Buttons are located at the bottom left hand side of the screen. These buttons control the
way in which you view your presentation. From left to right the buttons are: Normal View, Outline View,
Slide View, Slide Sorter View, and Slide Show. (These views can also be accessed through the View
menu).

Normal view
The presentation structure organiser on the left of the screen tells you which slide you are viewing and
on the formatting toolbar there is a button. The common tasks are detailed below.

Button Function

New Slide Creates a new slide. Brings up the AutoLayout dialog box allowing you
to choose a layout for the new slide.

Layout Brings up the AutoLayout dialog box allowing you to change the layout of
the current slide.

Apply Design Template Brings up the Presentation Template dialog box in which you can choose
a new template for all the slides in your presentation.

Slide setup

PowerPoint presentations can be produced as Overheads, 35mm Slides or printed out on A4 paper.
Because each format is a slightly different size (in terms of height to width ratio) it is worth establishing
the appropriate slide size at the beginning of your presentation.

The default orientation for all presentations is landscape. If you need to change the orientation to portrait,
you can do so in the Slide Setup dialog box.

To change the slide size
* In the “File” menu choose “Slide Setup

Page Setup
* In the Slides Sized for drop down list, choose Sides sized fors Orieristion ————————
. . Hon-sc 1 i~ Slides
the appropriate size - R concal |
I?Ecm & Landscape
To change the presentation to portrait |Hlsg—ht3 R, PERESE Eilie
X X . . = |G A % Portrait
¢ In the Orientation box for Slides choose Portrait iz s . ® T
* Click on the “OK” button L=
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Adding Text to your Slide

Text can be added to a slide either by entering the text into a ‘“Text Placeholder’, or by creating a text box
on the slide and then adding text to it.

Text Placeholders

Placeholders are text boxes created in the presentation template, that link through to each slide in the
presentation. The format and location of the Placeholder text is established in the template and applies
to each slide in the presentation.

Placeholders are characterised by the phrase ‘Click to add xxxx’. (This phrase does not print out if no
text is entered).

To add text to a placeholder
* Click in the Placeholder, to insert the text insertion point
e Start typing. The text automatically wraps when it comes to the end of the text box
* Press [Return] to create a new paragraph

To move to the next placeholder
e Click in the next Placeholder
or
Press [Ctrl]+[Return] to move automatically to the next Placeholder

Adding ClipArt

PowerPoint contains a large collection of ready made Clip Art pictures, including maps, flags and signs
that can be added to any slide.

To add a clip art picture to your slide
e Click on the Insert Clip Art button on the Drawing Toolbar, to open the Clip Art dialog box

The PowerPoint Clip Art library is divided into categories such as Animals, Buildings and People.
* Choose a Category by clicking on the category name
Thumbnail pictures are shown of the existing clip art for that category.
* Click on the clip art picture you require, to select it
e Click on the “insert clip” '} J button from the pop up list
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Eid Insert ClipArt
[o - @ |z

Tupe one or more words. .

X

Eavoiites Backagrounds

Buildings

Once the Clip Art is on the page it can be resized or moved to any position.

To move clip art
* Click on the picture and drag to a new position

To resize clip art
» Click on the picture to select it, bringing up the selection handles
e Click on a corner handle and drag to resize the picture while maintaining its proportions
or
e Click on a side handle and drag to change its proportions

To remove a clip art picture from your slide
* Click on the picture to select it
* Press [Delete]

Adding a new slide

There are several ways to add a new slide to a presentation. The easiest way is to use the new slide
icon on the Standard toolbar.

e Click on the “New Slide” icon on the Standard toolbar.

. Select the appropriate AutoLayout for your new slide in the New Slide dialog box.
e Click “OK”.

Mew Slhide
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The bullet list slide

Bulleted lists are a common way of displaying textual information in presentations. In PowerPoint the
Bullet List AutoLayout provides a preformatted bullet list containing five levels of bullet points. Each level
has a different bullet point such as dots or dashes, and each successive level has a smaller font size
than the previous. These styles can all be changed to suit your needs.

To create a bulleted list slide
* Click on the “New Slide” button.
* In the New Slide dialog box choose the Bullet List AutoLayout.
 Start typing in the ‘Click to add text’ placeholder, pressing [Return] to create the next bullet point.
* To move to the next bullet level down use the [Tab] key (demotes - to the right)
or
* To move to the next bullet level up press [Shift]+[Tab] (promotes - to the left)
* Use [Shift]+[Return] (a soft return) to create a new line without a bullet point.

Slide Title

First Line
— Second Line
+ Third Line
— Fourth Line
» Fifth Line

Changing the style of a bullet point

Bullet point styles can be changed individually using the Bullet command in the Format menu. But to
create a new bullet point style that can be used consistently throughout your presentation you should
change the bullet list styles on the Slide Master template.

To change an individual bullet point

e Click in the line of text associated with the bullet point to change.

* In the “Format” menu choose “Bullets and numbering” to bring up the Bullet dialog box (see
next page).

* In the ‘Bullets tab dialog box click on

e Click on the |ict i

* Click on a bullet point icon to select it.

* To make the bullet point a different size from the bullet list text, increase or decrease the
‘Size’ (as a percentage of the text size).
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* Click “OK” to okay the changes and return to your presentation.

Bullet [ 2] x|
Bullets From: Color: Size:
|[Norma| Text] j I_ vl WE % of text

PIU S Pl || (¥ ] -] A o)L 2(3(4|5|a]|7|8]9]:|; ﬂ
<|=|= |7 @L|B|C|D|E|F[G|H| T |J|E|L MO |Q|R|S|T[UV[#|
ZIV|ZI0 (V] el e dle | Elg]k] ] (k| |m]n|o|p|g|r|s
tlulviw|z|v|z[{]]|}|~[O€(0. /]| 11]5]" pd 3|« (E|OZ|O
ol | ”n——"m§}wﬂé? iElEl= 2] E] 2] |«
Sl @® T ] e e Pl s |AAAA|A|ALE|C
AERERREREREEEEE R EEEENEEBR AR
aldle|c|e|g|&le|i|{|T|i|&|f|a]|a]6|a|a] e|i|ald|i]|f|b|y =l

To change the bullet styles for the whole document

* In the “View” menu choose “Master”, then “Slide Master”.
* The five bullet levels are displayed in the bullet text placeholder on the Slide Master.
e To change a bullet style for a particular level click in the line of text associated with it

¢ In the “Format” menu choose “Bullet”.

* As described in the previous section - choose a bullet font in the Bullets From box and select a

bullet style.

* Click on “OK” to return to the Slide Master.
* Repeat these actions for each bullet point level you wish to change.

e To return to your presentation select the “View” menu and choose “Slide”

or

Click on the “Slide View” button at the bottom of the screen.

The changes you make to the bullet points on the Slide Master will affect every existing and new Bullet
Slide in your presentation, except for slides where you have changed the bullet styles on the slide itself,

as this overrides the Slide Master.
The Drawing Tools
Adding rectangles, ovals and lines

Graphics objects, such as rectangles,
elipses and lines, are all added to the page
using buttons found on the Drawing Toolbar.

Each object created on the page exists in
its own layer. The last object to be drawn
is in the top most layer and will hide any
object underneath it. To find out how to
move an object up or down a layer.

Line
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To add rectangles and ovals to your page:
 Click on the Drawing Toolbar button for the object you want to create.
* Click on the page to establish the starting point of the shape and drag down and across the
page. Release the mouse to finish creating the shape.

To add a line to your page:
* Click on the Line Tool button.
* Click on the page to establish the starting point of the line and drag across the page. Release
the mouse to finish creating the line.
AutoShapes

The AutoShapes Toolbar contains buttons for creating a whole array of interesting and useful shapes.

To bring up the AutoShapes Toolbar click on the AutoShapes button on the Drawing Toolbar Then select
the type of shape required

|{T Basic Shapes ’
)
-

To create an autoshape shape:
* Click on the AutoShape button for the shape you wish to create.
* Click on the page and drag down and across.
* Release the mouse to finish creating the shape.

Moving and Resizing Objects

All the objects that you create on your page can easily be moved into a new position.
To move any graphics object:

e Just click on the object and drag it across the page.
To resize a graphics object

» Click on the object to select it. This will bring up its selection handles.

* Click on a handle and drag to resize.

69



70

3. PROCESSING AND
PRESENTING INFORMATION

Formatting Objects

All graphics objects in PowerPoint can be formatted. The formatting options available for objects are fill
colours, border lines styles, Text Colour shadows and 3D formatting.

In order to format any object you must select it first. You can select multiple objects together and apply
the same formatting to all the objects in one go.

Selecting Objects
You can tell if an object is selected because its eight selection handles will be visible.

To select an object:
* Click on the object.

To select multiple objects by clicking;
* Click on the first object you wish to select.
* Hold down the [Shift] key and click on each additional object.

There is a faster method available for selecting a large number of different objects.

To select multiple objects by dragging: E
* Click on the “Selection Tool” on the Drawing Toolbar

* Click on an empty part of the page and drag out a rectangular box shape that encompasses
the objects you wish to select. Everything totally contained within the box, when you release the
mouse, will be selected.

To deselect an object you did not want included in the multiple selection:
* Hold down the [Shift] key and click on that object.

Formatting fills, borders, text shadows

There are buttons on the Drawing Toolbar that can be used to formatting objects

Line PR
Colaur Style * Select the object
* Click on the relevant format button, These buttons will
Line 20 . . .
Ste Tool bring up a palette of options to select from. Click on the

option of your choice to select it.

} |

|&r‘v£1i§.E.ﬂ-|

! !

Text Shadow
Colour Tool

Fill [razh
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Creating Arrows

We have already seen that there are a number of fat arrow shapes available in the AutoShapes Toolbar.
However, if you want to create a thin arrow in PowerPoint, you must create a line and then apply an
arrow head to it, using the Arrowheads button.

To create an arrow:
* Use the Line Tool to draw a line on your page.
e Select the line.
* Click on the Arrowheads button.
* In the drop down menu select an arrowhead style.

Adding text to graphics objects
In some presentation programs, to create a shape that contains text, you have to create the shape and

the text as two separate objects, and then lay the text over the top of the shape. In PowerPoint all
graphics objects (rectangles, ovals and autoShapes, etc.) can have text inserted into them.

AutoShape
containing

Rectangle Cir:_:lg
containing text containing

AutoShape

containing text text

text

To add text to a graphics object:
* Right click on the shape and select Add Text, this will insert the text cursor into the shape (if the
shape has no fill you will have to double click on the shapes border).
* Type the text you wish to insert.

The text will be inserted in one long line which may stick out of the object. To remedy this you can either
resize the object using a selection handle. Or you can make the text wrap around at the end of the
object’s borders using the Text Anchor command (see next).

Text Anchor - Wrapping text in an object | Foimat AutoShape

To turn on word wrapping in an object:
* Select the object.
* In the “Format” menu choose. “Auotshape”.
* Click on the Text Box tab.
e Turn on “Word-wrap text in auotshape”.
e Click “OK".
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Slide sorter view

The Slide Sorter View can be used to get an overall view of your presentation and to reorder your slides.
It can also be used to copy and paste slides, within the same presentation, or between different
presentations.

Viewing your presentation in slide sorter view:
* Click on the Slide Sorter button at the bottom left of the screen L2
This brings up small thumbnail sketches of all the slides in your presentation. You will be able to
see about six slides at a time. Use the vertical scroll bar to scroll up and down through the rest of
the slides in your presentation.
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Changing the order of slides:
* Click on the slide you want to move and drag it between the slides you wish to place it between,
then release the mouse.

Copying slides:
* Click on the slide you want to copy, this will select it and place a thick border around the slide.
* To copy multiple slides, hold down the [Shift] key and click on each additional slide.
* In the “Edit” menu choose “Copy”.
* When you paste slides in, they are pasted after the selected slide. Click on a slide to establish
the position the new slides will be pasted in. In the “Edit” menu choose “Paste”.

Copying slides to another presentation:
* In Slide Sorter view, in the presentation you wish to copy slides FROM, select and copy the
relevant slides.
* In Slide Sorter view, in the presentation you wish to copy SLIDES to, select a slide to establish
the position that the copied slides will be pasted in, and in the “Edit” menu choose “Paste”.

To return to normal view:
* Select the slide you wish to view, by clicking on it
¢ Click on the Normal View button at the bottom left of the screen
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Deleting slides
The easiest place to delete a whole slide is in Slide Sorter View.

To delete a slide:
» Select the slide you wish to delete
* Press the [Delete] key on the keyboard

Slide Shows
Once you have created your presentation you can display all the slides as an on-screen slide show.

Running a slide show:
* Go to slide that you want to start viewing from
¢ Click on the “Slide Show” button at the bottom left of the screen, to start the slide show

To move to the next slide in the show:
e Click the left mouse button, or press the [Page Down] key, or the [Return] key

To return to the previous slide:
* Click the right mouse button or press the [Page Up] key

To draw on a slide during the slide show:
* Right click with the mouse
* Select Pointer Options and then pen
* You can now click and drag across the slide to draw a temporary line on it
e To turn off the draw feature Select Pointer Options and then Automatic

To stop a slide show:
The slide show will stop automatically when you try to move past the last slide in your presentation (unless
you have set it to run in a continuous loop - see Automating a Slide Show)
* When you reach the last slide - click on the slide, or press [Return] or the [Page Down] key
* To stop the show at any point during the show, press the [Esc] key

Slide show effects

You can add special effects that make the transition from one slide to another more interesting during
your slide show.

When you are in Slide Sorter View the Slide Show Toolbar is automatically displayed. This toolbar can
be used to apply effects to slides.

Applying an effect to a slide
d In Slide sorter view, click on the slide(s) you want to apply the effect to
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* Click on the “Transition” button on the Slide Show Toolbar to open up the Transition dialogue
box

Slide Transition

fosardl =

I} Conp untl o tipie|

* In the Effect drop down list choose a transition effect.
e Choose a transition Speed.

You can also choose to advance automatically on to the next slide after a chosen number of seconds.

But this will not actually work until you go into the View menu, choose Slide Show and turn on the Use

Slide Timings feature for the whole slide show (see Automating A Slide Show).
* Click “OK”.

Automating a slide show

You can set up a slide show so that it runs by itself. You can choose how long, in seconds, each slide
remains on the screen before changing to the next. If you are not sure how long you will need each slide
to remain on screen, during a presentation, you can rehearse the timing of the presentation in order to
find out.

Rehearsing the timing of the presentation
* In Slide Sorter View, click on the “Rehearse Timings” button. This starts running the slide show
II_IF‘? A small clock appears in the bottom left of the screen, to time how long each slide remains
= on screen
* Rehearse the talk you will give while the slide is showing, then click on the slide or press [Return]
to move to the next slide. When you reach the end of the presentation a dialog box will appear,
telling you how long the total presentation will take, and asking you if you wish to record (save)
the new slide timings.
e Click on “Yes”

Microsoft PowerPoint

(?)

7%
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Once the slide timings have been set you will notice, in Slide Sorter View that the timings for each slide
appear underneath the slide thumbnail on the left. Where, for example, 02:30 means 2 minutes 30

seconds.

You can change the timing for a single slide without having to rehearse the whole presentation again

To change the timing for one slide:
* In Slide Sorter View, click on the slide you wish to change.
* Click on the “Transition” button on the Slide Show Toolbar to open up the Transition dialog box.
* In the Advance area, replace the existing number with a new time (in seconds).

* Click “OK”.

To run an automatic slide show:
* In the “Slide Show” menu choose “Set up Show”, to bring up the Setup Show dialog box.

Set Up Show

[ Hw=:[ H
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* In the Advance slides category choose “Use Timings if present”

e If want your slide show to run in a continuous loop, click in the “Loop continuously until
‘Esc’” box.

* Click on the “Show” button to start the automatic slide show.

The slide show will run through by itself, using the slide timings that have been Rehearsed, or set

in the Transitions dialog box.

You can press [Esc] to stop the show.

Using templates

A Template is a presentation in which certain key elements have been specially designed to create a
particular ‘look’. These elements are the background colour and design, and the size, style and position
of the Placeholder text boxes (i.e. the main title and bullet list text).

Templates are useful for giving a presentation a professional look and for ensuring a consistent
style throughout. They can also be customised to make sure an important element, such as a
company logo or file reference, appears on every slide.

7%
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Here is an example of the same text slide with four different Templates assigned to it.

|=uu|
o
L]
Our Success Story ga Our Success Story
a4
peee @ Great strategic planning m Great strdegic planning
& Wis irvestment inthe future m'\Wise investment inthe future
@ Short term - Shortterm
e Long term - Longterm
# The verybest people u The very best people
 The right time to move m The right time to move L.
# Personalachieveme nt m Personal achievement E
Our Success Story
il ® Greats ratezic planring
1 » Wise novestmernt m the fatue
+ Shoit temm =
= Lang terrn .d
# The verybest people :
® The rght time to move i : i
& Pessoralarlosvesimt ] ® Pesoral aclie verent
1EE

The information that creates the Template is stored in the Slide Master. There are actually four different
Masters - Slide, Outline, Handout and Notes. Each Master relates to a different way in which you can
print out your presentation. But the most important Master is the Slide Master.
When you apply a new Template to your presentation you are actually changing the Slide Master. If you
wish to edit a Template you need to edit the Slide Master.

Changing templates
You can change the Template of your presentation at any time.

To change templates:
* Click on the “Common Tasks” Apply Design Template. This will bring up the Apply Design Template
dialog box.
» Select a template in the list. Once you select a template, a small preview of the template will
appear in the right of the dialog box.
» Click on the Apply button to apply the template to your presentation.

Apply Design Template [ 2]x=]
Lookini (] Fresertation Designs =l | @ X 5 - Toos -

Azure.pot
Bamboo. pot
Blends.pat
Blue Diagonal pat
Blueprint pot
Bold Stripes.pot
(3] Business Planner Templates
Cartus pat
Capsules. pot
Checkers. pot
Citrus.pot
Construction. pot
Dad" s Tie.pot
Expedition.pot

Factory.pot =l
7@ Flaname: | =l & Agply |

B Files of bype: [pesign Templates (* pot) =l Cancel |
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The slide background

The underlying colour of a PowerPoint slide is the background colour. You can change the background
colour of your presentation at any time. You can also change the background colour of just one slide in
your presentation.

To change the slide background:
* Move to the slide you wish to edit.
* In the “Format” menu choose “Background”.

B ackground

P Title of Slide
= Bullet text

* Click on the “More Colours” button to bring up a colour palette.
» Select a new background colour and click on the “OK” button.
* Select a Fill Effect if required.

Having chosen a new background colour you can now apply it to the slide you are currently working on,
or to every slide in your presentation.

To apply the background colour to the current slide only:
* Click on the “Apply” button.

To apply the background colour to every slide in the presentation:
* Click on the “Apply to all” button.

Saving your presentation

If you are saving a presentation for the first time you will need to choose a name to save it with,
and a directory to save it into. Presentation file names cannot be longer than eight characters.
PowerPoint files are given the three character extension ‘ppt’ (you do not need to type this in when
you save the presentation).
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Saving a new presentation:
* In the “File” menu choose “Save As”.
* In the File Name box type in a name for your file.

Save As EHE
Save in: |_| Personal j - | @ b4 ﬁ +* Tools =

| Imy Pictures

| 1My Webs

caplastering.ppt
pa=d shorteut ko iktrain on 'grofps1' (M)

File: name: j EH save I
Save as type: IPresentation (*.ppt) j Cancel |

» Select the relevant drive by clicking the Save in drop down arrow.

» Select the relevant directory and sub-directories by double clicking on each. directory name in
turn from the lists shown.

* Click on “Save” to save the presentation.

Saving a presentation to include the latest changes:

+ Once you have saved and named your presentation for the first time you can save the presentation
at any time, to include the latest changes, using the Save button.

- ltis a good idea to save your work regularly, perhaps every 15 minutes, especially if you are
working on a large presentation containing many charts or inserted Word or Excel tables, as your
computer will be at greater risk of crashing.

* Click on the “Save” button on the Standard Toolbar.

Closing a presentation
It is a good idea to save your presentation before you close it.

To close a presentation:
* In the “File” menu choose “Close”.

If you try to close a presentation that contains unsaved changes, a dialog box will appear asking you if
you wish to save your changes before closing down the presentation.

» Click “Yes” to save and close the presentation.

* Click “No” to close the presentation without saving
the changes.

* Click “Cancel” to return to your presentation.

& Do wou want to save the changes you made ko Presentation1?

o | Cancel |
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Opening an existing presentation

To open an existing presentation:

In the “File” menu choose “Open”.

Select the relevant drive, by clicking on the Look In drop down arrow.

Select the relevant directory and sub-directories by double clicking on each directory from the
list.

A list of the PowerPoint files in that directory will appear with a preview of the first slide on the
right hand side of the Open dialog box. Click on the file you want.

Click on the “Open” button.

Printing

PowerPoint presentations can be printed in several different formats. You can print out each slide on
its own A4 page, you can print out Notes Pages, or you can print out Handouts where a number of slides
are printed on one page to give you a condensed view of your presentation.

To print your presentation:

In the “File” menu choose “Print”, to bring
up the Print dialog box.
In the Print What drop down menu choose \WGROFPSZIIT_4000
what you want to print, where:

Slides prints out one slide to a landscape
page (unless you have changed the
presentation default to portrait).
Notes Pages prints out the prompt notes
pages you created using the Notes Pages
View, on a portrait page.

Handouts (2 slides per page) prints out
two slides, scaled down, on a portrait
page.

Handouts (3 slides per page) prints out
3 slides, scaled down, on a portrait page.
Handouts (6 slides per page) prints out
6 slides, scaled down, on a portrait page.
Select the number of Copies to print
(generally, if you want multiple copies of
your slides you should print one copy and
then use the photocopier).

Select the Print Range, where:

All - prints out all the presentation.
Current - prints out the current slide you are working on.

Slides - allows you to choose a range of slides (e.g. 3-6 to print out pages 3, 4, 5 and 6).
Click on the “OK” button to send your slides to print.
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Objectives

The objectives of this session are to:
e Gain a basic understanding of how messages can be created and sent using a computer and
the Internet.
* Understand the difference between having an E Mail address using an e mail client and a web
mail address; as well as the intersection between the two.

Email basics

An email client is a program (software) which allows you to send and receive electronic mail. Examples
of email clients are Eudora, Microsoft Outlook, Microsoft Outlook Express, Pegasus Mail, etc. You can
also access your email using a web-based email system such as Hotmail, Yahoo, Webmail, etc. Often
Internet Service Providers allow you to access email both ways.

In this manual, Outlook Express is used as the email client and Yahoo is used as an example for web-
based email.

An e-mail address looks something like this:
tendai@pcliteracy.org.za
and each part of it means something different.

tendai The person who will receive the email message (username)

@ This symbol means ‘at’ and means that the user is at a certain internet address.
In this case tendai (user) is @ pcliteracy.org.za (address)

pcliteracy The organisation where the email is registered — often it will be the name of the
ISP which provides the email account (e.g. Mweb and lafrica)

org This is a nom-profit organisation usually (but not always) — an extension like
"co" means it is a company, "ac" is academic, "gov” is government, etc

za The country where this organisation is located — za means South Africa, uk

means Britain, zw means Zimbabwe, etc. The USA does not have country name
extensions e.g. www.mail.com

MS Outlook Express

Outlook Express is a Microsoft product and can only be used with the Windows operating system.
To open the program

1.  Click Start then Programs then Outlook Express to open the programme.

2. Alternatively, locate the shortcut icon (see picture below) on the desktop and double-click on it with
your mouse.

Outlook Express
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Sending & receiving messages

Create a message

WS Outlook Express

You can set-up a hew message area
with a simple click of the Compose
Message button. This is labeled
New Mail in some versions of Outlook. s Ou

LELF LS I_Auress -

1. On the toolbar, click the New Mail button. A new message window will appear
2. Inthe To box, type the e-mail address of the person you are sending the message to. For example,
tendai@pcliteracy.org.za.

% 3. Inthe Subject box, type the subject of the message. For example, if the message is about a request

82

for ICT training for your community, type Request for ICT Training.
4. Type your message in the message area.

Internet Etiquette, or Netiquette

J Never type in CAPITAL LETTERS - it is like shouting.

*  Avoid abusive language and angry emails — remember that you may regret them once they have
been sent, and email is kept on record.

e Try to keep your email messages short.

e Try to avoid language that is culture-specific — someone in Japan may not understand you if you
reply with a word or phrase that is only found in Southern Africa.

*  Be gender sensitive — avoid sexist and labeling language.

Send a message
1. On the toolbar, click the Send button. Depending on the connection you have to the Internet,

a message box may appear telling you that the e-mail message is being moved to the Outbox.
If it does appear, simply click OK.
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You can set it up so that your messages
are all sent later OR you send them straight
after you type each one. To change this
setting, click Tools...Options... Send.
Click the ‘Send messages immediately’
option if you want them to be sent as you

type them (a in the box next to this option s Outlook Express
means it has been selected). EX S Lotal Folders
To send the message from the Outbox, mg%
click the Send and Receive button. @

Sending attachments

Many types of files can be attached to e-mail messages: Word documents, PowerPoint presentations,
graphics, sound clips...there's no limit. Just make sure you know where the file is located on your computer,
and you're ready.

On the toolbar, click the New Mail button to open a new message window and type your message
Click the Insert menu, then click File Attachment m]
(Or, click the File Attachment icon on the toolbar). Attach
The Insert Attachment dialog box will open.
In the Look in box, find the location of the file. Is it on your hard drive or a floppy disk?
In the File name box, type or select the name of the file, then click the Attach button. A file attachment
icon will appear beneath your message.

Click the Send button to move your message and attachment to the Outbox.

Viewing an attachment in a message

How do you know when someone has attached a file to a message? Look for the paper clip icon next
to the message title in your message list.

In the Message list, double-click the message. The message window will open, and the attached
file icon will appear beneath the message.

2. To open the file, double-click the file attachment icon.

EXERCISE )

1. Give the person on your left your email address.

2. Follow these steps to find your email address if you don’t know it.
Click on Tools and then Accounts.
Click on Mail and Properties.
You will see the email address of the PC in the window which opens.
Click on Cancel and then click on Close.

3. Now send an email message to the person who gave you his or her address

4.  Now send an email message with an attachment of the Word document which you worked on
earlier.
Open your new mail and open the attachment which has been sent to you.

/fw
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Creating folders for storing email messages

You may wish to keep messages around different projects or from different people in separate folders.
This will stop your inbox from becoming too full and will help you to work with your mail in an organised

way.

ok wbd-=

In the Outlook Express window, click the File menu, point to Folder.

Click New Folder. The Create Folder dialog box will open.

In the Folder name box, type a name for the folder. For example, Library staff.
In the Folder List box, select where you want to place your new folder.

Click OK.

Moving messages to a folder

When you have created your first folder, you can move or copy messages to it.

In the message list, select the message you want to Move

move by clicking it. Move the item(s] to the sslected folder
With the message(s) selected, click the Edit menu, then p— -

click Move to Folder.

The Move dialog box will open. "EE"

In the Folder List box, click on the folder you want to Highlight the folder you want
move a message to and then click OK to close —
the Move dialog box. Your message will be stored in

the specified folder.

Directing incoming messages to specific folders

Instead of moving messages to folders manually, you can tell Outlook Express to do it for you. Simply
tell it which messages to look out for and what it should do with them.

Read through the following example, where messages written by Tendai are moved to a folder called
Community training.

1.

In the Outlook Express window, click the Tools menu, then click Inbox Assistant. The Inbox Assistant
dialog box will appear.

Click the Add button to open the Properties dialog box.

In the Properties dialog box, type the criteria that will be used to ; |£m ﬁ“
filter messages. In this example, the filter is all messages from —
Tendai. In the From box, type Tendai’s e-mail address.
In the "Perform the following action" area, click the Move To check box, then click the Folder
button. The Move dialog box will appear.

In the Move dialog box, select the destination folder for the filtered messages.
Click OK to close the Move dialog box. The name of the destination folder will be displayed
in the Properties dialog box, next to the Folder button.

Click OK to close the Properties dialogue box, then click OK to close the Inbox Assistant
dialogue box.
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EXERCISE

1. Create folders for all the people in the training room.
2. Set up mail direction rules which will automatically filter messages you receive from these people
into their folders on your computer.

Address Books

The Address Book is a convenient place for you to store e-mail addresses. You can add new contacts
to your Address Book by typing them in or by adding them directly from e-mail messages.

Typing in contact information

\ J

1.  Click the Address Book button. The Address Book o
window will open. Ela: Ecit View Tools
2. Onthe Address Book toolbar,.cllck the New. Contact . e O B o
button. The Properties dialog box will open. Mew Contact the properties dialog box
3. Click the Personal tab and type the contact's first

is automatically added to the Display box. If you Pessonal | Home | Business | Other | Nethesting| Digital IDs |

want a different name to appear in the box, type
it in. Enter personal information about this contact here.

and last name in the name boxes. The full name

4. In the Add new box, type the contact's e-mail
address, then click OK. The contact is now saved (

E-Mail Addr

Add new: I

in your Address Book.

Deleting messages

You will often need to delete messages as your mailbox will become too full. You can also delete messages
that are not needed for documentation or record-keeping after you have read them.

1.  Click on the message you want to delete
2.  Press the Delete button on your keyboard

Adding a personal signature to your messages

When sending e-mail messages, it is useful to attach a signature. A signature is a block of text at the end
of a message which identifies you and tells the recipient how they can contact you.

Creating a signature

1. In the Outlook Express window, click the Tools Signature
menu, then click Stationery. The Stationery T&;&f&%ﬂ“ﬂﬁ‘&“
dialogue box will open. et usness Cadfle (Card)loyo gingie,.
2. Click the Mail tab, then click the Signature button.

|
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\ The Signature dialogue box will open.
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3. Select the option button next to Text, then type your signature in the text box provided.
4.  After you've created your signature, click OK to close the Signature dialog box, then click OK to
close the Stationery dialogue box.

To add your signature to an individual message

28 New Message
File Edit View

48 Format Tools

=Isend | = File Attachrment. .
1. Type your message. II Tewfom Fie..

2. When you are finished, click the Insert menu, then click Signature.
3. Your signature will appear at the end of your message.

Webmail

You can set up an email account which you can use with an Internet browser. You can setup your own
email address for free at or, or or and read your mail from anywhere in the world. You will still need
an Internet connection (e.g. at an Internet café or on a friend’s computer) to send and receive messages.
% To set up your E Mail account take the following steps:

Step one: Go to www.yahoo.com

Fle Edt View Favortes Tooks  Help

s - 5 Q[ 4| Qs Grovorss Fress I - S S - Wl BB
Address [ ) bt v yoboo.com

Gat ahoo! Toolbar wth Ant-Spy

@ ® ® YRHOO! @ w %

inan. by Yahao! ger

Balesd Saaich Calegoer m:mm;r’. Video | Directory | Lacal | Mews | Products

Search the Wab: |

Yahoo! search | JEEEL,
Yahoo! Search Marketing - (Gt mare raverus from your wih site with Spansared Search. Find aut how

I\ Chack your mall status: Sign ln
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* Enthusia: Professional Racing
* Brothers in Asns
« Fragdom Force vi. Third Reich g

* More Came Previews

Yahoo! Small Business

Wab Hosting  Sell Online
Diornain Names Search Listings

Yahoo! Featured Services
Parsonal Website Parsanals

Fardasy Baseball Careers

Entertainment

o Mare Entertainment

Fras il Sign Up e ——— Click on
Autvs Hialth Muwirs Real Estate T 4 Uniimited access 1o 800,000 songs
Careers Heroscopes Muzic Shopping w Gt a free trial il-
Free mail:
Finance Mail News Travel In the News 100 i
Games Maps People Search TV
GeoCities Messimger Personats Yollow Pages + Dozans of bodies found in Tigris river Slg nu p
Groups Mobile Photos P - * Benedicl's papacy takes shape
= Ethus chasman proposes probe of Detay
- = Connecticut approves civl unions for gays
Yahoo! Games Reviews | News | Downloads | More » Muslims sue LS. over border detentions
. = Study says gentrfication belps urban poor
P \V1deo Game Previews: - Singh namowly slectod to golf Hall of Famo
+ NBA, Streed V3 = HBA - ML - NFL Dvaft - Soccer - Tennis

P = Popular « Sports « Stk

Dakland. CA o Ehangs Lacation
Weather  titandad Farass -
. Today Tomuorrom
{} Marthy Sunny & PM Showars
REEF <l 81 "7 hiBIF - Io STF
Traffic
 See traffic for Oakland, CA

Step two: Click on “Sign up for Yahoo Mail”. Free mail is bottom left.

YaHOO! MAIL

“Yaheo! Mail
Free, rellable, and easy to use

‘Yahoo! Mail Plus
Bore control and capacity.
* Mo gesziicsl ate

Personal Address

o raal spam prabaction with

Mall that's made just for you
* CEDUENOURRaEE o, I vaRable

SpamGused * Mo pecenosonsl lAgins i Massages e CYRANE UD 8 Tw dofRRn addresa8s
Vg 3eRnning Bnd claaning fram o sang muse
Horton Antivirus™ & SpamOuan Pius halss s1op svan & Cowmyaur domain namsa
* ALCEER AMAWHBIE i have 3 wab Mg Ut mal 3 iars
eannaction o il unbied storsge - 08
» Awnopging TS0ME emal £rage Lean Mace
Leam Mg

Drder Porsonal Addiess
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Step three: Fill in form and click on “l agree”

YaHOO! MAIL

Help

[ Already have an ID or a Yahoo! Mail address? Sign In.

Fields marked with an asterisc * are required.

Create Your Yahoo! ID

* First name: I

* Last name: I

*+ Praferred cortert: [Y'ahoal ULS 'I E

# Gender: |[Select] =

* Vahoo! D @yahoo.com
ID mary consist of 8-z, 0-9 and underscores.

* Passyvord. I

Six characters or more; capitalization matters!

+ Retype passyword: I

If You Forget Your Password...

* Security question: I [Select a Question] j

# Your answer: I

Four characters or more. Make sure your answer is memorable for you but hard for others to guess!

* Birthday: |[Select a Month]j dd IWW |
# IPPostal code:

Afternate Email

H]

Customizing Yahoo!

Incfustry: |[Se|em\nduslvy] j
Title: |[SelectaTitle] =

Speciaiization: | [Select a Specialization] =

Verify Your Registration

* Enter the code shawn I More info £

This helps Yahoo! prevent automsted registrations.

Terms of Service

Please review the following terms and indicate your agreemert below. Printable Wersion

1. ACCEPTANCE OF TERMS ﬂ
Tahoo! Inc. ("Vahoo!"™) welcomes wou. Fahoo!
provides its service to you, subject to the
following Terms of Service ("TOS™), which mway he ;l

By clicking "l Agree” you agree and consert to (a) the Yahoo! Terms of Service

anid Prival receive recuiredd notices from Yahoo! electronically.

| Agree | Do Mot Agree

v

Step four: Verify your registration.

Verify Your Registration

# Enter the code shown: InEvEIF More into £

Thiz helps Yahoo! prevent automated registrstions

Code verification technology deweloped in collaboration with the Captehs Project st Camegie Mellon Unive rsity

Copyright @ 2005 Yahoo! Inc. All rights reserved. Copyright Policy Terms of Semice
MNOTICE: We collect personal information on this site.
To learn more about how we use your information, see our Privacy Polic
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Step five: You will see that your registration is completed.

Yz2HoOO! MAIL Yahoo! - Help

Registration Completed: Welcome cleverboy4321!

© A confirmation message has been sent ta the Email four *Yahoo! ID:
Address you provided. Please read the ernail and follow cleverboy4321
the instructions to fully activate vour account.
“our Yahoo! Mail Address:
VWe also recommend that vou print out this page E cleverboy4321@yahoo.com
far future reference. our Aternate Emai:
marc@eontentatfrica.net

© Ifyou forgetyour passward you will be asked Security Question: ) Date of Birth:
for the following information. What is your favorite pastime? April 18, 1956
Your Answer: ZIPiPostal Code:
sleeping 21498

o Your Marketing Preferences: Select and customize the categaries of communications you receive about Yahoo! Products and
semices. You can also choose to optout of each. Edit Marketing Preferences

Caontinue to *ahool Mail

Step six: You get a welcome message and are ready to send your first email. Click on “compose”
message to create your first message.

‘Yahoo! iy vahoo! Mail Searchl— |
the Wb Search I
Hoo' welcomne, cleverboy4321
L MA' L [Sian Cut, My Account]

Mail Home - Mail Tutarials - Help

\ETIBA Addresses  ~| Calendar ~| Notepad ~ What's New - Mail Upgrades - Mail Options

[ s nail | _comoors | [ | sewat || seacntewer |
| Welcome, Marc! 0% of 250.0ME

g Get your credit |
back on track

354 ‘ou have 1 unread message

o Inbox(1)
Folders [Add - Edit]
Canbox (1) D Today's tip: Keep getting spam from a certain domain? You can block an
(R Draft entire domain. Learn mare
3 Sent R
Start up your new mailbox!

(g Trash [Ernpty]

elee] GEmaS - Set up your Address Book
Come and play

v Put your contacts within easy reach so it's a shap to stay in touch

More from Yahoo!

My Yahoo!
check out 3 preview of your Yahoo! Mail inbox - a2
well as personalized news, weather and mare!
Yahoo! Messenger

Make it your own Get an alert whenever you have new mail, and

H S . communicate instantly with your online friends,
Personalize Mail with your choices of colors and themes 4 ¥

- Announce your new email address
e Send an email to your contacts to let therm know your ¥Vahoo! Mail

address

et ||_compone | | e [ et |
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Step seven: Write your first email from your Yahoo address:

“rahoo! My vahoo! Mail

Welcorne, cleverboy4321
hHOo!a MAI L [Sign Cut, My Account]

I"ETIMRA Addresses = | Calendar = | Notepad ~

e | sove e ot || spechc || cance |

Insert addresses or enter nicknares (separated by comrmas)

To: |tendai@contentafrica.net |

Cc: |Sim0ne@contentafrica | Bcee: | |

Subject: |My new email account |

Attach Files |

Dear Tendai and Simone,

Hope all is well with you both. I have just signed up
for a free email account at Yahoo. I am so excited.

Love and regards

Harcg

Step eight: You will also get an email containing account verification with all details which you
should keep for your records.

 Welcome to Yahoo! Please Activate Your Account. - Message (HTML)

© File Edit Wiew Insert Format  Tools  Actions  Help Type & question for help &

From:  Vahoo! Member Services [yahoo-register@ce. yahoo-inc,com] Sent: Thu 4/21/2005 11:50 AM
To: marc@contentaftica.nst
@

Subject:  Welcome to Yahoo! Please Activake Your Account.

YARHOO! 4553 on Help

Do not reply to this message. If you did not create an account, please follow the instructions at
the end of this email

Welcome to Yahoo!

Click the link below to verify your email address and activate your account. Email verification helps
pratect your identity and allows you to participate safely on all of Yahoo!'s properties

Important! Click here to activate your new account.

Your Yahoo! ID: cleverboy4321
‘our new Yahoo! Mail address: cleverboy4321@yahoo.com

Your alternate email. marc@contentafrica.net

If you can't click on the sentence labeled "Important!” ahove, you can also verify your email address
by cutting and pasting (or typing) the following address into your browser.

http:#/edit. yahoo.comivrecy?788008 8. intl=us

For your records, your verification code is: 788008

Click hete to review your Marketing Preferences. You can select and customize the categories of
communications you receive about Yahoo! products and services, or choose to opt-out of each,

What can | do with my new Yahoo! ID?

=&y Yahoo! Mail %@ HotJobs, a Yahoo @) Yahoo! Chat
Tt yrour own, Senice Chat with peaple from all aver
yahoo.com email Hearch for a job quickly by city, the world,
address

iHstart |J

industry or keyword. New jobs i
MRBLBO®SOH N @ »| | Elimbox - Maroso...| &)vahoat i -cl.. | Miekometova... | [ WAL H@E D 115440
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Adding an attachment to a web mail message (Yahoo mail)
1. Login to your Yahoo mail account.

2. Click on Compose to prepare a message.

3. Fillin the To: box and the Subject: box.

Inzert addresses | Add €C - Add BCC

To: [tendai@pcliteracy.org.za
Subject: lMimm of meeting

& Attach Files

YXOBFLBIIZLO0QEE®R ni%muﬁl
B

@ l' Use my signature .

% 4. Click on Attach Files to attach a document to the message

Calendar ~ Notepad ~

Attach Files

Click "Browse" to select a file. You can attach files up to a
total message size of 10.0MB [VWhat's this?).

File 1:| I_
File 2: | |_
File 3: [ ‘_
File 4: [_
File 5: [ [_

Aftach More Files

To avoid sending an infected file, your attachment
will be scanned by:

Antivirie

PC users: Select "All Files" for "Files of Type". If you don't
see a "Browse" button, your browser doesn't support
attachments,
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© N>

Click on Browse to search your hard disk for the document you want to attach.
Double click on the name of the file to attach.

Click on Attach Files at the bottom of the screen.

You will see a screen with the attached file name.

LETIRRE  Addresses ~| calendar ~| Notepad ~

Attachments
The following file has been attached:
& Training for Gender Links Members.doc (50k) [Remove] Mo virus threat detected

Attach More Files
Your attachments have been scanned by:  Rotivirdie

Click on Continue to message.
Click on Send to send the message.
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Web mail versus Outlook Express

for example, the Yahoo server. When
you access your email, you are shown
a list of headers of the messages
including who sent the malil, the subject,
the date, and the size.O If you click on
a particular message, the contents of
the message are retrieved from the
server and shown to you.O If you delete
the message, it is deleted from the
server.O If you simply view the message,
it stays on the server and can be viewed
again from any computer connected to
the internet.0 This message stays on
the server until you tell it to be deleted.

Web Mail Outlook
What is the Web Mail stores the messages on a | You access your email by connecting
difference? mail server that you are connected to, | to your Internet Service Provider. When

you download your email, the messages
are transferred from the ISP’s server to
your own computer. When you have
downloaded all your email, the
messages are deleted from the server
and the messages only exist on your
computer.

Advantages Email is stored on a server you can
access your email from any computer
with a connection to the internet. This
is helpful if you want to check mail from
more than one location, if for example
you are traveling.

You are able to work offline, preparing
many email messages to send, and
then connecting once to the Internet
saving costs.

If there are people sharing a computer,
each person has the ability to access
their own email separately.

There are no limits to the number of
messages and all your email messages
are stored in one place.

Messages do not take up space on your
computer.

There is built in virus protection,Ousually
a personal calendar and address book.

You have functions and features that
may not be available via web mail and
your email program integrates with your
other computer software

Disadvantages You need to be online (connected to
the Internet), all the time while you are
reading or preparing emails. This can
be very costly.

Once you have downloaded the email
to your computer, you must have access
to that same computer to view the
messages.

There is usually a limit to the number

of messages that can be stored on the

server.O0This includes messages in the
trash. If you receive many emails this

can be problematic as your mail box

will fill up very quickly

You are more prone to receiving viruses.

There is also a time limit to how long
you can be connected to the server
without activity. If you take a long time
to compose your message, then you
may lose your web mail connection to
the server.O0
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Objectives

This section aims to assist participants in:

e Becoming familiar with the different methods of retrieving information from the Web; including
information on gender and the media.

e Evaluating information obtained from the Web.

e Learning how to save images and text from the Web.

e Understand the advantages and disadvantages of different search programmes.

* Understanding how software can be downloaded from the Internet free of charge.

e Understanding what is needed to create and market your own website.

The World Wide Web consists of all the files which make up web sites (called hypertext or HTML files,
usually). These files are stored on host computers and linked in a “web” by the Internet. The Web has
provided the Internet with a graphical interface. The web is a rich source of information. It is also a space
that anyone or any organisation can use to create and post their own information.

Getting information from the web

A browser is a computer program that lets you view WWW documents and access the Internet taking
advantage of text formatting, hypertext links, images, sounds, motion, and other features. Netscape and
Internet Explorer are currently the leading "graphical browsers". There are other browsers (e.g., Macweb,
Opera, Mozilla).

Adding sites to favourites/bookmarks

A bookmark or favourite saves a web browser, so that you can find it quickly and easily again. Go the
page on the Web that you want to bookmark.

In Explorer do the following:

Click on Favorites

Select organize favorites

Click NEW and create a folder

Close the options box

Click on Favorites again

Select Add to Favorites

Double click on your folder and click on add

N MDD~

In Netscape do the following:

1. Click on Bookmark
2. Click on add to bookmark
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Some useful websites for gender and media activists
Test the browser facility on your computer by going to the following websites:

BRIDGE:
http://www.ids.ac.uk

Feminists for Freedom of Expression:
http://www.ffeusa.org

Feminist Interactive Radio Endeavour (FIRE):
http://www.fore.or.cr

FEMNET:
http://www.femnet.africaonline.co.ke

Flamme:
http://www.flamme.org

Freedom Forum Online, Media Studies Journal:
http://www.mediastudies.org

Gender Links
www.genderlinks.org.za

International Journalists Network:
http://www.ijnet.org

Media Institute of Southern Africa:
http://www.misanet.org

Media Theory:
http://www.theory.org.uk

MediaWatch Canada:
http://www.mediawatch.org

UNDP, Gender in Development Programme:
http://www.undp.org/undp/gender

University of lowa, Communication Studies: Gender, Race and Ethnicity in Media:
http://www.uiowa.edu

WomenAction:
http://www.womenaction.org

Women.Com:
http://www.women.com

Women’s International News Gathering Service:
http://www.amazoncityradio.com

WomensNet:
http://www.womensnet.org.za

World Association for Christian Communication:
http://www.wacc.org.uk
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Saving information from the Web

This section gives basic instructions for saving information which you locate on the Web. It also gives
step by step instructions for downloading free software from the Internet. There is plenty of perfectly
useable software available on the Net, and much of it is called Freeware - this means that you don'’t have
to pay for it.

To save an image or picture from the Web:
1. Right-click on the image.
2. Click on save as

o W RIS s O3 WG TR DT O Babhful

B AMA S B8 GO A O\ @ | e e e o g ! Aamm
3. Save the picture in the folder you would like to store it in.

2x
Savein IaDICS d ] &F Ea-

File name: Ipwclurs 1 d Save I
B Save asype [JPEG ipg) =l Caricel

e

To select text from a Web page:

Save the text in text format as it will take up less space, especially if you are cutting and pasting for
research, etc.

Highlight the text you wish to save.

Right click over the text.

Click on copy.

Open a text file (in a word processor or Notepad, for example).

Select edit and click on paste.

Now save the document.

Alternatively, just save the document as an html document.

No oMb~
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Saving complete pages from a website (all the text and all the graphics)

oD~

Go to file

Go to save as
Under “file type” choose “Web Page, complete (html, htm)
Save the picture in the folder you would like to store it in. It will save the page as an html document

and put all the other files associated with the page in a separate folder.

Click on the html page to open the web page on your computer

3 genderIT.org - Global and regional highlights o

File Edit View

e

open...
Edit with Microsoft FrontPage
Save

Fawvaorites

Tools  Help

»

Search [
ChrHO =E

e, shikml
Ctrhs Search el

Fage Setup...
Print...
Print Preview. .,

Chrl+P

Send

Import and Export...

Properties
ok COFFline
Close

Making pages available for offline viewing

When you make a Web page available offline, you can read its content when your computer is not
connected to the Internet. For example, you can view Web pages on your laptop computer when you
don't have a network or Internet connection. Or you can read Web pages at home without connecting to
the Internet.

To view a website offline (using Internet Explorer) first add the website to Favorites. Go to favourites, click
on Add to Favourites and you will get the following dialog box:

=]

i? Intemet Explarer will add this page ta your Favarites list. oK |

I~ Make available affline

Mame: IgenderIT.org - Global and regional highlights on gender Lreate in << |

Custamize... | Cancel |

Create jn: @Favorites
] ens

{:I Current
{27 Links
{2 Media

{:I ‘ahoo!

: {2 Corel on the Web

2] Research orgs
{2 website promotion

Mew Folder... |
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Then click in the check box “Make available online”
2
* Internet Explorer will add this page to your Favorites list. ok |

I~ Make available offline [Customize,.. I Cancel |

Mame: IgenderIT.org - Global and regional highlights on gernder LCreate in << |

Create in: 1 Favarites New Fuolder... |

1 Research orgs
21 wehsite promation
E-] ¥ahoa!

Now click on the customize button and you will get the following screen which is a wizard to take you
through the step of how to save the website offline, and how much of the website you want to save.

Offline Favorite Wizard x|

Usze this wizard to determing how much content to make
available offline. ou can alzo zet up a schedule to
zynchronize the offline page(z] with the most recent pages
on the netwark,

¥ I the future, do not shaw this introduction screen.

< Back I Mext > I Cancel

Click on next and you get the following screen:

0ffline Favorite Wizard ] =]
Set up the following page:

Mame:  gender|T.ong - Global and regional highlights o...
URL:  hitp: Ao genderit. org/envindes, shtml

If thiz favorite containz links ta other pages, would you like
ta make those pages available offline toa?

" No
[y
Downlead pages I 1_|::[ links deep fram this page

Mote: If pou have limited hard disk space or pou want ta
reduce synchronization time, it's a good idea ko limit the
number of linked pages pou store.

< Back I Mext > I Cancel |

You now have a choice whether to save the one page you added to the Favorites, or more pages. If 97
you want save only the one page click on No. If you want to save more than one page click on Yes.
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Offline Favorite Wizard x|
Set up the following page:
MName:  genderl T.org - Global and regional highlights a...

URL:  httpeAwwaws. genderit. org/en/indes. shiml

IF this favorite containg links to other pages, would you like
to make those pages avallable offline too?

" No

& ez

Download pages I 21_,:' links deep from thiz page
Mate: If you have limited hard disk space or you want to

reduce synchronization time, it's a good idea to limit the
number of linked pages you ztore.

< Back I Mext » I Cancel |

You have now chosen to go 2 links deep into the website to save onto your hard drive.

Offline Favorite Wizard 5 x|

Y'ou can gpnchronize thiz page any time you are
connected by choozing Synchronize from the Tools men.
‘f'ou can also set up a schedule to spnchronize thi page
autamatically.

How would pou like to sunchronize thiz page?

= Only when | choose Synchronize from the Tools
menuy

| would like to create a new schedule

< Back | Mext > | Cancel |

If you choose to update the pages you have downloaded in two ways: only when you choose Synchronize
from the Tools menu or you can choose “new schedule” if you want the only update the information at a
particular time.

Next you are asked if you want have a password. Press finish.

Dffline Favorite Wizard =]

Dioes this site require a passwaord?

= No

ez, my user name and password are;
Wser mame: I

Easzward: I

[Earfirm Fassword: I

< Back I Finist I Cancel
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If you want to save it in a new folder, click on New Folder. Click OK to finish the task.

Add Favorite i 3|
* Internet Esplorer will add this page ta your Favaorites list.
[ Make available offine Customize. . | Cancel |

Mame: IgenderIT.org - Global and regional highlightz ot gender Create in <<

Create in:

Mew Folder...

L

-] s

{27 Corel on the Web
{2 Current

(] Links

{2 Media

--{_7] Research orgs
{2 website promation
B2 vahoo!

Downloading software from the Internet — software sites

To download programs from the Internet do the following:

1. Search for the software you need.

2. It will probably locate it — often freeware.

3. Click on download.

4. Save the program where you want it to be stored on your hard drive.

Some popular free download sites are:
http://www.download.com
http://www.tucows.com
http://shareware.com

Searching the Web

There are two different types of search sites available on the Web: search engines and subject
directories. Today they look very similar and most people don't know the difference between them, but
it's important to distinguish between them since they work in quite different ways.

Search engines

Search Engines are a quick way of searching for information on the Internet. Their database of websites
is built by completely automatic programs (called worms, crawlers, spiders or robots) that roam the Web
constantly, visiting websites, retrieving the pages and automatically indexing them. Usually they index
the full text of the pages.

Google is a good example of a search engine and is one of the most widely used search engines
available on the Internet. Go to www.google.com
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How to search using a search engine

e Search engines are searched by entering a keyword or keywords into a search field (dialogue box).
These are matched against the database - again, usually containing all meaningful words from the
full text of the Web pages. A description (title + abstract or first few lines of the page) of pages
containing the words you've searched for are returned.

*  Most search engines use implied Boolean searching; an increasing number also offer full Boolean
searching. See more information on Boolean searching below.

e The list of Web pages is arranged according to a relevance ranking algorithm that calculates how
relevant to the search request each page is and presents them in descending order of relevance.

e Clicking on the title of a Web page takes you to it.

Strong points of search engines

. Coverage: They try to be comprehensive.

*  Full-text searching: You'll find information that may be relevant to you even when it's only of
peripheral interest to the main topic of the page.

*  Boolean search capability: Not every search engine offers it but it's a growing trend. Read the help
section to see exactly how it works in the search engine you're using.

* Relevance ranking: A lot of the time they don't do it very well, but it's still better than nothing. Imagine
an alphabetical display of a list of 10,000 websites! Specialized sites, such as news engines, often
let you choose other ranking criteria, such as reverse chronological (most recent first).

Weak points of search engines

e Comprehensive coverage: You get a lot of irrelevant information.
. Learning the search language: Implied Boolean is pretty standard, but engines differ about most
other things. It's getting to be quite complicated to remember which engine does what and how.

Directories

A directory is a collection or database of websites classified in a meaningful way. Usually it's classified
by subject, i.e. it's a subject tree or subject directory. The subjects are organized into categories, which
are usually arranged hierarchically. For example, if you are looking for information on Web graphics, the
hierarchy might look something like this:

Computers
Internet
Web Development
Web Graphics

Which could also be represented as:
Computers/Internet/Web Development/Web Graphics.

Each subject division is called a category; each category lists Web pages relevant to its subject
plus sub-divisions of its subject.
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When using subject directories, keep in mind that:
1.

There are two basic types of directories: academic and professional directories often created and
maintained by subject experts to support the needs of researchers, and commercial portals that
cater to the general public and are competing for traffic. Be sure you use the directory that appropriately
meets your needs.

Subject directories differ significantly in selectivity. Consider the policies of any directory that you
visit. One challenge to this is the fact that not all directory services are willing to disclose either their
policies or the names and qualifications of site reviewers. This is especially true of commercial
portals.

Many people don't make enough use of subject directories, but instead go straight to search engines.
Keep in mind that academic subject directories contain carefully chosen and annotated lists of quality
Internet sites. Don't overlook subject directories when searching for quality on the Internet.

INFOMINE (http://infomine.ucr.edu/) is a good example of an academic subject directory. Yahoo! is a
good example of a commercial portal.

The content in directories are chosen (and sometimes evaluated) by human beings. They're selective,
and usually the sites included have significantly higher information content than the Web average.

How to use a directory

Directories can be browsed: You can click on a subject to see pertinent links and subcategories on
your topic.

You can also search by keywords: These are matched against the database; you get a list of
categories matching the keywords and a list (usually arranged alphabetically) of pages containing
them.

A few directories offer implied Boolean searching but none of them offer full Boolean searching.
With the type of limited database they've got, it wouldn't make sense to do so.
Once you've found the relevant subject, you click on it to get a list of Web pages. The list is usually
arranged alphabetically and includes the title and an abstract or first few lines of the page. Clicking
on the title of a Web page takes you to it.

Implied Boolean Searching (""'Sign Language")

This search language, now the Web standard, has three main symbols, which are attached as the first
letter of the word they refer to (no space between the sign and the word):

A plus sign ( + ) means that this word must appear in order for the page to be retrieved.
Example: +cats +dogs means that both words must appear in the page (not necessarily close
together).

A minus sign ( - ) means that this word must not appear in order for the page to be retrieved.
Example: cats -dogs means that you want pages containing the word cats but not containing the
word dogs.

No sign at all ( - ) means that the word may or should appear in the page but is not obligatory. If

it appears, the page is ranked as more relevant. If it doesn't, the page may still be retrieved if it
meets the other criteria in your search.
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Example: cats +dogs means that you want pages containing the word dogs; you prefer those that

also contain the word cats and would like these to be ranked higher in the list than pages that don't.
. Double quotation marks: " " indicate phrases. If you write “computer programming” this will be treated

as either:

Computer AND programming or as

Computer OR programming

depending on the search engine you're using. (You can check out which does what from the list of

search engines and directories). If you want adjacency, write "computer programming".
e Combining signs: pluses and minuses go in front of the first quotation marks:

+'"computer programming".

If you put them inside the quotation marks, the search engine may understand this or it may search

for the sign (which will reduce your recall rather more than you intended!)

Strong points of directories

e They provide a "subject heading" classification scheme for the Web. If there's a category in
the directory for your topic, it can be the quickest way to find quality information.

*  They only include sites whose main topic is relevant to the category they're classified under.
If you look for “safari” and “Kenya” in a directory, you can expect to find the website of the Kenyan
Safari Park Authority and not a personal account of someone’s holiday. A search engine will bring
you both sites indiscriminately.

e They have a policy and selection criteria. People can submit their sites to the directory for possible
inclusion, but whether or not a site is included is a function of how relevant it is to the subject matter
of the directory, its scope, coverage and accuracy, in additional to other selection criteria such as
audience.

Weak points of directories

e It's difficult to combine facets. Pages are classified by their main topic. Since the full text of the
page is not indexed, you can only search on the page's title and the category they're classified by.

* You can't search the full text of the pages: It isn't indexed. As said, only the page title and the
list of categories are indexed. If you're looking for side-information that might be included in the small
print or a footnote, don't use a directory.

* Directories are exclusive. They intentionally only include a small proportion of what's on the Web.
This is their strong point if you want "a few good sources on...". It's their weak point if you're doing
a comprehensive search.

When would you use a directory?

e To do preliminary research on a subject you're not very familiar with: to get the basics.

*  When you're looking for "a few good sites on..." (but this depends on the subject; and if you
know how to search efficiently using a search engine you can also get a few really good sites in the
top 10 or 20).

*  When your subject is one concept: directories have very limited ability to combine facets
of a search.

e When you know the directory and trust its compilers' ability to channel you to the most
informative sites.

)




3. THE WOLLD WIDE WED

EXERCISE h
Searching for information using a search program.

Search Engine

Open your Browser, IE or Netscape

Type this address http://www.google.com

Type Gender issues

Check the results: Results 1 - 10 of about 29,900,000 for Gender issues.

Type Gender issues South Africa (to narrow down your search and get more specific results.

(o0 s wp =

Check the results: Results 1 - 10 of about 6,560,000 for )

Creating a web site

A website is a very easy and effective way of publishing information on your organisation. The information
is publicly available on the Internet and anyone who has access to the Internet can obtain the information.
You can publish any information that is relevant to your organisation, from publications that your organisation
produces.

To publish a website you will need:
* An Internet Service Provider (ISP) who will host the site for you so that it is always available for
public viewing.
e Astructure for the site.
* Design of the site.
* Coding of web pages in HTML using a software package.

Web pages are written in a programming language called HTML (Hyper text markup language). HTML
controls the look and feel of a web page, for example what will appear in a bigger font, what would be
in colour, where a graphic should appear.

Web pages can be static — the pages do not change very often — they are almost like a brochure of your
organisation.

Web pages can also be dynamic. They change frequently, can have interactive spaces inviting the public
to respond or engage with the information on the site.

There are many programs that are used to develop web site and web pages. One of the most common
programs is Dreamweaver which most professional designers and web developers use.

Another common program which is used is Microsoft FrontPage. This program comes standard with
the Windows 2000 and XP Operating systems. It works very much like Microsoft Word and is very
simple and easy to use. You can create your own website or you can make use of the services of a
Website Designer who will work with you from planning your organisation site up until the site is
published. Once your website has been developed, you will need to market it so that your target
audience will be able to visit your organisation website.
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Post design website marketing

A web site is a public representation of the organisation; it is a marketing tool; it a vehicle to communicate
who you are, what you do and how interested people can communicate with you and vice versa. Thus
it is crucial to profile and advertise your web site on an ongoing basis, not only with the public at large
but also specifically to peoples constituting your target audience. Some of the ways you can do this are:

Public launch

It is highly advisable to organise a public function where you can engage in some 'networking' on behalf
of your website. Create an event to launch the site and unashamedly promote the site at the event by
taking the audience through the different sections of the site, explaining how the site can help them. Give
the audience hand-outs of the website to market the site.

Submission to a Web Directory or Search engine

As according to web statistics, the majority of users find a website through a search engine. Therefore
it is crucial to make sure the Search portals have listed your site. You may have to manually submit your
site to web directories like Google (http://www.google.com) and other prominent Search engines.

The Open Directory is a project to which prominent web directories like Yahoo, Google and Lycos
subscribe. If you submit your site to the Open Directory, it will be listed on these portals. Visit the Open
Directory for more information: http://www.dmoz.org/

Some Web Resource sites offer to submit your website to a list of some 40 to 400 search engines. Some
of them are free (Add Me -http://www.addme.com), others charge a small fee (Submit It -http://www.submit-
it.com).

Direct Email

If you have been in business for a while, you probably have tried at least one conventional mass mail
campaign to promote your business. Conventional mass mailing is probably the most-used selling
technique. Even with a response rate of only about one percent, it can be effective and profitable. Mass
mailings are also one of the more economical ways of advertising a business.

You can use the same concept for electronic mail. You send out a single message promoting your website
to a many people by email, at a fraction of the cost and time it would take to otherwise promote the site.
One way of doing this is to join a mailing list, which focuses on your target audience, and send all the
users of the mailing list a message inviting them to visit your site. There are many service providers for
mailing lists. One of them is http://www.egroups.com.

You can use the same approach to propagate your website at bulletin boards (message boards or
discussion forums) aimed at your target audience and hosted on other websites.
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Press Release

In the same way that you can send out press releases offline, you can do it online to the various e-zines
and online newspapers. It is much cheaper and the chances are that people on email will be more
receptive to online news.

Offline Publicity

As well as promoting your Website online, you can promote it off-line. Your first step is to display your
URL prominently wherever you can: on your office stationary, on your publications, display posters, on
any advertising you might produce etc.

Being a Cool Site

Many Web portals and other Websites run a "cool site of the day" or "cool site of the week" or even grant
prestigious awards such as the Webby Award (http://www.webbies.com). If you are featured as one of
these, you could experience a huge surge in traffic. Visit the Microsoft Network "Cool Site of the Day".

There are also lots of Websites and Web guides who select the best few hundred sites on the Web, or
the best 10% of sites, and it is valuable to be listed by these sites.

To win an award or feature as a "cool site", you will obviously have to do some work on your Website,
to get it looking as good as possible and working as well as possible. You could then submit your site
for the award.

Banner Advertising

Banner Advertising is widespread on the Web. It works by placing your banner on someone else's website.
Much depends on the quality of the banner itself, as click-through rates' tend to be very low. Space for
banner ads is sold on a number of views or number of how many people click on the banner, or it can
be exchanged via organisations like the Link Exchange.

You might want to consider joining the Link Exchange. You allow people to post banners on your site and
in exchange get to place your banners (with links to your page) on other people's sites. Find out more
from the Link Exchange: (http://adnetwork.bcentral.com).

Reciprocal Links

An excellent way to generate traffic to your Web site is to have reciprocal links. This means that you place
a link on your website to another site, in return for a link to your website being placed on the other site.
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EXERCISE

Registering your site with a search engine.

Open your Browser, IE or Netscape.

Type this address http://www.google.com.

Click on Add a site to google.

Write your website address e.g. genderlinks.org.za.

Click on add.

You have successfully added your site on google.com. You site will only show after a week.

J
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Objectives

The aim of this session is to:

e Take advantage of Internet Interactive features.

*  Know how to join lists and discussion groups.

e Be familiar with unsubscribing from lists and discussion forums.

*  Learn how to create electronic address groups for specific kinds of information.
d Learn to create E-Newsletters and how to disseminate these on the internet.

Joining a listserv
What is a listserv?

A listserv allows a group of people to work together online and to discuss, share, and produce information.
On a more technical level, a listserv consists of email addresses of a group of people who are “members
or subscribers” of that list. The list with addresses is based at a host computer connected to the Internet.
This means that in order for your listserv to work you must have an ISP to host it. Fortunately enough
these days one can setup a free mailing list on yahoo. You will find the steps of setting up a free yahoo
mailing list at the end of this session. The list distributes each messages sent to it, to all the members
on the list. The mailing list software offers several functions to manage the mailing list.

Why a listserv

Mailing lists can be used for the following:

e Giving your opinions

e Share information and documents

e Making decisions

*  Giving feedback

e  Achieving common goals

*  Implementing activities

e Writing documents together e.g. a training manual
e Convening online meetings

e Planning face-to-face meetings

e Starting a campaign

*  Bringing together experts on a certain theme
e Disseminating your publications

*  In-depth discussions

Electronic discussion lists (also known as mailing lists, listservs, newsgroups or electronic conferences)
are forums for discussion or announcements on specific subjects. You initially subscribe to a list by sending
an email message. Mailing lists can be a source of information about research, conferences and campaigns.
Mailing lists can also be used to lobby support or advocate change.

Subscriptions to most lists are free and unrestricted. A moderator may control some lists. Some
lists are more active than others, and the quality of discussion/messages may vary. If you join 107
several very active lists, then you may find your email inbox being swamped with messages.
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How a Listserv works

Let’s say you have 200 emails of people sharing a common goal. All these emails will be given one user
name, e.g. a mailing list of women against child abuse would call their mailing list WACA, and their group
mailing list will be . A member sends a message to the list’s email address. All the members or subscribers
of the list automatically receive that email message. When one member on the list replies to the sent
message, all the members of the list receive the reply. Let’s say you want to send a message to certain
members of the list maybe 20 out of 200. There is no way you can do that through the mailing list unless
you pick up those 20 people’s email addresses and then send the message to them, i.e. outside the
mailing list.

How to subscribe to a mailing list

1 Send an e-mail to the site of the list.

2 Include as part of your message: SUBSCRIBE (LISTNAME) (E-MAIL ADDRESS).

3 E.g. SUBSCRIBE WNINFO would be the message text if Tendai wanted to subscribe to Women’sNet
Info Mailing List.

Netiquette

Your first email to a mailing list must be about introducing yourself. Sign on and tell people about yourself,
your work, your interests, and experiences. Keep your message short and concise.

To post messages

If you are responding to someone else’s posting, make sure the Subject Heading is the same as the one
you are replying to, to ensure coherency of the discussion

Relevance of messages

Messages must be relevant to the whole group not just one individual. It is advisable not to have personal
discussions. There are times when 2 people on a list start arguing over an issue and sending their views
to everybody on the list. In cases like these the 2 should send each other messages privately and then
post the outcome of the discussion to the group if need be. A mailing list facilitator should handle those
that do activities like these one.

Do not keep the body of the original text in your replies, except when you are responding to a message.
Use a descriptive Subject header to identify message content

To unsubscribe

Do not send a message to the list but to the list facilitator. Each mailing list will provide information on
how to unsubscribe from it.
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Some useful listservs

Here are some gender-related email lists that focus on activism. If the instructions say "send subscription
message," the message to send is SUBSCRIBE (LISTNAME) (E-MAIL ADDRESS) The aim here is to
give you ideas on mailing lists that you can start in your countries, mobilize people and start them talking.

GL-generals: This is a list serve moderated by Gender Links that provides information on gender and
media activism in Southern Africa. To subscribe send an E Mail to admin@genderlinks.org.za

BEIJING-CONF is a moderated list supported by the United Nations Development Programme. It includes
subscribers from 55 countries, including 28 developing countries. As a result, the list emphasizes
discussion of the Beijing UN Women's Conference issues as they affect developing countries as well
as industrialized ones. The list hopes to continue beyond the Conference, focusing on implementation
of the Women's Conference and the Social Summit agreements. To subscribe, send the message
subscribe beijing-conf to majordomo@confer.edc.org

ECOFEM focuses on women and the environment, from local to international. It offers opportunity for
sharing information about grassroots activism, legislative action, treaties/conventions, publications,
syllabi, upcoming events, and more. Send subscription message to listserv@csf.colorado.edu.

FAVNET (Feminists Against Violence Network) is a women-run, moderated list dedicated to ending
domestic violence and violence against women through networking and direct action in a feminist
environment. To subscribe, send a request to FAVNET-SUBSCRIBE @yahoogroups.com. More information
is available at the FAVNET web page which can be found here http://groups.yahoo.com/group/favnet

FGM-L is dedicated to discussion and research about Female Genital Mutilation in the United States
and internationally. To subscribe, send the message SUBSCRIBE FGM-L <your email address> to
majordomo@hollyfeld.org

RURALCONNECT is open to members of rural sexual assault and domestic violence programs.
It is a working list for sharing, networking, and problem solving around sexual and
domestic violence. Related information is available at the Ruralconnect web page
http://ruralwomyn.net/mailman/listinfo/ruralconnect_ruralwomyn.net

RURALWOMYN is an email discussion list focusing on all aspects of what it means to be a rural woman.
The list overcomes the distance and other barriers that prevent many rural women from meeting face
to face. "It allows us to write about our own experiences as rural women, 'hear' the experiences of others,
and explore the concept of 'rural women' as a group." Topics range from aspects of daily living to
substantive issues and how they impact women, and, more specifically. Members must currently live
in a rural area and bring a rural perspective to discussions. For more information or to subscribe see
the RURALWOMYN web page http://ruralwomyn.net/mailman/listinfo/ruralwomyn_ruralwomyn.net
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EXERCISE

Joining a mailing list

1. There are several types of mailing list. Can you give some examples?

2. Are you subscribed to mailing list? What is the mailing used for?

3.  What do you like best about this mailing list and what changes would improve the mailing list?

4. Search for one mailing list of interest on the Internet. Join the mailing list and tell the class about
the mailing list.

. J

Creating a listserv

Key considerations

When you plan to set up a mailing list there are certain things that have to be addressed:

Purpose: What is the aim of the listserv? You may set up a free mailing list on yahoo that will allow
you to discuss and share information online.

Define your group of participants or audiences of the list, i.e. who do you want to reach and what
does the group share in common?

Rules and regulations for working together on the list. Here you have to define list membership
criteria and establish a “netiquette” for you list.

The type of list you are going have, public with restricted access or private, whether it will be
moderated or non-moderated.

Make sure that the list is accessible for the people you want to reach. Do the participants of the
list have access to the equipment and knowledge necessary for them to effectively participate on
the list? Do the participants have unrestricted access to their computers and is their privacy ensured?
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The most basic listserv

You can create a list of e-mail addresses and put them in the To box, or in the BCC (Blind Copy Box) so
that all the E Mail addresses cannot be seen. However, the only way for this to be a discussion group is
if those responding click reply to all when they respond. There are also likely to be problems with sending
large numbers of e mail addresses in this way. And this rudimentary option does not allow recipients to
subscribe or unsubscribe.

Below is a screen shot on sending an email to a group of people using the BCC field:

B Workshop on Resource Mobilisation

i File Edt View Insert Format  Tools Message Help

2 % DR v Y Fi VM 5=z 5

: send Cuk: Capy Paste Unda Check  Speling Attach  Priority Sign  Encrypt  Offfine

To:  |tendai@Pclieracy, org, 2a
@ ]

Bee:  [Mewlfechurch@rylist. Tiscal, Co. Za; Mathan Sassman; Malusi M, Moumiwana; Macds@lolmail. Co. Za; Lydia Webber; Lusunqu Kanchenche ; Luckydavlotterv@Starspath, Com; A
Lsc@Tiscali. Co. 2a; Liamjlondon@ahoo. Co. Uk; Lerato Makgalemele ; Kubi Rama; Kim Vosse ; khayametro@Telkomsa, Net; Judith Rupare; Judith P, Mdiovu; Jocelyn Liesering; |
Deremy Matthews; Jason; Jacob Masilela ; Trumelena; Info@Papillonfoundation. Za. Org; Inald Khosa; Icebox whitelist; Hikon@Tsf, Ora., Za; Hiton@Shottlewarthfoundation, Ora; =
Hihandoffice@anl. com; Helpdesk Helle & Gavin Cawkhra: Heike Herbst; Glenda Esterhuizen ; Gizila Takavarasha ; Gina Hotz: ol Com: Frankkalvor@ietscape. Met: el

Subject:  [Warkshop on Resaurcs Mabiisation

[
1
i
i
e
]
[
[
[l
]

-3

Dear all,

You are all invited to the Resource Mabilation

'3 start 2l dhaf

Working with groups in MS Outlook

Creating a group in MS Outlook allows you to send emails to a group of people, rather than selecting
individual names of the people you want to send a particular email to.

You can create a single group name to use when sending a message to several contacts at once. Simply
create a group name and add individual contacts to the group. Then you only need to type the group
name in the To window of the new email, or even more simply, choose the group name from the address
book. Once you have set up a group, you can use it over and over again. You can add email addresses
or delete them from an existing group.

For example, you may create a group for friends, family, or to you colleagues, and so on.
In the exercise below, we will create a group called “Employees”.
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To create a group of contacts

1. On the Menu bar click Tools and then select Address Book.
2. In Address book click on File and select New Group. The Properties dialog box opens.

4. There are several ways to add people to the group:
To add a person from your Address Book list, click Select Members, and then click a
name from the Address Book list.
To add a person directly to the group without adding the name to your Address Book,
type the person's name and e-mail address in the lower half of the Properties dialog box,
and then click Add.
To add a person to both the group and your Address Book, click New Contact and fill
in the appropriate information.
To use a directory service, click Select Members, and then click Find. Select a directory
service from the drop-down list at the end of the text box.
After finding and selecting an address, it is automatically added to your Address Book.
Repeat for each addition until your group is defined.

5. To view a list of your groups separately from the Address Book listings, in the Address Book,

on the View menu, make sure that Folders and Groups is selected.
6. You can create multiple groups, and contacts can belong to more than one group.

(O—=2®@
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To add a contact to an existing group

In the Address Book list, double-click the group you want. The group's Properties dialog box opens. You
can add people to the group in several ways and in some cases you can add them to your Address Book
as well.

1. To add a person from your Address Book list, click Select Members, and then click a name from
the Address Book list. Click Select, and then click OK.

2. To add a person directly to the group without adding the name to your Address Book, type the
person's name and e-mail address in the boxes provided in the lower half of the dialog box, and
then click Add.

3. To add a person to both the group and your Address Book, click New Contact, fill in the appropriate
information, and click OK

Deleting contacts from your Address Book

You can easily remove contacts and groups from your Address Book. When you delete a contact from
a group, the name is removed from the group but the entries for both the group and the individual remain
in your Address Book. Likewise, deleting an entire group does not remove the entries for the individual
members who made up the group.

In the list of contacts, click the one you want to delete, and then click Delete on the toolbar. The contact
name is also removed from any groups it is in.

™ Address Book
File Edit View Tools Help

E H X B g %

Mew  Propertiss  Delsts |FindPsople  Print Action
[S-Ed Comtacts _ Tepe name or select from list: |
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L 3 folexs '
EZachiever@Capemedia. ... achiever@capemedia.co.2a
[EZ) alan weichel: weichelaj@telkomsa net
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How to delete a contact from a group

* In your Address Book, double-click the group name.

+ In the Group Members list, click the name you want to delete, click Remove, and then
click OK.

» The contact is removed from the group, but the individual entry for the contact remains in your

+ Address Book.

How to delete a group from the Address Book

In your Address Book, click the group name in the list, and then click Delete on the toolbar. This deletes
the group but leaves the entries for the individuals who made up the group.

How to move a contact or a group

+ In the Address Book contact list, select the name of the contact or group that you want to
move.

+ Drag the contact or group from the list on the right to the group or folder you want it in on
the left.

How to organise names in your Address Book

When you have a large Address Book, you can organise it in several ways to make it easy to retrieve
contacts and groups.

+ To sort contacts by name, e-mail address, or phone number, click the appropriate column
heading above the name list.

+ To switch columns between ascending and descending sort order, click the column heading.

+ To change the order of the columns, point to a column heading (Name, E-mail Address,
Home Phone, and so on), and then drag the column to the left or right until it's located where
you want it.

« To view a list of your mailing groups, on the View menu, select Folders and Groups.

Discussion list tools through your hosting company

If you are hosting your website or email through a large shared hosting company you may already be
paying for tools that can manage your list. Many hosting packages include the functionality to manage
several mailing lists. Check your control panel to find out.

The tools typically available are useful but have limited functionality. Generally, people can
subscribe and unsubscribe by sending an email to a particular address (i.e.
“subscribe_shoestring@alderconsulting.com). The list administrator can subscribe people by hand through
a web-based interface, and can view and monitor the addresses on the list. To send out an e-newsletter,
the administrator sends an email (plain text or HTML) to a particular address; the email is then sent on
to everyone on the list. The tool also manages bounced emails as needed.
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These tools tend to be focused on discussion lists, in which multiple people talk to each other via the list,
rather than e-newsletters. The functionality they have works fine for e-newsletters (you can simply moderate
out anyone who tries to post something else to the list), but they don't have much of the advanced
functionality offered by e-news specific tools.

Discussion list ASP tools

If you can't get a discussion list tool through your hosting company, a number of services will let you use
theirs — either free for qualified organisations, free with ads, or for a fee. These services generally work
like those described above, except with someone else's email domain. On the upside, this means that
that there is no danger of being blacklisted as a spammer. On the downside, subscribers will see the
service as a key part of the “From” email address (i.e. shoestring@topica.com). Some of these services
do not allow HTML e-newsletters.

Again, these are low-costs solutions for small organizations. They have a slight advantage over discussion
tools with your own hosting company, as there is no danger of having your domain blacklisted. However,
there are still many useful e-newsletter functionalities they don't offer.

Some tools of this type to consider:

e Online Policy Group (www.onlinepolicy.org/services.shtml): The OPG is a nonprofit organization
which offers free lists to “"nonprofit organizations and individuals who are under-represented,
underserved, or facing unfair bias, discrimination, or defamation".

* Riseup (http://lists.riseup.net): A “radical tech group” that offers free lists that “must be used for
radical social change.”

e Topica (http://lists.topica.com): Discussion lists which are free to anyone, with small text ads shown
at the top of each email.

*  Yahoo Groups (www.yahoogroups.com): Similar to Topica, Yahoo offers free discussion lists to
anyone, with ads in each email. We discuss Yahoo Groups below.

e Electric Embers (www.electricembers.org ): A nonprofit that offers affordable fee-based discussion
lists. Fees are on a sliding scale, starting at about $5/ month. Electric Embers is one of the only tools
in this article who will work with organizations to integrate the subscriber list with an existing database
(for notable extra cost).

How to get a listserv

1. You need to check whether your ISP provides a mailing list or listserv option.

2. You then apply to run a listserv.

3. Your ISP will set up the listserv for you and the program will reside on the ISP’s server. The ISP
will send you a login and password to access the administrative panel of the listserv. You will also
get a name for your listserv.

4. You do not need any extra programs on your computer. You will access the listserv manager
through your web browser.

5. Once you have access, you will need to add all the email addresses you want on your list.

6. Generally ISP’s charge for a once-off set up fee. You will then be charged a monthly amount
depending on how many recipients you have in your list.
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We have taken an example of prices charged for listservs from Mweb (www.mwebbusiness.co.za)

Mailing List Setup Service size Price

R250 1-500 R90.00 pm / R990.00 annual
R250 501 - 1000 R130.00 pm / R1430.00 annual
R250 1001 - 3000 R200.00 pm / R2200 annual
R250 3001 - 5000 R260.00 pm / R2860 annual

Yahoo! Groups

Yahoo! Groups is a free service that allows you to bring together family, friends, and associates through
a web site and email group. Yahoo! Groups offer a convenient way to connect with others who share the
same interests and ideas.

There are millions of groups that you can join in an easy-to-use, privacy-protected, and spam-protected
environment. You can also set up your own Yahoo group. You can use the Yahoo! Groups service at the
Yahoo web site or through any email program.

What are the features of Yahoo Groups?

e Message archive

Read and reply to group messages. Start a new discussion.
e Photos

Share photos with group members in your own photo album.
e Calendar

Coordinate events for your group with a shared calendar
e Polls

Ask members how they feel about any topic.
e Links

Store links to Web sites related to your group.

How much does it cost to use Yahoo! Groups?

Yahoo! Groups is free to both members and moderators. The service is advertiser-supported
and is partially sponsored by advertisements inserted into the email messages you receive.

How to join a Yahoo group

Join via the group page:

1. Locate a group to join. On the front page of Yahoo! Groups, you can browse the Groups directory
or search for a group by topic.

2. Click on the Join This Group button on front page of any group.

3. If you are not signed in, you will be asked to enter your Yahoo! ID. If you do not have a Yahoo!
ID, you can click on the link New to Yahoo!? Sign up now.
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4.  Set your membership preferences. When you join, you can choose a profile you'd like to display to
the group, select the email address at which you'd like to receive group messages, choose how you
receive group messages, and more.

Join the mailing list only:

We highly recommend you join a group via the group page (above). However, if you are familiar with
mailing lists, you may join only the mailing list for the group. If you choose this method, you will not have
access to all of the group's web features (Photos, Files, Links, Polls, Calendar.) In addition you will not
have access to the My Groups page, where you can easily manage all of your memberships and email
messages.

To subscribe to a group's mailing list via email, send a blank email to:
groupname-subscribe @yahoogroups.com

Make sure to replace "groupname" with the actual name of the group
(e.g., pastry_chefs-subscribe @yahoogroups.com).

You will receive a confirmation message. Just reply to this message and your subscription will be complete.

Respond to an invitation to join:
If someone sent you an email invitation to join a group, click on the link provided to join via the Yahoo!
Groups web site.

How do | leave a group or unsubscribe?

On the Web:
Sign in to Yahoo! Groups and go to the My Groups page.
Click on the Edit My Groups link at the top of the page.
Look for the group you wish to leave, and check the corresponding box on the right side of the
page.
Click Save Changes at the bottom or top of the page.
The group will no longer be listed on the My Groups page, and you will no longer receive
messages.
7. To leave/unsubscribe via email:
8. From your email program, send a blank message to:
9. groupname-unsubscribe @yahoogroups.com
10. Make sure to replace "groupname" with the actual name of the group
(e.g., pastry_chefs-unsubscribe @yahoogroups.com).
11. Alternatively, you may wish to remain a member but reduce or eliminate group email by changing
your message delivery option to No Mail/Web only, Daily Digest, or Special Announcement.

e

o o

Note: If you own a group, you must first give up your ownership in the Members section of your group
before you can leave on the My Groups page.
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How do I start a new group?

First, decide if you really need to start a new group. Yahoo! Groups has thousands of groups that you
can join. Search through the directory to see if your interests are already discussed in one of the many
groups.

If you've decided that you're ready to take on the responsibilities of a group moderator, then starting a
group is really quite easy. Just click the Start a Group button on any Yahoo! Groups page. It will walk
you through a simple set-up process. At the end of the process, you'll have created your very own group!

All groups must be properly categorized. To categorize your group, simply browse or search your way
through the Yahoo! Groups directory looking for the appropriate category in which to place your group.
Look for categories that list similar groups or are specifically related to your subject.

Your group will be listed in the Yahoo! Groups directory within a few days. Yahoo has a team of category
editors, known as "surfers," that go through the Groups directory constantly. They may come across your

group, and if they feel it was improperly categorized, they may move it to a more appropriate location.

There is a lot more help with joining and starting Groups in Yahoo. To find out more information go to
http://help.yahoo.com/help/groups

A step by step guide to joining or starting a Yahoo Group

Step one: Join an existing group or start a new group
Either go to Yahoo’s home page () and select groups or go straight to the Groups Page ()

Find a Group

| || Search |
(Ewarnple: breadmaking, kite surfing, collactibles)

Business & Finance Computers & Internet
Cultures & Community Entertainment & Arts
Family & Home Games

Government & Politics Health & Wellness
Hobbies & Crafts Music

Recreation & Sports Regional

Religion & Beliefs Romance & Relationships
Schools & Education Science

Create Your Own Group

atart a group for your friends, family, club, or ather organization. Create a
group to find others who share your own particular interest.

Start a group now
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Step two: Sign in with your Yahoo ID and Password.
If you have already created a Yahoo email account, your Yahoo ID or Password will be the same.

View My Groups
Sign in to Yahoo!

Yahoo! [D: |

Fassword: |

| | Remember my |0 an this
computer

Don't have a Yahoo! ID?
Signing up is easy.

=ign In

MODE: Standard | Secure
Forget gour ID or password?
Sign-in help

Sigh Up

Step three: You need to put your new group into a category. You can use the search engine or

browse group categories.

“fahoo! My rahoo! Mail

YaEOO! GrROUPS

walcorne, cleverboy4221
[Sign Cut, My Account]

Search
the lweb

Grouf

Start a Group
Start a Group
pEEEE R

Categorize

Describe

Seled Profile

OR

Browse Group Categories

- Buginess & Finance

- Computers & Internet

- Cultures & Cormnrnunity
- Entertainment & Arts

- Family & Home

- Games

- Government & Politics

[ T R Y I TR

Step 1 of 3: Select a Yahoo! Groups Category

Browse or search for the category that best describes your group. Please be as specific as possible when selecting the
category. Groups containing sexual content rust be placed under the Romance and Relationships = Adult category.

Search Group Categories: | GO |
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Start a Group

Categarize Describe Select Profile

Step 1 of 3 Select a Yahoo! Groups Category (Continued)

Browse or search for the category that best describes your group. Please be as specific as possible when selecting the

category. Groups containing sexual content must be placed under the Romance and Relationships = Adult category.
Search Group Categories: | GO |

OR

Browse Group Cateqgories

Top = Computers & Internet > Education Place my group here

Select a more specialized subcategory

- A Plus Certification
- Metwork Certification

Step four: Name and Describe your Group

Wwelcome, cleverboy4321 B H—
-YK_HOO!Q GROUPS (sian cut, My Aczaunt] Groups Home

Start a Group | My Gro

Start a Group

Categorize Describe Select Profile

Step 2 of 3: Describe Your Group
Group Name

This name will appear on your Group page and in search results.

Cleverboy and friends
Example: The Coolest Group

Enter Your Group Email Address

This erail address is for your group. YWhen you send a message to this address, all members of your group will receive a
copy. (40 characters maximurm, no spaces or special characters allowed)

|cleverh0y |@yah00gr0ups.com
Example: coolestgroup or coolest_group

Describe Your Group

This description will appear at the top of your Group page. (2000 characters maximurm)

ﬂg@ Continue Cancel
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Step five: Confirm name of Group and your email address

welcome, cleverboy4321
hHOO.’®GROUPS [Sign Out, My Account] Groups Homne

Start a Group | My Gro

Start a Group

Categorize Describe Select Profile

Step 2 of 3. Describe Your Group
Group Name

This name will appear on your Group page and in search results.

Cleverboy and friends
Example: The Coalest Graup
Enter Your Group Email Address

This email address is for your group. When you send a message to this address, all members of your group will receive a
copy. (40 characters maximurm, no spaces or special characters allowed)

cleverboy Eyahoogroups.com
Example: coolestgroup or coolest_group

Step six: Select your Yahoo Profile and Email address

ahoo! My Yahoo! Mail Search
¥ the Ieb Search |
' Welcame, cleverboy4321
'YJ;I—IOO. GROUPS (sign out, my Account] Groups Home - Help

2

Start a Group | My Groups

Start a Group

Categorize Describe Select Profile

Step 3 of 3 Select your Yahoo! Profile and Email Address
Email Address
If you choose to receive group messages by email, they will be sent to the email address you select below.

(@) cleverboyd321iE@yahoo. com
() marci@contentafrica. net

Yahoo! Profile

The profile you select will be used when other members want to learn more about you, or communicate with you via
Yahoo! Messenger.

Mermber Real Mame Gender Age

cleverboyd321 (Mot Provided)  [Nat Provided)  (Not Provided)

Create new profile

Step seven: Verification

Word Verification

Enter the text as it is shown in the box below. This step helps Yahoo! prevent autornated registrations.

If you can not see this image click here.

Cantinue || Cancel |
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Step eight: Congratulations. You have started a Yahoo Group.
You can now customize your group by deciding who can join, who can post messages and much more.
You can also start inviting people and organisation to join your Group/

welcome, cleverboya321
YA_HOOL GROUPS [sion out My Account]

e e

R —

Groups Home - Help

Start a Group | My Groups
Start a Group

Congratulations!

"My Groups" page.
Group name: cleverboy
Group home page:  hitp:fgroups. yahoo. com/group/cleverboy

Group email: cleverboyi@yahoogroups. com

Customize Your Group Invite People to Join

and morel colleagues

Your Group cleverboy has been created. You can access your group using the link below or from the Yahoo! Groups

Choose who can join, who can post messages, Growe your group now! Invite friends, family, and

Managing listservs

Guidelines for working online on a listserv

Stay involved — be active and contribute, speak your mind out.
Share accountability.

Group identity — always identify yourself with the group.
Initiate and formulate activities.

Respect one another’s differences in experiences, country realities, etc

Understanding group communication

We know that people with different gender, social and cultural backgrounds may have different ways of
communicating. We may differ in how we choose our words, in our body language, in how we dress, in
how we often we speak or don’t speak in a group, in how we behave towards our fellow group members.
We may also differ in our understanding of these differences. A participant’s silence may be understood
by one as shyness and by someone else as a sign of disapproval. A facilitator is attentive to the different
ways people communicate, especially when differences may lead to miscommunication or even conflict.

EXERCISE )

1) Have you experienced differences in how people communicate in a group meeting such as
a team meeting, conference or mailing list?

2) Did these differences lead to miscommunication? If yes, who do you think was the cause of that

miscommunication? If no, what happened to prevent miscommunication?

J
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Mailing list facilitator

Each mailing list should have a Facilitator. The role of a Mailing List Facilitator is to create a working
environment based on mutual respect, understanding and trust, building and creating a positive working
environment. He/she is responsible for welcoming and supporting new subscribers and making people
feel cared for.

Types of mailing lists

Mailing lists can be divided into a number of categories, depending on whether they are used for discussion
or for the one-way dissemination of information, and whether they are open to the public or only to
particular groups, such as members of a professional organisation.

Alerting services

Some mailing lists are used only to disseminate information; these include electronic newsletters and
lists used to inform users of particular web sites about changes or additions to those sites.

An examples of this type of list is womensnet_news: A weekly mailing list informing subscribers of additions
to the South African Women'sNet Web site: http://www.womensnet.org.za/about/wn_news.htm.

Discussion lists

Discussion lists are used for networking and communication between people with shared interests. Mailing
lists can be open or closed, moderated or non-moderated.

Open and closed lists

Open lists are open to anyone interested in a particular topic. The range of open discussion lists cover
just about every topic.

Closed lists are open only to members of particular groups. Examples of closed lists include those used
by classes to discuss assignments, online tutorial groups, working groups and lists used by members
of particular organisations.

Moderated and non-moderated lists

In a non-moderated list, messages sent to the list are automatically distributed to each list member or
subscriber.

In a moderated list, messages are first forwarded to the list "moderator" who will approve — or reject
— it for distribution to all list members. The levels of moderation vary from list to list. Some list
moderators approve just about all messages other than inappropriately directed administrative
requests, such as requests to unsubscribe. Others may moderate with a heavier hand, keeping the
list tightly focused and rejecting "off-topic" postings. Much will depend on the character of the particular
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list, and on the number of subscribers. For example, it may be unnecessary to moderate a list with twenty
members, but essential to moderate one with two thousand members.

E-Newsletters

Email newsletters are a very cost-effective way to stay in touch with and grow your audience. Periodic
emails - with news, events, or tips - remind your constituents of your existence, of the good things you
are doing, and of the ways that you might be able to work together.

The easiest and most basic way to produce an E-Newsletter is simply to write an email message you
want to send to your members or colleagues. Then go through your email address book, select the email
addresses you want to send to, and send!

If you want to be a bit more professional, you should produce an E-Newsletter that has graphics, links,
ways to subscribe and unsubscribe to the Newsletter. The Newsletter should have a uniformed look,
much like a printed newsletter or brochure, to give it a unique identify. At the very least it should have a
logo and banner or masthead on top, and the date and volume number.

The easiest way to produce this
kind of E-Newsletter is to prepare
the newsletter in a in a word
processor programme like Word.
You can use templates that can
come with the programme to help
you. You can insert graphics and
make hyperlinks to other parts of
the document or to external
websites and insert email
addresses for people to click on.
You can do the same in a web
authoring programme, like
FrontPage or Dreamweaver.
Once you have prepared the
newsletter this way, simply “Select
all” and copy and paste it into the
body of your email. You can then
send the

E-Newsletter to those recipients
you choose.

This is an example of a page from
a GEMSA newsletter created in
this way:

E-Newsletter of the
Gender and Media
Southern Africa

Network

Issue 4, May 2005

IN THIS ISSUE:
* Letter from Exco

* Alerts!
Breakthroughs

* Notice board

Gender justice
barometer

* Network news

Resources

Remember to send
information you think that
the network wilf find useful
to:
admin@genderfinks.org.za
and we will include this in
the newsletter. The
newsletter reaches over 800
individuals and
organisations, so share with
us your challenges and
successes so that
collectively we can build a
stronger gender and media
network in the region.

Contact your GEMSA
country representatives:
Angola: Anacleta Pereira
Botswana: Pamela Dube
dube@mmegi.bw

Gender and Media Southern Africa

Letter from Exco

Dear friends and members ...
With your support, GEMSA continues to grow from strength to strength.
Network manager

Earlier this month we appointed the GEMSA Network Manager, Janet
Karim from Malawi. Janet brings a wealth of experience as a former
newspaper owner and editor, activist in media women’s organisations, and
in posts held with Oxfam and the UNDP. Welcome Janet!

Country action plans

The GEMSA Executive and Committee met on 5 May to review progress
and plan for up coming activities. Country representatives presented their
action plans and fund raising initiatives. Minutes of the meeting can be read
at www.genderlinks.org.za

Membership

Membership of the network continues to grow. Country chapters are
forging ahead with membership drives to encourage organisations and
individuals to join the network.

Sub committees

Two sub-committees have been established — a monitoring committee,
chaired by William Bird of the MMP, and a trainers' committee chaired by
Emily Brown of the Polytechnic of Namibia. We look forward to
strengthening these important aspects of our work.

GEMSA Plan of Action

All GEMSA country chapters took part in the Global Media Monitoring
Project in February. We will work with the MMP to derive from this a
Southern Africa report which will be used as a benchmark against the
Gender and Media Baseline Study.
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Disseminating your E Newsletter

In you have a large subscriber list, it would be better to use specialist software that has been developed
to create and manage E-Newsletters. There are many commercial programmess you can buy for this
purpose. There are also a number of free or inexpensive tools that can help you to manage your subscriber
list, create and sent the e-newsletters, and track the number of people who open the emails or click on
the links.

The web or email hosting company you already use might be able to help you. Or you may be able to
use open source tools, or a free ASP discussion list. For most nonprofits, however, an ASP tool specifically
designed to manage e-newsletters will work best. Below, we walk through each of these options and give
examples of products in each category.

Why use an E-Newsletter Tool?

At the end of the day, sending an e-newsletter is technically just like sending any other email. So why
couldn't you just put all the email addresses onto the BCC line and send out an email just like any other?
Well, you can. This will absolutely work. It just may not be your best option, for a number of reasons:

* Time involved in maintaining your subscriber list. There's a lot of effort involved in adding
new subscribers, removing people who want to be un-subscribed, and monitoring emails that are
returned. And remember that you are legally liable for removing those people who request it. E-
news tools can handle these issues for you.

* Integrating your list with your website. Many email tools provide ways to put an e-newsletter
signup form on your website. This allows your website visitors to easily sign themselves up without
directly involving anyone on your staff.

* Potential for being listed as a spammer. If you send out a huge number of emails from your
personal email domain and some people complain that your emails are spam your domain could
be blacklisted as a spammer. This means that major ISPs (such as AOL or Yahoo) could refuse
to deliver any email from you — not just your e-newsletter, but all your organization's day-to-day
email. Some email tools have relationships with major ISPs that ensure that your email will go
through when it might otherwise be caught as spam (based on keywords and the like).

E-newsletter ASP tools

E-news ASPs make a lot of strategic sense for most organisations. While they are a bit more expensive
than tools in other areas, they offer many useful functionalities geared to e-newsletters in particular.

Like the discussion tools mentioned above, these tools have a web-based administrative interface to
mange subscribers. For these tools, though, you also create and send your emails through a web-based
interface. You enter the text or HTML for your email, along with information about what subscribers you
would like to send it to, into forms at a particular website, and the tool sends the emails for you. All of
the tools mentioned below, unless mentioned otherwise, allow you to:

* Integrate your list with your website, given a basic knowledge of HTML.

» Easily import and export subscriber lists.

e Create HTML emails without HTML knowledge.
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* Insert personalized mail merge fields.

* Preview and test your emails.

* Tailor the “From” line to match your organization.

* Report on subscribers and response information for each e-newsletter.
* Automatically manage bounces and unsubscribes.

These tools remove all possibility of being blacklisted as spammer. In addition, many of the vendors
proactively manage relationships with ISPs to prevent spam filter problems that might trouble you with
other solutions. If your organization is willing to invest about $200 per year into infrastructure for a strategic
e-newsletter effort, this is the category for you.

Some tools of this type to consider:

e GraphicMail (www.graphicmail.com): In a deal that can't be beat, GraphicMail offers 10,000 emails
a year free to nonprofits (notable branding for GraphicMail is included in your emails in the free version;
the branding can be removed for $20/year). The tool is impressive to boot — it has a great HTML editor
that allows you to create your own templates.

* Vertical Response (www.verticalresponse.com): Vertical Response is mostly differentiated by its
pricing scheme — it is priced by the number of emails sent. At $1.50 per hundred emails, it can be
quite affordable for small lists.

e Intellicontact (www.intellicontact.com): Intellicontact is also friendly for small lists, at $9/ month for
500 subscribers and $12/ month for 1000. It has a great HTML email editor — not only can you create
emails based on their pre-packaged templates (as is typical), but you can create your own templates.
This would allow an HTML savvy staff member or consultant to create sophisticated to be used by
their less HTML savvy colleagues.

e Groundspring mailNow (www.groundspring.org/services/emailnow.cfm): Groundspring, a nonprofit
itself, has a reliable set of tools that includes a basic e-newsletter tool for $20/ month ($49 setup fee).
EmailNow can be integrated with Groundspring's donation tool, DonateNow, to provide integrated
reporting on — for instance — how much money was raised by each email campaign. It does not,
however, provide any tools to help create HTML e-newsletters without HTML knowledge.

* Democracy In Action (www.democracyinaction.org): Democracy in Action is a nonprofit that offers
a suite of tools directed at those trying to mobilize large groups to action. Their e-newsletter tool is
a bit expensive for what it is if purchased by itself ($200 setup and $50/month), but for an additional
$50/month ($500 setup, $100/month), you can get a sophisticated integrated package that includes
donation support, tools to email and fax politicians in bulk, tools to support meet-ups, website content
management tools, and more - an amazing value for $100/month.

Installable open source tools

If you have the technical skills to install packaged code and databases on your server, then you may find
a good bargain in open source e-news tools. You pay a flat fee (about $75 - $150) for the tool, download
the code, and install it on your server. The tools are designed to be installed with no special access rights,
and work fine in a shared environment. Once they are installed, they are similar to the low-end ASP tools
described above.
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What to look for in an E-News tool

Tools are geared towards different needs and objectives. As you look at the list of considerations below,
you will like find a number of them may or not be applicable to your organisation:

1. Setup and monthly fees. Most of the tools described are priced as an Application Service Provider
(ASP) — essentially, you rent them by the month. Tools come in a huge range of prices — from free
to hundreds of dollars a month. Make sure you understand what, if anything, you will pay up front
as a setup fee, and what you will pay on a monthly or yearly basis.

2. Maximum number of emails, subscribers, and/or lists. For most tools, you buy a package that
includes either a maximum number of emails per month, or a maximum number of list subscribers.
Most tools will also let you manage multiple lists at the same time.

3. Website integration. Many tools provide a chunk of HTML code that, when placed on your website,
allow visitors to subscribe themselves. Check if you can capture custom information about
your visitors. Also check whether the tool will support more than one linked website form.
A preferred e-news signup method — which only a few tools support - is to ask only for an
email address to subscribe, but then to request additional optional information in a follow-up
form once they've signed up.

4. Subscriber import, export and integration. Ensure that you can easily load in lists of new
subscribers, or export the subscribers you have, to allow you to synch up subscribers with an offline
contact management database. Most tools allow this.

5. HTML support. If you would like to create HTML emails (which allows graphics, complex formatting,
and sophisticated reporting, but may be difficult for some your subscribers to view), make sure the
tool you choose supports this. A tool that includes HTML templates or editing capabilities can be
helpful if you don't have HTML expertise. Note that you don't necessarily need them - you can create
HTML emails using separate HTML editing tools, such as Contribute, FrontPage or DreamWeaver.

6. Personalisation and list segmentation. If you're hoping for a more personalised approach, look
for a tool that allows you to include personalised fields (i.e. “Dear Laura”) in your emails. Higher end
tools will also allow you to send different emails to different subscribers based on their information
(state, interest, etc) or even on their response to previous emails.

7. Message preview and testing. Check to make sure that you can see how your emails will look with
preview functionality, an ability to send a test email, or both. Testing is critical, particularly if you're
sending HTML emails.

8. Ease of use. Get a look at the administrative interface that you'll use to create emails and view
reports — some of the tools on the market are difficult to work out.

9. Email “From” Line. Who does the email appear to be from when subscribers receive it? Where
does a reply go if a subscriber replies to your email? Many tools allow you to simply enter a
name and email address to appear as the “From” information.

127



128

C. INTEDNET EXCHANCES

10.

11.

12.

13.

14.

Ensuring Email Delivery. A solid e-newsletter tool will help get your emails into inboxes and out
of spam filters. Top tools have a strict anti-spam policy and create relationships with major ISPs (i.e.
AOL, Hotmail) to “white-list” your e-newsletters — preventing them from ever being tagged as spam.
Some tools let you do a “spam keyword” check before sending — to score your email on the likelihood
that other automated tools will think its spam. This is a handy way to learn what makes an email
look like spam.

Bounces and unsubscribes. Check what the process is for handling bounces (when an email is
returned as undeliverable) and for unsubscribes. Some tools handle all of this automatically, some
require you to be involved in the process, and some allow you to choose how involved you would
like to be.

Reporting. All tools should be able to show you how many subscribers you have, and how the
number has changed over time. If you are sending HTML emails, some of the higher end tools also
offer extremely useful reports as to how many opened the email, and how many clicked on each
link in the e-newsletter.

Support. As with any tool, check how responsive the vendor is to your questions and what methods
you can use to reach them. Do they list a phone number, or is support only by email? How
comprehensive is the documentation?

Reputation and longevity of vendor. Make sure the company seems stable. As with any other
online vendor, you will have to go through the setup process all over again if they go out of business.
And ensure that the email addresses on your list will belong solely to you. No reputable vendor would
send emails to your list for any reason.

Some E-Newsletter tips

An easily to read and useful monthly e-newsletter is likely to have better results for a organisation than
a boring and irrelevant newsletter. A few things to keep in mind as you think through your specific e-news
strategy:

An e-newsletter doesn't stand alone. Like any external communications, your e-newsletter should
be part of an overall strategy, which encompasses print communications, PR, and your website.
Content is king. Consider what to include and how to present it with just as much care as for a
printed newsletter. Make sure your information is timely and relevant to your subscribers.
Brevity is key. Few people will read all the way through a long email. Typically, an e-newsletter
includes only short “teasers” to stories featured on your website.

HTMLor plain text. Think carefully about whether to send your e-newsletter in an HTML format
(which allows graphics, complex formatting, and sophisticated reporting, but may be difficult for some
your subscribers to view), or in a plain text format (which limits the formatting, but ensures that all
will be able to read it).

Timing matters. The day and time that you send your e-newsletter can make a notable
difference in the number of people who read it. Be consistent, so that your subscribers know
when to expect your email.
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Objectives

To understand use of the Internet as a tool for mobilising support using:
e Alerts and

. Petitions.

. Real time interaction; “chats” or “cyber dialogues.”

Alerts
What is an alert?

An action alert is a message that someone sends out on the Internet asking for a specific action to be
taken on a current political issue. Well-designed action alerts are a powerful way to invite people to
participate in the processes of a democracy. Although an Internet action alert should always be part of
an issue campaign with a coherent strategy and clear goals, this manual does not discuss the larger
strategic questions. Instead, we have divided action alerts into two categories, single messages and
structured campaigns.

Single alerts are broadcast in the hope that they will propagate to the maximum possible number of
sympathetic Internet users. Structured campaigns are typically conducted through mailing lists specially
constructed for the purpose.

A networked alert can travel far from its origin by being forwarded from friend to friend and list to list,
without any additional cost being imposed on the original sender. This phenomenon of chain-forwarding
is important, and one needs to think through its consequences.

Example of alerts: If you go to www.genderlinks.org.za, under “What is New” and alerts you will find
examples of current and past alters on gender and media issues.

Tips for writing effective action Alerts

1. Establish authenticity:
Bogus action alerts -- such as the notorious "virus" alerts -- travel just as fast as real ones. Don't
give alerts a bad name. Include clear information about the sponsoring organisation and provide
the reader with several ways of tracing back to you - e-mail address, postal address, URL,
phone number, etc. Including this contact information makes sense anyway - you want people
to join your movement, and this means establishing contact with you. There's no substitute for
clearly explaining who you are and giving people a way to reach you.

2. Put a date on it:
Paper mail and faxes get thrown away quickly, but action alerts can travel through the Internet
forever. Do not count on the message header to convey the date (or anything else); people
who forward Internet messages frequently strip off the header. Even better, give your
recommended action a clearly stated time-out date, e.g., "Take this action until June 30, 2005".
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Include clear beginning and ending markers:

You can't prevent people from modifying your alert as they pass it along. So put a bold row of
dashes or something similar at the top and bottom so additional comments will look extra. That
way it will be very clear what you and your credibility are standing behind.

Beware of second-hand alerts:

Although it is uncommon for someone to modify the text of your alert, sometimes people will
foolishly send out their own paraphrase of an alert, perhaps based on something they heard
verbally. These second-hand alerts usually contain exaggerations and other factual inaccuracies,
and as a result they can easily be used to discredit your alert. If you become aware of inaccurate
variants of your alert, you should immediately notify relevant mailing lists of the existence of
these second-hand alerts.

Think about whether you want the alert to propagate at all:

If your alerts concern highly sensitive matters, for example, the status of specifically named
political prisoners, then you will probably want to know precisely who is getting your notices,
and how, and in what context. If so, include a prominent notice forbidding the alert's recipients
from forwarding it.

Make it self-contained:

Don't presuppose that your readers will have any context beyond what they'll get on the news.
Your alert will probably be read by people who have never heard of you or your cause. So define
your terms, avoid references to previous messages on your mailing list, and provide lots of
background, or at least some simple instructions for getting useful background materials. In fact,
you might consider making the e-mailed alert relatively short and include the URL for a Web
page that provides the full details. Your most important audience consists of people who are
sympathetic to your cause and want to learn more about it before they can take action. Write
your alert with that type of reader in mind, not the complete insider or the apathetic stranger.

Ask your reader to take a simple, clearly defined, rationally chosen action:

For example, you might ask people to call their representatives and express a certain view on
an issue. In this case, you should provide a way to find that representative's name and number,
and explain how to conduct the conversation: what to say, how to answer certain likely
questions, and so on. The purpose of such a script is not to impose your thinking but to help
people to learn a skill that might otherwise be intimidating. Decide whether to ask for
e-mail messages (which can be huge in number but near-zero in effect), written letters (which
will be fewer but more effective), or phone calls (which fall in between). Consider other
options as well: perhaps the sole purpose of your alert is to solicit contacts from a small
number of committed activists, or to gather information, or to start a mailing list to organize
further actions.

Make it easy to understand:

It is crucial to begin with a good, clear headline that summarizes the issue and the recommended
action. Use plain language, not jargon. Check your spelling. Use short sentences and simple
grammar. Choose words that will be understood worldwide, not just in your own country or
culture. Solicit comments on a draft before sending it out.
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Start a movement, not a panic:

Do not say "forward this to everyone you know". Do not overstate. Do not plead. Do not say
"Please Act NOW!!!” Do not rant about the urgency of telling everyone in the universe about
your issue. You're not trying to address "everyone"; you're trying to address a targeted group
of people who are inclined to care about the issue. And if the issue really is time-critical then
just explain why, in sober language. Do not get obsessed with the immediate situation at hand.
Maintaining a sense of that larger context will help you and your readers from becoming dispirited
in the event that you lose the immediate battle.

Give the facts- accurately:

Most people have never heard of your issue, and they need facts to evaluate it. Your message
will circle the earth, so double-check. Errors can be disastrous. Even a small mistake can make
it easy for your opponents to dismiss your alerts - and Internet alerts in general - as "rumors".
Once you do discover a mistake, it will be impossible to issue a correction.

Don't just preach to the converted:

When you are very caught up in your cause, it is easy to send out a message in the language
you use when discussing the issue with your fellow campaigners. Often this language is
“shorthand” that doesn't really explain anything to an outsider. If you really care about your
issue, you'll take the time to find language that is suitable for a much broader audience. This
can take practice.

Avoid polemics:

Your readers should not have to feel they are being hectored to go along with something from
the pure righteousness of it. Some people seem to associate non-polemical language with
deference, as if they were being made to bow at the feet of the king. This is not so. You will not
succeed unless you assume that your readers are reasonable people who are willing to act if
they are provided with good reasons.

Make it easy to read:

Use a simple, clear layout with lots of white space. Break up long paragraphs. Use bullets and
section headings to avoid visual monotony. If your organization plans to send out action alerts
regularly, use a distinctive design so that everyone can recognize your "brand name" instantly.
Use only plain ASCII characters, which are the common denominator among Internet character
sets.

DO NOT use a chain-letter petition:

A chain-letter petition is an action alert that includes a list of names at the end; it invites people
to add their own name to the list, send in the petition if their name is the 30th or 60th etc, and
in any case forward the resulting alert-plus-signature-list to everyone they know. This idea
sounds great in the abstract, but it really doesn't work. The problem is that most of the signatures
will never reach their destination, since the chain will fizzle out before reaching the next multiple
of 30 in length.
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15.

16.

17.

18.

Urge people to inform you of their actions:

If you are calling on people to telephone a legislator's office, for example, you should provide
an e-mail address and invite them to send you a brief message. Explain that you'll use these
messages to count the number of callers your alert has generated, and this information will be
invaluable when you speak with the legislator's staffers later on. Only do this, though, if your
mail server is capable of handling large amounts of messages in a short period. You might want
to check this out with your service provider beforehand.

Don't overdo it:

Action alerts might become as unwelcome as direct-mail advertising. Postpone that day by
picking your fights and including some useful, thought-provoking information in your alert
message. If you're running a sustained campaign, set up your own list. Then send out a single
message that calls for some action and include an advertisement for your new list. If you must
send out multiple alerts on the same issue, make sure each one is easily distinguishable from
the others and provides fresh, useful information. Above all, don't spam. Post your message
only where it belongs.

Don't mistake e-mail for organising:

An action alert is not an organisation. If you want to build a lasting political movement, at some
point you'll have to gather people together. The Internet is a useful tool for organising, but it's
just one tool and one medium among many that you will need, and you should evaluate it largely
in terms of its contribution to larger organising goals. Do the people you reach through Internet
alerts move up into more active positions in your movement? Do you draw them into conferences,
talk to them by phone, meet them in person, become accountable to them to provide specific
information and answer questions? If not, why do you keep reaching out to them?

Encourage good practices:

The Internet is a democratic medium that provides us all with the time and space to do the right
thing. So let's use the Internet in a positive way and encourage others to do the same. Remember,
forwarding a badly designed action alert actually harms the cause that it is supposed to support.
Modeling thoughtful, constructive action on the Internet, however, provides everyone with a living
example of democracy in action. Do a post-mortem when it is all over.
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Petitions

A petition may be defined as: “a request to an authority, most commonly a government official or public
entity. A petition is a document addressed to some official and signed by numerous individuals. A petition
may be oral rather than written, and in this era may be transmitted via the Internet. The term also has a
specific meaning in the legal profession as a request, directed to a court or administrative tribunal, seeking
some sort of relief such as a court order.”

source: en.wikipedia.oeg/wiki/Petition

(Q EXERCISE A

Read the following case study of a petition. What were the main elements? How did SAGEM use the
Internet? How would you evaluate the success of the campaign?

Much has been said and written about the “Strip the back page” campaign spearheaded by the South
African Gender and Media (SAGEM) Network. The campaign went online on the 1 February 2004 when
Women’sNet, a SAGEM member began circulating a petition urging editors to drop pages that objectify
women and replace it with stories about women in all their diversity in the run-up to International Women’s
Day on 8 March 2004.

There is a tradition around the globe of women being handed over the task of “making the news” on
International Women’s Day (8 March). The newly formed SAGEM, by challenging the most sexist parts
of the news, aimed to test whether editors talking the talk of gender equality were willing to walk the walk.

No sooner had the petition hit the wires than SAGEM began to receive scores of responses and comments,
as well as unprecedented media coverage. In all, the SAGEM petition attracted 218 signatures between
1 February 2004 to 1 March 2004. Some of the comments are captured in the box below:

Comments on the Strip the Back Page Campaign

Veronica Mohapeloa : | support this campaign, hoping to get all those chauvinistic editors and
reporters to mend their ways. It is time this important lesson is learnt. Especially
now that we have entered the 21st century, such presentation of women in
the media is absolutely unacceptable!

Rossetta Simelane  Replubic of South Africa : | fully support the campaign. Actually the back page
must be stripped forever!!!!

Ditshego Magoro : | think is about time we do something about how the media is portraying us
as women.

Edward Cottle : | support Stripping the Back Page and Dressing it with Real News!

Virginia Molose : Congratulations on a worthwhile cause. These sort of campaigns need to live

beyond 09/08. We need to now target electronic media and free television
and radio from such humiliating stereotypes about women.

Seabo Gaeganelwe: This is one campaign that is long overdue. As an individual it makes me
sick that 10 years into our democracy the media in our country still depicts
women as sex objects .Let us join civilized society in destroying this sick
portrayal of Women by the "Fourth Estate". 133

—

For more comments go to: www.womensnet.org.za
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In a statement “distancing” itself from the campaign on grounds that SANEF could not determine the
editorial policy of its members, SANEF simultaneously indicated that individual editors “might well support”
the campaign. Head of the Rhodes University media department Guy Berger, also deputy Chair of SANEF,
described as “infantile” the Sunday Times’ particularly hostile and personalised attacks on Gender Links.
Writing in his regular column for the Mail and Guardian Online, he cast the response in the broader context
of the South African media’s thin skin for criticism of any kind.

Responses to the “Strip the Back Page” campaign show that while many editors subscribe to the ideals
of gender equality, some have not thought through the implications of this for the content of their news
pages.

The refusal to engage with the issue just reinforces how important it is to keep the issue of women’s
representation in the media on the table. We have to address the issue of the status of women in this
society. The media has a pivotal role to play in this struggle.

\. J

How to develop a petition

Petitions can be effective ways of getting many supporters to rally around an issue. Individual letters and
phone calls, however, are still very effective and should be encouraged in addition to signing a petition.

Each petition should have a statement of facts structured as a logical argument, and concluded with a
statement of position on the part of those signing. People need to know what they are agreeing to! You
can make sure they understand the issue by making the background available - a page or two about the
issue (its importance and relevance to the public, why the issue is so important to be addressed now,
the expected result of action, etc.)

Traditionally petitions are printed on paper, with activists asking try get people to support the petition by
singing it. Often, you will see a group of people sitting at a small table outside a supermarket, who will

approach you to sign their petition. A traditional petition looks something like this:

Sample petition form

Whereas:
1. Statement of Fact
2. Second Statement of Fact, and
3. Third Statement of Fact
4. We request that:
Statement of position, who is to act on position, and how they might act on position.

Signature Name Residential Address Postal Code | Date

O
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E-mail petitions

Email petitionsOare usually forwarded from person to person and have a long list of names or
email addresses at the bottom.O The recipient of the email is asked to add his or her name and
forward it to others.

The main problem with many of these email petitions is that a surprising number of them do not seem
to have a final destination.O In other words, they keep circulating from person to person, but there's no
information about who is going to give the names to the government agency, politician, celebrity or
whoever is supposed to receive them.

O O
Some email petitions do have instructions, usually to forward the latest version to the originator's email
address when a certain number of names have been added.O Others ask that when a limit has been
reached, the email be forwarded directly to the organisation, government, or particular email address.OThis
type of petition most often does not achieve its purpose.O If there is a petition that a lot of people are
inspired to sign and circulate; it creates such a volume of email to the originator that either that person
or their email server brings it to a halt.0

The biggest problem with email petitions, however, is that they do not really carry the weight of a personally-
signed petition.O The reason paper petitions are more effective is that real people have signed them with
real signatures and, presumably, real addresses.1 When petitions are circulated to qualify a political
candidate for public office or an initiative is launched to change a law, the petitions are accepted only if
a minimum number of the signatories are validated by comparing name and address information with
known records.O0 The names on an email petition, however, can be easily fabricated.O There is no way of
knowing whether the alleged "signers" really attached their names or if someone simply created or
borrowed a list of names and pasted them into the email.

Online petitions

Online petitions potentially carry more clout because they ask for names and addresses, although
there is still the lack of a signature (unless electronic signatures become popular for petitions).O This still
leaves the issue of whether the names and addresses being fabricated or borrowed in doubt.

The biggest question with regard to online petitions, however, is who is sponsoring them and why?
Many of the online petition websites do not list the names of any of the people running the petition or
campaign, have no information about the organisation or organisations associated with it, if any, and give
no evidence that the petitions have been presented.d Yet hundreds of thousands of people give petition
websites their personal information including addresses, business information, and email addresses.

Those hundreds of thousands of names, addresses, phone numbers, and email addresses are a gold
mine for marketers who use these lists to send various kinds of solicitations and can make a fortune
renting, selling, and sharing the names on the lists with other businesses.O The online petition sites have
been a sensational source of not only new names for mailing lists but names of people who can be
identified as having particular interests such as supporting conservative or liberal causes,
environmental issues, animals rights, etc.O

135



186

4. MOEBILISING ON THE INTERNET

There is nothing wrong with businesses and other organisations accumulating mailing lists and there is
nothing wrong with any of us ending up on one...as long as it is a mailing list that we have chosen to
belong to.

If you creating an online petition make sure that you address the following issues:

1.  Who owns, sponsors, or runs the site either individually or organisationally?0

2. Information on when, where and how the petition will be presented

3. Be careful to protect the integrity of the information you receive. For example, be specific if you are
going to use information on mailing lists, etc.

Example of an online petition

To African Union Heads of State
Your Excellencies:

Protocol to the African Charter on Human and Peoples' Rights on the Rights of Women in Africa

We the undersigned write to you regarding the ratification of the Protocol on the African Charter on Human
and Peoples' Rights on the Rights of Women in Africa by member states of the African Union and urge
your Excellencies to ensure the fast tracking of its ratification by your respective governments by the next
Heads of States Summit in July 2004.

As you will recall, the Protocol was adopted in July 2003 during the Second Ordinary Session of the
Heads of States held in Maputo. lts adoption was celebrated by African women, women's and human
rights organizations in Africa and the diaspora as a major step towards finally securing a legal and rights
framework for the protection and advancement of the human rights of African women.

However, one month before its first anniversary only 29 of the AU's 53 member states have signed the
Protocol and only one (Comoros) has ratified it. This record undermines the stated intention of African
governments to protect and promote the rights of all their peoples.

Many women and their families experience social, cultural and economic rights abuses and political
discrimination on a daily basis. Physical violence, vulnerability to life-threatening diseases most notably
HIV/AIDS, poor educational opportunities and legal barriers around rights to property combine to keep
women in Africa as second class citizens as well as inhibiting their ability to contribute fully to the prosperity
of the continent.

Our call for the urgent ratification of the Protocol by all countries of the African Union deserves your
serious consideration. Ratification will send a clear signal that women and men can and should enjoy
equal rights and responsibilities. This enjoyment, in turn, will realise benefits to the whole of the continent.

We in civil society share the dream of the Heads of States that Africa's social, economic and political well-
being rests on enabling women's resourcefulness at this time. We trust therefore that you will recognize
the urgency of the situation and will facilitate the speedy ratification of the Protocol thereby completing

the good work that your Excellencies began in Maputo last year.

Yours sincerely

African Women's Development & Communication Network (FEMNET)

Credo for Freedom of Expression and Associated Rights, Rotimi Sankore - Coordinator
Equality Now, Faiza Jama Mohamed - Africa Regional Director

Fahamu, Firoze Maniji - Director

Oxfam GB, Irungu Houghton - Pan-African Policy Adviser

and more than 200 others

Visit http://www.pambazuka.org/petition/petition.php?id=1 to sign the petition urging African states to ratify
the Protocol on the Rights of Women in Africa. Once you have signed online remember to confirm your
signature through an email that will be sent to you.
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There are many websites that give you information about online petitions. Many of these websites allow
you to create and host petitions for free or for a small fee.

Some examples of websites which allow you to create petitions:
www.petitions.org/

www.petitionsite.com/

www.petitiononline.com/

Cyber dialogues

Cyber dialogues or Chat rooms are places on the Internet where people can plan meetings and share
ideas. Chat is a form of communication which allows immediate interaction on the Internet. The earliest
form was Internet Relay Chat (IRC), a text-based communications network. Now, there are newer Internet
technologies which make it possible for a group of people to meet and talk online. With chat technology,
all conversations take place in real time. This means that you need to be on the Internet at the same
time. Chat has been used extensively for live coverage of world events, news, sports commentary, etc.
For activists, it can be a useful tool for convening online meetings, debates and conferences. The group
must be connected to the Internet all at the same. There are many free cyber dialogues available today.
The most commonly used are Yahoo and MSN messengers.

E EXERCISE

Making it work for gender justice

Read the case study below of the Sixteen Days of Activism cyber dialogues piloted by Gender Links in
South Africa. What were the main elements of the cyber dialogues? How did GL make use of ICTs in the
campaign? What were the outcomes? Can these be replicated?

The cyber dialogues that had South Africa “chatting” about gender justice for 16 days ended with a strong
call to ensure that “peace begins at home.”

The dialogues, according to a statement released by partner organisations on 10 December 2004 (Human
Rights Day), “opened an unprecedented space for those most directly affected to speak out.” This
happened both in the face-to-face discussions that took place at 66 centres in all nine provinces as
well as in the daily lunch time chats that allowed these groups to pose questions to the 55 experts and
decision-makers who took part in the cyber dialogues on different days.

—
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As illustrated in the diagram, the cyber dialogues consisted of:

CO-ORDINATING COMMITTEE

'

NGOs RESPONSIBLE FOR CONTENT EVERYDAY

}

MEDIA HUB = BULLETIN
CENTRE CITY OF JHB BOARD
COMMUNITY
FORUMS / \ NGOs
LOCAL
MPCC 2

Different themes for each day, for which the sixteen participating NGOs prepared fact sheets and
organised panelists who came to a central hub.

Face to face debates on the theme at the hub, as well as at 80 access points around the country
included government information multipurpose centres; local government libraries and community
centres and the local level offices of partner NGOs. These took place from 12.00 to 13.00 each day.
An Internet link up between the hub and the satellite points via a chat room provided through the
partnership with Microsoft and Telkom.

A daily poll question where participants could register their view and facility to access the results in
graphical format.

A summary of the chat and especially of action points at the close of each day.
A bulletin board which participants could post comments to at any time.

A video conference on the last day of the cyber dialogues that involved four panelists each in five
Southern African countries with about twenty audience participants in each country (supported by
the British Council and UNIFEM SARO).

Media kits and a media liaison officer who ensured maximum publicity for the cyber dialogues
and tracked the increased coverage that resulted from having structured debates, with interesting
and knowledgeable speakers at the hub, and views from around the country on the different
themes. y
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On every day of the dialogues, held under the banner of “Making IT work for gender justice” at least one
person came online to say that they had been raped. ‘Lalu’ sent this message on the 8 December: “l was
brutally raped by my employer....Because | earn R900 | could not afford to get a lawyer. | am now
unemployed, where and what help can | get help?” Lalu received several messages back with the contact
information for organisations that could help her.

In the live discussion in Alexandra on the same day, Nellie Baloi said that in the ten years of South Africa’s
freedom, her testimony before the group had been the first time that she had experienced personal
freedom. She recounted how earlier this year her partner sought her out at her mother’s house where
she had taken refuge; burnt her house and doused her with petrol, ready to burn her alive. He committed
suicide after neighbours came to the rescue.

Organisers of the cyber dialogues saluted “the courage of those who have taken the space provided by
the Sixteen Days of Activism on Gender Violence to speak out. We must not let them down. It is now up
to all of us as a nation to secure that space with concrete action.”

NGOs expressed concern that despite the government commitment to the campaign, the Sexual Offences
Bill that has been on the cards since 1996, has still not been passed. In particular, they urged the
government to reinstate the treatment clause that had been removed by the justice portfolio committee
on grounds that it had not been sufficiently costed.

“It is inconsistent that this bill should make provisions for the rehabilitation of perpetrators, and then say
nothing about the treatment and care of those affected,” said GL Director Colleen Lowe Morna. “This
provision is especially important because of the widespread findings that Post Exposure Prophylaxis is
not available to survivors of sexual assault in many health facilities.”

PEP is a course of anti retroviral drugs which, if taken within 72 hours of exposure to the possibility of
HIV infection can reduce the chances of transmission. Currently this is provided for in government policy
but not in law.

During the cyber dialogues Esther Maluleke of the Ministry of Health said that her ministry will be conducting
an audit in 2005 on the availability of Post Exposure Prophylaxis to reduce the possibility of HIV infection
for the survivors of sexual assault.

Maluleke also announced that in response to research showing that only 16 percent of the few women
who have taken the treatment adhere to it, the department is looking at how to integrate this provision
into home-based care, including the possibility of “treatment buddies”.

\. J
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Government prompted into action

Other important commitments made by the government during the cyber dialogues that will now be

closely monitored by civil society partners include:

. Peter Durandt of the Department of Justice and Constitutional Development said that the
department would be launching a hotline to receive complaints or hear about difficulties that
survivors of sexual assault are experiencing with the courts.

. Susan Pienaar of the South African Police Service (SAPS) said that the police will be launching
an integrated inter-sectoral training programme on domestic violence in 2005.

. Robbie Raburabu of the Independent Complaints Directorate outlined the role of the IDC in
receiving complaints about the police and their handling of domestic violence matters. He urged
the public to make greater use of this facility.

. Following criticism that the government is doing little to support places of safety and care for
survivors of sexual assault, Deputy Minister of Social Development Jean Benjamin announced
that her department will be building nine new shelters per province each year over the next
three years as well as 29 one stop centres for survivors of sexual assault.

Participants in the daily discussions stressed that at the root of gender violence is the inequality between
women and men reflected in every sphere of life, and reinforced by custom, culture, tradition, the media
and religion. The may long term solutions proposed centre on empowering women as well as changing
the attitudes of men. As one “chatter” put it: “South African men wake up. The world is watching you!”
And another: “Bring back ubuntu!”

Survivors of gender violence said that services offered to them should include vocational training and
finding employment. Several recommendations related to making information technology more accessible
to rural areas as part of a broader campaign to empower women. As one participant put it:  “This chat
is such a wonderful medium — let us use it constructively to seriously better life in our communities.”

\ J

Instant messaging

Another collaborative tool, which is growing in popularity, is instant messaging. Instant messaging
applications allow you to communicate with colleagues instantly. Activists can use instant messaging
to identify colleagues they might want to be in contact with when both are online at the same time.
In addition to sending instant text messages, some services make it possible for activists to send files
and pictures instantly, and to conduct audio and/or video conferences. Users should be aware that
not all instant messaging services are inter-operable. For example, if you are using Yahoo's
messenger, you will not be able to send instant messages to someone using AOL's instant
messenger.

For the purposes of this exercise, we will use Yahoo Messenger. In order to do this, we all need to
first register for a free Yahoo email account. This will give us a Yahoo ID and password.

)
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Setting up Yahoo Messenger

Step one: Go to www.yahoo.com
Click on Messenger in top right corner.

Make Yahoo! your home page Get Yahoo! Toolbar with Anti-Spy
H @ HOO! &
5 E['@y I
= i
W B A I @ =

Finance Music Travel Mail My vahoo! Messenger

Select Search Categary: m Images | Video | Directory | Local | News | Products

‘ Search the Web: | Yahoo! Search | Aduanced ‘

Yahoo! Search Marketing - ¥ou could win 10 million free ads on Yahool. Enter the Think Big Contest.

m Check your mail status: Sign In Free mail: Sign Up Yahoo! Health - Weight Loss Center

Calculate Body Fat, Find a Diet,

Autos Horoscopes Movies Real Estate b

Chat HotJobs hlusic Shopping Search for Low-Cal Recipes
Finance Kids My Yahoo! Sports

Games tail Mews Travel In the News 4pm, Thu A
GeoCities Maps People Search TV ) . ;i 3
Graups Iessenger Personals Yellow Pages * Irag's parliament OKs & partial Cabinet

Step two: Click on “Get it now”

“rahoo! My Yahoo! Mail Stehaercwhebl— — |
Sign In
hﬂw!a M ESSENGER Neg Uzer? Sign Up Mezzenger Home - Help

Features | IMVironments | Audibles | Emoticons | Games | Mobile New to Instant Messaging?

Try Yahoo! Messenger

Take a tour See the features
tlick for Windows 98,/Me, 2000 and XP:
Other versions: Mac |UHJ
Step three: Yahoo Messenger begins downloading

“rahoo! My Yahoo! Mail Stehaamwhebl— Searchl
Sign In
YAHOO! MESSENGER 7020 cign ve Wassanger Home - Hlp

Downloading Yahoo! Messenger

Downloading installation... Please wait.

S

Welcome to Yahoo! Messenger

Communice a b i nd video in real time,

Firewall support by
Copyright @ 2005 Yahoo! Inc. All rights resenved. Privacy Policy - Terms of Service - Copyright!lP Palicy - Help
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Step four: Click on Next (bottom right corner)

Yahoo! Messenger Installation

Step 2 of 6
Install Options

Chooze the type of install you prefer. Click 'MNext' to continue.

(* Typical (recommended)
Select this option to get:
- Yahoo! Messenger The best way to share what matters with the
penple who matter most.
- Yahoo! Toolbar with Pop up Blocker . Al your important stuff
onling, just one click away .
-Yahoo! extras Easier access to Wahoo! services such as
Search, Maps, Mail and Games.
™ Custom (advanced users)

Select this option to specify the festures you wart.

¥ Make Yahoo! my default search engine
[ Make ¥ahoo.com my home page

™ Make Yahoo! Mail my defaul mai application

Digk Space Requirad: /J-EB-ME\
Cancel_| < Baf )

Step five: Click on “Yes, | accept the terms of this agreement”. Click Next

Yahoo! Messenger Installation

Step 3 of 6

License Agreement

Before wwe can install vour nese software, vou need to agree to License
Agreement below.

1. ACCEPTANCE OF TERMS H

Welcowe to Yahoo! Messenger. Tashoo! provides
this service to you, subject to the
following software license terwms ("Software
License™), which incorporates by reference
the Tahoo! Terims of Service ("TO3M") each
which may be updated by us frow time to time
without notice to you. ¥ou can review the
most current wversion of the Software License
and TO3 at any time at:

http://docs. vahoo.con/ info/ terms/messenger. h
tml and http://docs.yahoo.comd info/terms/ . =

¥ “Yes, | accept the terms of this agreement.

Cancel | < Bad

Step six: Click Next

hoo! Messenger Installation

Step 5 of 6
Ready to Install!

You are now ready to install. Click Mext to cantinue.

Total download size: 5.37 MB

Estimated Download Time:
a6 Kb modem 13 min.
DSLiCahle (812 kh) 1 min.
THLAN {1672 Kb 27 sec

Cancel | < Bad
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Step seven: Let it install:

Yaho g llation

Entertainment

LAUNCHcast

Listen to LAUNCHcast Radio
and show your friends what

you're listening to

Games
Challenge your friends to
Word Racer, Checkers, Chess,
Dominoes and more

Downloading Y'ahoo! Messenger:
C:%Program Files''ahool\Installz\wmagrie. exe

Step eight: Congratulations. You have successfully installed Yahoo Messenger

“rahoo! My vahoo! Mail

YaHOO! MESSENGER

Features | IMVironments | Audibles | Emoticons | Games | Mobile

Search
the Webl Search |

Mezzenger Hame - Help

Sign In
Mew Uszer? Sign Up

Mew to Instant Messaging?

Congratulations! You have successfully installed Yahoo! Messenger.

Start Yahoo! Messenger in 3 Steps

1. Get a Yahoo! ID

“four Yahoo! ID lets you use other
free vahoo! services, like My
rahoo!, Mail, Finance and rmaore,

Sign up nowr.

2. Sign in

Yahoo! Messenger Feature Tour

Learn about the features in vahoo! Messenger by sesing how people
like you use them,

Getting Started Tutorial

For people new to vahoo! Messenger,

See the features - More help

Step nine: To start using Yahoo Messenger, sign in with your Yahoo ID and password.

Then click “sign In”

Sign In

Mew Lser?
Get a Yahoo! 1D

Already hawve a vahoo! ID7

Yahoo! ID: | tendai_ncube

Akokok
Password: |

[] remember my ID & passwaord
[7 automatically sign in
[ sign in as invisible

—

Sign In ] [ Cancel ] [ Help
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Step ten: To add contacts to your mailing list, click on “Contact” and select “Add Contact”.

(& cleverbopdy  Add a Contact Chrl+Shift -+

I' Messenger | Addre Invite People ko Yahoo! Messenger. ..

s Search ¥ahoo! Member Direckaory
© |

Add ™ Send an Instant Message. .. kM
Send a Text Message. .. Chrl+T =
Send an Email. .. Chrl+
To add people t Place an Internet Call... Chrl+L
List, click the Ad Invite to Conference. ..
reedisthe perst  qoath settings Chrl+ShiFt+5

email address. Contact Details

KL

e lazrn b F Profile. .. =l
Message Archive
LALINCHzast Radio (%)
Delete. ..
Edit Messenger List 4
W
Listen to a radio station now:
[ soft Pop |

l M Love Songs
[ my station

Browse all | ™y Stations «

090 Tl
/O @) e &) :

| | [ Search |

Step eleven: Type in the Yahoo ID or email address of the contact wish to add. Click on Next and
in the following screen Next again.

%

Add to Messenger List |

To add people to wour Messenger List, enter the Following information:

Yahoo! ID or Email Address:

| cleverboy43zl |

Specify how wau want this person ko appear in your Messenger Lisk (optional):

Firsk MNarme: | Marc Last Mame: | Suttner |

| < Back |[ Mext = ]| Finish |[ Cancel ]
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Step twelve: Enter a name for your mailing list. For example, “Gender activists” Click on Next.

Enter a brief message about the mailing list, like below.

Add to Messenger List #

Choose or enter a group for this person: Gender activists |,]

A message will be sent asking this person to approve your request to
add him or her to your Messenger List.

Enter a brief inkroduction to this person {optional):

I'm inviting vou ko join v gender ackivist lisk, T heard about wou through -
Kubi From Genderlinks who suggested I contact wou. I am sure yaou wil
rake a waluable contribution bo our disucssions.,

[ < Back. ][ Mext = J| Finish |[ Cancel J

Step thirteen: You have successfully added a new contact. You can repeat the above steps to add

more contacts to your mailing list.
Aidd to Messenger List m

cleverboy4321 has been added to your Messenger List and Address
Book pending his/her response to your request.

To add mare contact information For this person in vour Address Book, click Add
Mare Details:

l &dd Maore Details.. . I

To add mare people to vour Messenger Lisk, click Mext,

| < Back |[ Mexk = ][ Einish J| Cancel |
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4. MOBILISING ON THE INTERNET

Voice over Internet Protocol (VolP)

VoIP or Voice over Internet Protocol is an Internet technology that is causing a revolution in the
telecommunications industry. VoIP can turn a standard Internet connection into a way to place free phone
calls.

VoIP works by taking analogue audio signals, like the kind you hear when you talk on the phone, and
turning them into digital data that can be transmitted over the Internet.

By using some of the free VolIP software that is available to make Internet phone calls, you can bypass
the telephone company (and its charges) entirely.

The most common and easiest way to use VolIP is from computer to computer. Both computers need to
be running the same software. There are several companies offering free or very low-cost software that
you can use for this type of VolIP. All you need is the software, a microphone, speakers, a sound card
and an Internet connection; preferably a fast one like you would get through an ADSL modem. Except
for your normal monthly internet fee, there is usually no charge for computer-to-computer calls, no matter
the distance.

You can also use VolP to make a telephone call from computer to telephone instrument. This reduces
your telephone costs as you pay for the call at the local rates of the country you are placing the call to.
For example, you can call the US from South Africa using VoIP. You connect to the Internet. You use a
VolIP program to connect to the telephone number in the US you want to talk to. You are charged for a
local call at US rates.

& If you're interested in trying VolIP, then you should check out some of the free VoIP software available
on the Net. You should be able to download and set it up in about three to five minutes. Get a friend
to download the software, too, and you can start tinkering with VoIP to get a feel for how it works.
The most popular VolP software is know as Skype which has several million users. It’s very easy to
download and use. For more information go http://www.skype.com.
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What is open source software (0OSS)?

Open source software is software that is developed collaboratively by developers and programmers.
The software itself is available at little or no cost. The key characteristics are:

* Free: The software doesn't cost anything to obtain — although there are costs involved in
configuring and maintaining it, just like with other software;

* Open: Because the software code is open and readable by anyone, it also means that the
software can be modified by anyone with programming skills ... allowing for the translation of
software into local languages or the addition of features needed by a particular group;

» Collaborative: Open source software draws its strength from the fact that people who
improve, modify or customise programs must give it back to the open source community so
others can benefit from their work.

This concept contrasts with proprietary software. You need to buy proprietary software and you need to
purchase a license for every person using the software in your organisation. The source code is closed
and programmers do not have access to modify or change programs. Proprietary software can be very
costly. Microsoft Office is an example of proprietary software.

Is open source software free?

Yes and no. Open source software is free - users may freely copy and distribute the software. However,
a total IT solution consists of hardware, software and services such as support and training. It is important
to take all of these into account when discussing the cost of software. So although you will not have to
buy the software, you may have to pay to have the software installed and supported. The free concept
in open source software refers more specifically to freedom: free as in "free speech" or "free market",
rather than "free drinks". OSS gives users the freedom to use and modify the software to suit their own
needs. For non-technical users, this means the freedom from being locked into a single provider for
software fixes, upgrades, support and other services.

What can open source software do for organisations?

There are open source software equivalents for most (if not all) IT requirements. There are open source
operating systems, document-processing packages (office productivity suites), dialup, email and Web
browsing programmes. You can get open source games, multimedia and graphics applications. Since
open source software may be freely used, copied and redistributed, it offers a very affordable option for
organisations.

Examples of open source packages:
+ Operating system: Linux, Ubuntu Linux, Impi Linux, Free BSD
+ Openoffice is an equivalent of Microsoft Office and includes word processing and spreadsheet
programmes. Mozilla is an open source browser which is equivalent to Internet Explorer.
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Benefits of open source
There are many good reasons to consider open source software for your organization. Some of these
reasons include:

Software and updates can be obtained at low or no cost. There are no license fees.
Software can be customized to suit specific user needs (e.g. creating operating systems in
many different languages. There are Zulu, Xhosa and Tswana versions of Linux)
You are less likely to be dependent on a single software provider or trapped into long term
software support contract (no "lock in"). There are many developers worldwide who can
assist with development and maintenance.

Using open source makes you a part of a larger community that generally shares cooperative
values.

Software and documentation upgrade expenses can be distributed among groups.
Creates an opportunity to hire small, local developers to improve the software rather than big
foreign software publishers.

Better security. The open source model allows more programmers to participate in the
debugging of code. Specifically Linux and applications running on Linux have proven to be more
reliable and secure than Windows equivalents. Also, less likely to have virus problems
Hardware flexibility. With some smart coding, Linux can be scaled to run on almost any kind of
hardware. This is especially important for organizations who aim to use older computers.
Bugs tend to get fixed more quickly.

Why use open source?

There has been a great deal of discussion of the benefits of open source for organisations. Using open
source does have limitations and challenges, but it also presents benefits to civil society organizations:

Lower information technology costs: Open source eliminates the need to pay for software
licenses. This does not mean that you can eliminate information technology costs altogether —
there is still a need for staff and equipment to make it all work. But open source can definitely
lower overall costs, especially for organizations that need advanced servers, databases and web
applications.

Flexible software solutions: The fact that the code is "open" means that software can be modified
to respond to needs not addressed by the original developer. It is useful for applications where
it may be desirable to add on new features that accommodate the unique needs of your organization.
Better security: Mature open source applications — Linux, Apache, SendMail, OpenOffice.org—
tend to be more secure than their proprietary counterparts. This is partly due to the fact that the
code is open, allowing system administrators and others concerned with security to quickly identify
problems and propose solutions to the lead software developers. Also, open source applications
tend not to be targeted by people who make viruses. This kind of improved security is vital for
civil society organizations who want keep unwanted "snoopers" out of their network and who
cannot afford the downtime that comes with virus attacks.

Collaborative, cooperative values: Open source is based on a set of collaborative and cooperative
values. It assumes that we can create more useful tools by working together than we can by
competing. Using open source is not only a way to support these values, but it can also provide
a way to learn from them. The open source community presents a very practical and adaptable
example of how organizations can work collaboratively.
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CD-ROM & CD-RW

The CD ROM drive is like the CD drive found on a music system and operates in the same way. On a
PC, software is often installed from CD-ROM disks and people now use CD-Writers to ‘cut’ or ‘burn’ their
data onto blank CD disks. CD’s are useful because they can store a large amount of information and last
for a long time.

CPU

Central Processing Unit. This is the part of your computer which fits onto the motherboard and can be
compared to a human brain. All the instructions in computer programs must be ‘processed’ and executed
via this little device.

Floppy disk drive
A slot at the front of your system unit is the floppy disk drive. Small plastic diskettes fit into this slot and
can be used to store information. They are called ‘stiffy’ disks for short.

FTP
stands for File Transfer Protocol. This is a protocol specially used for transferring files between computers,
using a special program.

Hard disk drive

This is a storage device. It consists of a number of metal plates which store information permanently.
This is where you will usually save files and this is also where programs you install on the PC are stored.
It is located in the system unit. Be careful never to handle a magnet near your hard drive, or a stiffy disk,
as it can corrupt or erase the data.

Hardware

The actual machine parts of the computer — all the pieces you can touch and see. We can think of these
parts as the parts of the human body — we can see all the legs and arms and heads, but we cannot
actually tell what is going on inside. Examples are — monitor, speakers, printers, CPU, motherboard, etc.

Host Computer
is a computer which stores or ‘hosts’ files (web sites) accessed via the Web.

Internet
means a global network of computers and computer networks which are linked together by telephone
and satellite. Direct access to the main infrastructure of the Net is usually only available via an ISP.

ISP
Stands for Internet Service Provider. When you connect to the Net, you dial your ISP and they provide
you with a connection.

Keyboard

The keyboard is an input device. This means that you can send data to your computer by typing it in
on your keyboard. Take some time to examine the different sections of your keyboard. Later in the
manual, the different functions and keys are explained
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Monitor

A screen which displays images. Monitors come in different sizes and these days they are usually colour.
The image quality varies depending upon the quality of your machine’s parts, especially how much
memory it has. The monitor plugs into your PC system unit at the back, and the image is sent along the
cord to the screen.

Modem

A device which connects your computer to a telephone line so that you can connect to the Internet. It
converts your computer’s signal into a telephone signal so that information from you machine (messages,
documents, etc) can be sent along the telephone line to someone else’s machine. The modem attached
to their PC will decode the signal from a telephone signal to a computer signal, and they will be able to
understand the information you they have received from you. A internal modem can be slotted onto the
motherboard and an internal modem is connected at the back of the PC from outside the casing. There
will be more about the Internet in the section on email.

Motherboard

This is the plastic card inside your computer ‘box’ or system unit which has many electronic circuits
imprinted on it. It has slots for the CPU, RAM memory cards, device cards (e.g. video card, network card,
sound card, etc).

Mouse
A small input device which fits into the palm of the hand. It has clickable buttons and plugs into the
motherboard at the back of the system unit box.

Network

A network consists of 2 or more PC’s, linked together using special hardware called network cards and
cables. Linking PC’s to each other means they can communicate and also that they can share resources
—e.g., if there is only 1 printer available, it could be connected to 1 person’s PC and everyone can use
it by accessing it through the network connection to that machine. A Network in your office or building
would be called a LAN (Local Area Network).

Printer

An output device. To obtain a paper copy of a document you have on your computer, print it out. Printed
versions of information stored on PC’s are referred to as ‘hard copy’. The printer plugs into your machine
at the back of the system case.

Protocol
is a set of rules governing the way in which machines communicate with each other. Data cannot be
transferred over a network unless the correct protocols are set up.

Scanner
An input device, this is a machine similar to a photocopier: it can scan images from books, photographs,
etc and store them directly onto your PC.
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Software

Programs written in a special computer language. Because we cannot actually see how these special
coded instructions to the machinery are being processed, they are similar to the thoughts and dreams
we carry in our minds. These programs can be installed on your PC and enable you to perform different
tasks. Examples are: word processing programs, spreadsheet programs, games, email clients, operating
systems software.

System unit

This is the main ‘box’ or case where the motherboard, device cards, CPU and disk drives are located. It
is also where you switch on your PC. All external devices (also called peripheral devices) like printers
must be connected to the motherboard at the back of the casing.

Server
is a computer which is the central storage and operating point of a network

URL

Stands for Uniform Resource Locator. The URL specifies the Internet address of the electronic document.
Every file on the Internet, no matter what its access protocol, has a unique URL. A URL is also referred
to as a domain name or site address. Web browsers use the URL to retrieve the file from the host computer
and the directory (folder) in which it resides. This file is then displayed on the user's computer monitor.
This is the format of the URL: protocol://host/path/filename

For example:

http://www.house.gov/agriculture/schedule.htm a hypertext file on the Web
ftp://ftp.uu.net/graphics/picasso a file at an FTP site

telnet://library.albany.edu a Telnet connection

www

Stands for World Wide Web. This consists of all the files which make up web sites (called hypertext or
HTML files, usually). These files are stored on host computers and linked in a ‘web’ by the Internet. The
Web has provided the Internet with a graphical interface.
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ASSESSMENT FORM "%

CEMSA IT

A.

Name:

Organisation:

Contact details: Tel.:

Cell:

Email:

Job title:

Computers and related equipment

1.
2.

N o o b

Are you comfortable using a computer? YES /NO
Is your computer linked to other computers
through a network? YES /NO

. Do you use a word processing package such as

MS Word? YES/NO

. Do you use MS Excel? YES/NO

. Have you used Power Point? YES /NO

. Have you used a scanner? YES/NO

. Have you used a digital camera? YES /NO

. E Mail and list serves

—_

. Do you have e-mail? YES/NO
. Is it your own E Mail address or is it

shared? YES/NO

. Is your E Mail address a web address

eg Hotmail, or a direct e mail? YES /NO

. Do you disseminate information

electronically? YES /NO

If yes, describe how you disseminate information.

3. Internet and websites

5.

6.

Have you produced or been involved in
producing an E newsletter? YES /NO
Are you part of any list serves? YES/NO

If yes, please give examples.

7.

Have you ever been involved in an Internet petition
or campaign? YES/NO

Please give examples

1. Is your organisation connected to the
Internet? YES /NO
2. Do you dial up the Internet through a phone line
every time you need access? YES /NO
3. Have you used an Internet café before? YES /NO
4. Do you use the Internet to find information? YES / NO
5. What are some of the difficulties you have encountered?

6. Does your organisation have a website? YES /NO

7. Have you used a chat room? YES/NO

8. Were you part of the Sixteen Day or Beijing Plus Ten
cyber dialogues? YES /NO

9. Have you posted messages on an electronic bulletin
board? YES /NO

10. Have you ever registered your view through voting
on the Internet? YES /NO

Please use the space below to list, in order of priority,
the three things you would most want to learn during
the IT for advocacy workshops:

1)

3)

Any other comments




Many gender and media activists have access to computers,
modems and the Internet, but how do we use these tools?
Often, we are only using a fraction of the potential that sits
right in front of our eyes. Ours is a fast moving world. The
digital and gender divide grow wider every day. Neither will
wait for us. It’s up to us, working at a practical and strategic
level, to bridge the chasm. A sequel to the Gender Links/
Women’s Media Watch manual: Getting Smart: Strategic
Communications for Gender Activists, this manual - IT for
Advocacy - is a “how to” for using New Information and
Communication Technologies in gender justice campaigns.

The manual was developed and is being put to use in

partnership with the Gender and Media Southern Africa

(GEMSA) Network in our joint commitment to “making every

voice count - and counting that it does.”
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